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MODBUS SIO Master Driver

Introduction
This manual describes how to connect the Display and the External Device (target PLC).

In this manual, the connection procedure will be described by following the below sections:

1 System Configuration
This section shows the types of External
Devices which can be connected and SIO

type.

Fm System Configuration" (page 3)

2 Selection of External Device

Select a model (series) of the External
Device to be connected and connection
method.

&~ 2 Selection of External Device" (page 11)

3 Example of Communication Settings
This section shows setting examples for
communicating between the Display and
the External Device.

&3 Example of Communication Setting"
(page 12)

4 || Setup ltems

This section describes communication
setup items on the Display.

Set communication settings of the Display
with GP-Pro Ex or in offline mode.

Fny Setup Items" (page 60)

5 || Cable Diagram

This section shows cables and adapters
for connecting the Display and the
External Device.

&5 Cable Diagram" (page 68)

Operation
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MODBUS SIO Master Driver

1 System Configuration
The system configuration in the case when the External Device and the Display are connected is shown.
1.1 Schneider Electric SA External Device.
. . SIO . .
Series CPU Link I/F . Setting Example Cable Diagram
TSX 37 05 028DR1 Setting Example 1 | Cable Diagram 2
TSX 3708 056DR1 | R porton CPU RS8232C | (page 12) (page 81)
TSX 3710 128DT1
TSX 3710 128DR1
TSX 3710 128DTKI Accessory box RS485 | Setting Example 3 | Cable Diagram 3
TSX 3710 164DTKI1 | 75X SCA 50 (2wire) | (page 16) (page 82)
TSX 37 10 028AR1
TSX 37 10 028DR1
Micro TER port on CPU RS232C Setting Example 1 | Cable Diagram 2
(page 12) (page 81)
TSX 37 21 101 Accessory box RS485 | Setting Example 3 | Cable Diagram 3
TSX 37 22 101 TSX SCA 50 (2wire) | (page 16) (page 82)
TSX 3721001 PCMCIA card for RS232C RS232C Setting Example 2 | Cable Diagram 4
TSX 3722001 TSX SCP 111 (page 14) (page 96)
PCMCIA card for RS485 | RS485 | Setting Example 3 | Cable Diagram 5
TSX SCP 114 (2wire) | (page 16) (page 99)
TSX P57 103M PCMCIA card for RS232C RS232C Setting Example 4 | Cable Diagram 4
TSX P57 153M TSX SCP 111 (page 18) (page 96)
TSX P57 203M
Premium TSX P57 253M
TSX P57 303M PCMCIA card for RS485 | RS485 | Setting Example 5 | Cable Diagram 5
TSX P57 353M TSX SCP 114 (2wire) | (page 20) (page 99)
TSX P57 453M
TWD LCAA 10DRF . .
TWD LCAA 16DRF | Programming port on CPU | RS232C (Sett'”g’zl)zxamp'e 6 (Cab'eg?'agram 2
TWD LCAA 24DRF page page 81)
TWD LMDA 20DTK
Twido TWD LMDA
20DUK
TWD LMDA 20DRT | TwD NAC 485T RS4$5 Setting Example 7 | Cable Diagram 1
TWD LMDA 40DTK (2wire) | (page 24) (page 68)
TWD LMDA
40DUK
140 CPU 113 02
Quantum 140 CPU 113 03 Modbus port on CPU RS232C Setting Example 8 | Cable Diagram 6

140 CPU 434 12A
140 CPU 534 14A

(page 26)

(page 108)
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MODBUS SIO Master Driver

SIO
Series CPU Link I/F o Setting Example Cable Diagram
171 CCS 700 00
171 CCS 700 10 Setting Example 9 | Cable Diagram 7
171 CCS 760 00 Modbus port 1 on CPU RS232C (page 28) (page 110)
171 CCC 760 10
Momentum Modbus port 1 on CPU RS232C Setting Example 9 | Cable Diagram 7
171 CCS 780 00 (page 28) (page 110)
171 CCC 780 10 RS485 | Setting Example Cable Diagram 8
Modbus port 20n CPU -1y 0o | 10 (page 30) (page 111)
171 CCC 980 20 RS485 | Setting Example Cable Diagram 8
171 CCC 980 30 Modbus port 2 on CPU (4wire) | 10 (page 30) (page 111)
TM221C16R
TM221C16T RS232C Setting Example Cable Diagram
TM221C16U 15 (page 48) 13 (page 140)
TM221C24R
TM221C24T Serial line 1 on CPU
TM221C24U , )
TM221C40R RS485 Sett|ng EXampIe Cable Dlagram
TM221C40T (2wire) | 16 (page 51) 14 (page 142)
TM221C40U
TM221CE16R
TM221CEL6T Setting Example Cable Diagram
TM221CE16U RS232€ 18 (page 57) 16 (page 168)
TM221CE24R Serial line 2 on the
TM221CE24T Cartridges TMC2SL1 or
TM221CE24U TMC2CONVO1
M221 TM221CE40R RS485 | Setting Example Cable Diagram
TM221CE40T (2wire) | 17 (page 54) 17 (page 170)
TM221CE40U
RS232C Setting Example Cable Diagram
TM221M16R Serial line 1 on 15 (page 48) 13 (page 140)
erial line 1 on CPU
IM22IMI6RG RS485 | Setting Example Cable Diagram
TM22IMI6T (2wire) | 16 (page 51) 14 (page 142)
TM221MI16TG wire pag pag
TM221M32TK o RS485 | Setting Example Cable Diagram
Serial line 2 on CPU (2wire) | 17 (page 54) 15 (page 155)
TM221ME16R RS- Setting Example Cable Diagram
TM221ME16RG 232C 15 (page 48) 13 (page 140)
TM221ME16T Serial line 1 on CPU
TM221ME16TG RS485 | Setting Example Cable Diagram
TM221ME32TK (2wire) | 16 (page 51) 14 (page 142)
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MODBUS SIO Master Driver

B Connection Configuration

@ Micro Series

* 1:1 Connection

TER port—_

or *8
PCMCIA\_‘D
/ Accessory box
TSX SCA50
TER port
N
‘A(_)
O
0
@ Premium Series
* 1:1 Connection
0]
(@)
PCMCIA—p{]
& Twido Series
e 1:1 Connection
External Device
Programming port
or "o
Extension port )
TWDNAC485T f
e 1:n Connection
Max 16 units
'd N\

]

OO0

Extension port—
TWDNAC485T

(@) |
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MODBUS SIO Master Driver

@ Quantum Series

e 1:1 Connection

&

Modbus Pl

port on CPU
4 Momentum Series
e 1:1 Connection
Modbus port
3

*Port specification varies
depending on the model.

- ————

& M221 Series

e 1:1 Connection

Serial line 1 on CPU
o or ™

Serial line 2 on CPU — >

e 1:n Connection

Max 16 units

N
- N

Serial line 1 on CPU
o or ™

Serial line 2 on CPU — >0
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MODBUS SIO Master Driver

1.2 Yokogawa Electric Corporation External Devices.
. . SIO . .
Series CPU Link I/F Tise Setting Example Cable Diagram
. Setting Example Cable Diagram 9
Serial port on CPU RS232C 11 (page 32) (page 116)
Setting Example Cable Diagram
NFLR111-S00 RS232C 12 (page 36) 10 (page 118)
FCN NFCP100-S00
RS485 | Setting Example Cable Diagram
(4 wire) | 13 (page 40) 11 (page 120)
NFLR121-S00
RS485 | Setting Example Cable Diagram
(2 wire) | 14 (page 44) 12 (page 128)
Serial port on CONTROL Setting Example Cable Diagram 9
FCJ NFJT100-S100 UNIT RS232C 11 (page 32) (page 116)

B Connection Configuration

@ FCN/FCJ Series

1:1 Connection

1:n Connection

GP-Pro EX Device/PLC Connection Manual 7




MODBUS SIO Master Driver

m |[PC COM Port

When connecting IPC with an External Device, the COM port used depends on the series and SIO type. Please

refer to the IPC manual for details.

Usable port
Usable Port
Series
RS-232C RS-422/485(4 wire) | RS-422/485(2 wire)

coM1™!', comz,
PS-20008 coM3™!, com4 i i
PS-3450A, PS-3451A, 10 . 1
PS3000-BA, PS3001-8D | COMI, COM2 COM2 CoM2
PS-3650A (T41 model), -
PS-3651A (T41 model) CoMI ) )
PS-3650A (T42 model), *1%) *1%) *]%)
PS-3631A (T42 model) coM1™1*2, com2 COMI COMI
PS-3700A (Pentium®4-M) | COM1"!, com2™!, 0 )
PS-3710A COM3"?, COM4 COM3 COM3
PS-3711A coM1™!, com2™ com2™ coMm2™
PS4000"3 COM1, COM2 - -

com1*1*2, com2™, 1) 1%
PL3000 COMS3, COM4 COMI COMI
PE-4000B Atom N270 COM1, COM2 - -

COM3™, CcoM4™, | coM3™, comM4™,

PE-4000B Atom N2600 COM1, COM2 COMS™. CoM6™ COMS™ CoM6™
PS5000 (Slim Panel Type 4 4 *4
Core i3 Model) *> *6 COM1, COM2 COM2 COM2
PS5000 (Slim Panel Type
Atom Model) coMm1, com2™7 com2™7 com2™?
*5 %6
PSSOQ% (Enclosed Panel COMI ) i
Type)
55856000 (Modular Type) com1*7 com1*7 com1*’

*1  The RI/5V can be switched. Use the IPC’s switch to change if necessary.

*2  Set up the SIO type with the DIP Switch. Please set up as follows according to SIO type to be used.

*3  When making communication between an External Device and COM port on the Expansion slot,
only RS-232C is supported. However, ER (DTR/CTS) control cannot be executed because of the
specification of COM port.
For connection with External Device, use user-created cables and disable Pin Nos. 1,4, 6 and 9.
Please refer to the IPC manual for details of pin layout.

*4  Set up the SIO type with the BIOS. Please refer to the [IPC manual for details of BIOS.

GP-Pro EX Device/PLC Connection Manual




MODBUS SIO Master Driver

*S  When setting up communication between an External Device and the RS-232C/422/485 interface
module, use the IPC (RS-232C) or PS5000 (RS-422/485) cable diagrams. However, when using
PFXZPBMPR42P2 in a RS-422/485 (4-wire) configuration with no flow control, connect 7.RTS+
and 8.CTS+, and connect 6.RTS- and 9.CTS-.

When using RS-422/485 communication with External Devices, you may need to reduce the
transmission speed and increase the TX Wait time.

*6  To use RS-422/485 communication on the RS-232C/422/485 interface module, the DIP Switch
setting is required. Please refer to "Knowledge Base" (FAQs) on the support site. (http://www.pro-
face.com/trans/en/manual/1001.html)

Settings FAQ ID
PFXZPBMPR42P2, RS422/485 change method FA263858
PFXZPBMPRA42P2 termination resistor setting FA263974
PFXZPBMPR44P2, RS422/485 change method FA264087
PFXZPBMPR44P2 termination resistor setting FA264088

*7  Setup the SIO type with the DIP Switch. Please refer to the IPC manual for details of DIP Switch.

*8  For the connection with the External Device, on the user-created cable read as if the connector on
the Display-side is a M12 A-coding 8 pin socket. The pin assignment is the same as described in
the cable diagram. For the M12 A-coding connector, use PEXZPSCNM122.

DIP Switch settings (PL3000 / PS3000 Series)

RS-232C
DIP Switch Setting Description
1 OFF"! Reserved (always OFF)
2 OFF
SIO type: RS-232C
3 OFF
4 OFF Output mode of SD (TXD) data: Always output
5 OFF Terminal resistance (220Q2) insertion to SD (TXD): None
6 OFF Terminal resistance (220Q2) insertion to RD (RXD): None
7 OFF Short-circuit of SDA (TXA) and RDA (RXA): Not available
8 OFF Short-circuit of SDB (TXB) and RDB (RXB): Not available
9 OFF
RS (RTS) Auto control mode: Disabled
10 OFF

*1  When using PS-3450A, PS-3451A, PS3000-BA and PS3001-BD, turn ON the set value.

GP-Pro EX Device/PLC Connection Manual 9



MODBUS SIO Master Driver

RS-422/485 (4 wire)

DIP Switch Setting Description
1 OFF Reserved (always OFF)
2 ON
SIO type: RS-422/485
3 ON
4 OFF Output mode of SD (TXD) data: Always output
5 OFF Terminal resistance (220€2) insertion to SD (TXD): None
6 OFF Terminal resistance (220€2) insertion to RD (RXD): None
7 OFF Short-circuit of SDA (TXA) and RDA (RXA): Not available
8 OFF Short-circuit of SDB (TXB) and RDB (RXB): Not available
9 OFF
RS (RTS) Auto control mode: Disabled
10 OFF

RS-422/485 (2 wire)

DIP Switch Setting Description
1 OFF Reserved (always OFF)
2 ON
SIO type: RS-422/485
3 ON
4 OFF Output mode of SD (TXD) data: Always output
5 OFF Terminal resistance (220Q2) insertion to SD (TXD): None
6 OFF Terminal resistance (220€2) insertion to RD (RXD): None
7 ON Short-circuit of SDA (TXA) and RDA (RXA): Available
8 ON Short-circuit of SDB (TXB) and RDB (RXB): Available
9 ON
RS (RTS) Auto control mode: Enabled
10 ON

GP-Pro EX Device/PLC Connection Manual 10



MODBUS SIO Master Driver

Selection of External Device

Select the External Device to be connected to the Display.

£* Welcome to GP-Pro EX |

E‘F"'JP[’I’! E7 Mumber of Devices/PLCs Iﬁg
Device/PLC 1
Manufacturer | Schhneider Electic 54 |L
Series MODBUS 510 Master [~
Fart COM1 [~
Eefer to the manual of this Device/PLC
Eecent Device/PLC

%ﬂ" h [~ Use System Area Drevice Information

— Device/PLC

A 15

Back [B] | Communication Settings | Mew Screen I Cancel

Setup Items

Setup Description

Number of Devices/
PLCs

Enter an integer from 1 to 4 to define the number of Devices/PLCs to connect to the display.

Manufacturer

Select the manufacturer of the External Device to connect. Select "Schneider Electric SA".

Series

Select the External Device model (series) and the connection method. Select "MODBUS SIO

Master".
In System configuration, make sure the External Device you are connecting is supported by
"MODBUS SIO Master".

& System Configuration" (page 3)

Port

Select the Display port to connect to the External Device.

Use System Area

Check this option to synchronize the system data area of the Display and the device (memory)
of the External Device. When synchronized, you can use the External Device’s ladder program
to switch the display or display the window on the Display.

Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
This feature can also be set in GP-Pro EX or in the Display's offline mode.

Cf. GP-Pro EX Reference Manual "System Settings [Display Unit] - [System Area]

Settings Guide"
Cf. Maintenance/Troubleshooting Guide "Main Unit - System Area Settings"

GP-Pro EX Device/PLC Connection Manual 11




3 Example of Communication Setting

MODBUS SIO Master Driver

Examples of communication settings of the Display and the External Device, recommended by Pro-face, are

shown.

3.1 Setting Example 1
W Settings of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Devica/PLC 1 |
Summary Change Device/PLC
M anufacturer ISchneider Electic 54 Series MODEUS 510 baster Part  |COM1
Text Data Mode I‘I_ Change
Communication Settings
SI0 Type &+ R5232C RS 422/4552wire] A5 422455 wire]
Speed ISBDD 'l
Data Length 7 Lol
Parity  HONE &+ EVEN  0oD
Stop Bit 1 -
Flow Contral & HONE  ER[DTRACTS) L el i
Timeout I 3 3: [zec]
Fietry |2 3:
Wwiatt To Send |5 3: [ms] v Default Value
Rl /WCC @ Rl  WEC
I the case of R5232C, you can select the Sth pin to Rl [Input)
or WCC (5% Power Supply). If you uze the Digital's RS232C
Isolation Unit, please select it to WCC. Diefault
Device-Specific Settings
Allowveable Mumber Add Device
of Devices/PLCs 16
Add Indirect
Mo, Device Mame Seftings Device
lz‘ 1 IF'LEI‘I @ ISIave Equipment Address=1 Fest of the bits in this wol 8

GP-Pro EX Device/PLC Connection Manual 12



MODBUS SIO Master Driver

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] B .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

[Equipment Configuration] tab [Max Query] tab
E;Individual Device Settings & x| ﬁl‘lndividual Device Settings x|
PLCI FLCY
Equipment Gantiguration | Mas Query | Equipment Ganfiguration  Max Query |
—Equipment Address
Slave Equipment Address I] E Address Function Codes Max Cluery
—Bit manipulation (zet/reset) to Holding Register —————————— Coil (0} Read (01H) 1008 ~| bits
Rest of the bitz in this ward ¢ Clear & Da not clear Goil (1) Wirite (OFH) B0l = bits
Mote on when selecting Do not clear” : 5 5
If the ladder program writes data to Holding Reeister durine Digcrete Input (13 Read (02H) 1008 ~| bits
the read/write process, the resulting data may be incorrect.
Ihput Reeister (31 Read (04H) IBS E words
IECHT131 Synt.
g bl Holding Reeister (4) Read (03H) IBS E words
fddress Maode |D—based {Default) =
Holding Reeister (4) ‘Wite {10H) Iﬁ] E words
™ SoMachine Basic Syntas
If you chanee the setting, please reconfirm all address [ Single Bit manipulation to Coil/Discrete nput
settings.
—Wariables
Double Word word order Lawe word first{L/H) LI

[~ Low Security Level

Detault | Detault |
oK@ | Cancel | oK@ | Cancel |

B Settings of External Device
Use the ladder software "PL7 PRO" for communication settings.
Double-click "Hardware Configuration" from "Configuration" in "Application Browser" of "PL7 PRO". Next,
double-click "Comm" in the "Configuration" dialog box. Perform the settings in the displayed dialog box.

Setup Items Setup Description

CHANNEL 0

CHANNEL
MODBUS/JBUS LINK MAST

Slave number 1

Transmission speed 9600bps

Delay between characters Smsec

Data RTU (8 bit)

Stop 1 bit

Parity Even

@ Notes

» Please refer to the manual of the ladder software for more detail on other setting description.

GP-Pro EX Device/PLC Connection Manual 13



3.2 Setting Example 2
W Settings of GP-Pro EX

4 Communication Settings

MODBUS SIO Master Driver

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Devica/PLC 1 |
Summary Change Device/PLC
M anufacturer ISchneider Electic 54 Series MODEUS 510 baster Part  |COM1
Text Data Mode I‘I_ Change
Communication Settings
SI0 Type &+ R5232C RS 422/4552wire] A5 422455 wire]
Speed ISBDD 'l
Data Length 7 Lol
Parity  HONE &+ EVEN  0oD
Stop Bit 1 -
Flow Contral & HONE  ER[DTRACTS) L el i
Timeout I 3 3: [zec]
Fietry |2 3:
Wwiatt To Send |5 3: [ms] v Default Value
Rl /WCC @ Rl  WEC
I the case of R5232C, you can select the Sth pin to Rl [Input)
or WCC (5% Power Supply). If you uze the Digital's RS232C
Isolation Unit, please select it to WCC. Diefault
Device-Specific Settings
Allowveable Mumber Add Device
of Devices/PLCs 16
Add Indirect
Mo, Device Mame Seftings Device
lz‘ 1 IF'LEI‘I @ ISIave Equipment Address=1 Fest of the bits in this wol 8

GP-Pro EX Device/PLC Connection Manual 14



MODBUS SIO Master Driver

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] B .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

[Equipment Configuration] tab [Max Query] tab

£ Individual Device Settings 3 x| £ Individual Device Settings x|

PLCI FLCY

Equipment Configuration | Max Query I Equinment Configuration  Max Guery |

—Equipment Address

Slave Equipment Address I] E Address Function Codes Max Cluery
—Bit manipulation {set/reset) to Holding Register ——————————— Cail (0} Read (01H) 1008 ~ bits
Rest of the bitz in this ward ¢ Clear & Da not clear Goil (1) Wirite (OFH) B0l T bite
Mote on when selecting Do not clear” : . )
If the ladder program writes data to Holding Reeister durine Discrete Input (1) Read (02H) 1008 ~ bits

the read/write process, the resulting data may be incorrect.
Input Register (3}  Read (04H)

I i3 E words
I i3 E words
I fil E words

[~ Sinele Bit manipulation to Goil/Discrete Ihput

1 IECE1121 Syntax
Address Mode

Holding Register (4} Read (03H)

I-based {Default) >
I = Holding Register (4] Write (10H)

™ SoMachine Basic Syntas

If vou change the setting, please reconfirm all address
settings.

—Wariables

Double Word word order Lawe word first{L/H) LI

[~ Low Security Level

Detault |
oK@ | Cancel |

Detault |
oK@ | Cancel |

W Settings of External Device
Use the ladder software "PL7 PRO" for communication settings.
Double-click "Hardware Configuration" from "Configuration" in "Application Browser" of "PL7 PRO". Next,

double-click "Comm" in the "Configuration" dialog box. Perform the settings in the displayed dialog box.

Setup Items Setup Description

CHANNEL 1

CHANNEL TSX SCP 111 RS232 MP PCMCIA CARD
MODBUS/JBUS LINK MAST

Slave number 1

Type Slave

Transmission speed 9600bps

Delay between characters 4msec

Data RTU (8 bit)

Stop 1 bit

Parity Even

@ Notes

Please refer to the manual of the ladder software for more detail on other setting description.
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3.3 Setting Example 3
W Settings of GP-Pro EX

4 Communication Settings

MODBUS SIO Master Driver

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Devica/PLC 1 |
Summary Change Device/PLC
M anufacturer ISchneider Electic 54 Series MODEUS 510 baster Part  |COM1
Text Data Mode I‘I_ Change
Communication Settings
SI0 Type  R5232C & R5422/4552wire] A5 422455 wire]
Speed ISBDD 'l
Data Length 7 Lol
Parity  HONE &+ EVEN  0oD
Stop Bit 1 -
Flow Contral & HONE  ER[DTRACTS) L el i
Timeout I 3 3: [zec]
Fietry |2 3:
Wwiatt To Send |5 3: [ms] v Default Value
Rl /WCC Lo LT
I the case of R5232C, pou can select the Sth pin to Bl [Input)
or YL (5% Power Supply). If you uze the Digital's A5232C
|zolation Unit, please select it to WL, Diefault
Device-Specific Settings
Allowveable Mumber Add Device
of Devices/PLCs 16
Add Indirect
Mo. Device Mame Settings Device
lz‘ 1 IF'LEI‘I @ ISIave Equipment Address=1 Fest of the bits in this wol

GP-Pro EX Device/PLC Connection Manual 16
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@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] B .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

[Equipment Configuration] tab [Max Query] tab

£ Individual Device Settings 3 x| £ Individual Device Settings x|

PLCI FLCY

Equipment Configuration | Max Query I Equinment Configuration  Max Guery |

—Equipment Address

Slave Equipment Address I] E Address Function Codes Max Cluery
—Bit manipulation {set/reset) to Holding Register ——————————— Cail (0} Read (01H) 1008 ~ bits
Rest of the bitz in this ward ¢ Clear & Da not clear Goil (1) Wirite (OFH) B0l T bite
Mote on when selecting Do not clear” : . )
If the ladder program writes data to Holding Reeister durine Discrete Input (1) Read (02H) 1008 ~ bits

the read/write process, the resulting data may be incorrect.
Input Register (3}  Read (04H)

I i3 E words
I i3 E words
I fil E words

[~ Sinele Bit manipulation to Goil/Discrete Ihput

1 IECE1121 Syntax
Address Mode

Holding Register (4} Read (03H)

I-based {Default) >
I = Holding Register (4] Write (10H)

™ SoMachine Basic Syntas

If vou change the setting, please reconfirm all address
settings.

—Wariables

Double Word word order Lawe word first{L/H) LI

[~ Low Security Level

Detault |
oK@ | Cancel |

Detault |
oK@ | Cancel |

B Settings of External Device
Use the ladder software "PL7 PRO" for communication settings.
Double-click "Hardware Configuration" from "Configuration" in "Application Browser" of "PL7 PRO". Next,

double-click "Comm" in the "Configuration" dialog box. Perform the settings in the displayed dialog box.

Setup Items Setup Description

CHANNEL 1

CHANNEL TSX SCP 114 RS485 MP PCMCIA CARD
MODBUS/JBUS LINK MAST

Slave number 1

Type Slave

Transmission speed 9600bps

Delay between characters 4msec

Data RTU (8 bit)

Stop 1 bit

Parity Even

@ Notes

Please refer to the manual of the ladder software for more detail on other setting description.

GP-Pro EX Device/PLC Connection Manual 17




3.4 Setting Example 4
W Settings of GP-Pro EX

4 Communication Settings

MODBUS SIO Master Driver

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Devica/PLC 1 |
Summary Change Device/PLC
M anufacturer ISchneider Electic 54 Series MODEUS 510 baster Part  |COM1
Text Data Mode I‘I_ Change
Communication Settings
SI0 Type &+ R5232C RS 422/4552wire] A5 422455 wire]
Speed ISBDD 'l
Data Length 7 Lol
Parity  HONE &+ EVEN  0oD
Stop Bit 1 -
Flow Contral & HONE  ER[DTRACTS) L el i
Timeout I 3 3: [zec]
Fietry |2 3:
Wwiatt To Send |5 3: [ms] v Default Value
Rl /WCC @ Rl  WEC
I the case of R5232C, you can select the Sth pin to Rl [Input)
or WCC (5% Power Supply). If you uze the Digital's RS232C
Isolation Unit, please select it to WCC. Diefault
Device-Specific Settings
Allowveable Mumber Add Device
of Devices/PLCs 16
Add Indirect
Mo, Device Mame Seftings Device
lz‘ 1 IF'LEI‘I @ ISIave Equipment Address=1 Fest of the bits in this wol
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@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] B .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

[Equipment Configuration] tab [Max Query] tab

£ Individual Device Settings 3 x| £ Individual Device Settings x|

PLCI FLCY

Equipment Configuration | Max Query I Equinment Configuration  Max Guery |

—Equipment Address

Slave Equipment Address I] E Address Function Codes Max Cluery
—Bit manipulation {set/reset) to Holding Register ——————————— Cail (0} Read (01H) 1008 ~ bits
Rest of the bitz in this ward ¢ Clear & Da not clear Goil (1) Wirite (OFH) B0l T bite
Mote on when selecting Do not clear” : . )
If the ladder program writes data to Holding Reeister durine Discrete Input (1) Read (02H) 1008 ~ bits

the read/write process, the resulting data may be incorrect.

Ihput Reeister (31 Read (04H) IBS E words
IECHT131 Synt.
g bl Holding Reeister (4) Read (03H) IBS E words
fddress Maode |D—based {Default) =
Holding Reeister (4) ‘Wite {10H) Iﬁ] E words

™ SoMachine Basic Syntas

If you change the setting, please reconfirm all address [ Single Bit manipulation to Coil/Discrete nput

settings.

—Wariables

Double Word word order Lawe word first{L/H) LI

[~ Low Security Level

Detault |
oK@ | Cancel |

Detault |
oK@ | Cancel |

B Settings of External Device
Use the ladder software "PL7 PRO" for communication settings.
Double-click "Hardware Configuration" from "Configuration" in "Application Browser" of "PL7 PRO". Next,

double-click "Comm" in the "Configuration" dialog box. Perform the settings in the displayed dialog box.

Setup Items Setup Description

CHANNEL 1

CHANNEL TSX SCP 111 RS232 MP PCMCIA CARD
MODBUS/JBUS LINK MAST

Type Slave

Slave number 1

Transmission speed 9600bps

Delay between characters 4msec

Data RTU (8 bit)

Stop 1 bit

Parity Even

@ Notes

» Please refer to the manual of the ladder software for more detail on other setting description.
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3.5 Setting Example 5
W Settings of GP-Pro EX

4 Communication Settings

MODBUS SIO Master Driver

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Devica/PLC 1 |
Summary Change Device/PLC
M anufacturer ISchneider Electic 54 Series MODEUS 510 baster Part  |COM1
Text Data Mode I‘I_ Change
Communication Settings
SI0 Type  R5232C & R5422/4552wire] A5 422455 wire]
Speed ISBDD 'l
Data Length 7 Lol
Parity  HONE &+ EVEN  0oD
Stop Bit 1 -
Flow Contral & HONE  ER[DTRACTS) L el i
Timeout I 3 3: [zec]
Fietry |2 3:
Wwiatt To Send |5 3: [ms] v Default Value
Rl /WCC Lo LT
I the case of R5232C, pou can select the Sth pin to Bl [Input)
or YL (5% Power Supply). If you uze the Digital's A5232C
|zolation Unit, please select it to WL, Diefault
Device-Specific Settings
Allowveable Mumber Add Device
of Devices/PLCs 16
Add Indirect
Mo, Device Mame Seftings Device
lz‘ 1 IF'LEI‘I @ ISIave Equipment Address=1 Fest of the bits in this wol
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MODBUS SIO Master Driver

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] B .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

[Equipment Configuration] tab [Max Query] tab

£ Individual Device Settings 3 x| £ Individual Device Settings x|

PLCI FLCY

Equipment Configuration | Max Query I Equinment Configuration  Max Guery |

—Equipment Address

Slave Equipment Address I] E Address Function Codes Max Cluery
—Bit manipulation {set/reset) to Holding Register ——————————— Cail (0} Read (01H) 1008 ~ bits
Rest of the bitz in this ward ¢ Clear & Da not clear Goil (1) Wirite (OFH) B0l T bite
Mote on when selecting Do not clear” : . )
If the ladder program writes data to Holding Reeister durine Discrete Input (1) Read (02H) 1008 ~ bits

the read/write process, the resulting data may be incorrect.

Ihput Reeister (31 Read (04H) IBS E words
IECHT131 Synt.
g bl Holding Reeister (4) Read (03H) IBS E words
fddress Maode |D—based {Default) =
Holding Reeister (4) ‘Wite {10H) Iﬁ] E words

™ SoMachine Basic Syntas

If you change the setting, please reconfirm all address [ Single Bit manipulation to Coil/Discrete nput

settings.

—Wariables

Double Word word order Lawe word first{L/H) LI

[~ Low Security Level

Detault |
oK@ | Cancel |

Detault |
oK@ | Cancel |

B Settings of External Device
Use the ladder software "PL7 PRO" for communication settings.
Double-click "Hardware Configuration" from "Configuration" in "Application Browser" of "PL7 PRO". Next,

double-click "Comm" in the "Configuration" dialog box. Perform the settings in the displayed dialog box.

Setup Items Setup Description

CHANNEL 1

CHANNEL TSX SCP 114 RS485 MP PCMCIA CARD
MODBUS/JBUS LINK MAST

Type Slave

Slave number 1

Transmission speed 9600bps

Delay between characters 4msec

Data RTU (8 bit)

Stop 1 bit

Parity Even

@ Notes

Please refer to the manual of the ladder software for more detail on other setting description.
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3.6 Setting Example 6
W Settings of GP-Pro EX

4 Communication Settings

MODBUS SIO Master Driver

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Devica/PLC 1 |
Summary Change Device/PLC
M anufacturer ISchneider Electic 54 Series MODEUS 510 baster Part  |COM1
Text Data Mode I‘I_ Change
Communication Settings
SI0 Type &+ R5232C RS 422/4552wire] A5 422455 wire]
Speed |192DD 'l
Data Length 7 Lol
Parity & HONE  EVEN  0oD
Stop Bit 1 -
Flow Contral & HONE  ER[DTRACTS) L el i
Timeout I 3 3: [zec]
Fietry |2 3:
Wwiatt To Send |2 3: [ms] v Default Value
Rl /WCC @ Rl  WEC
I the case of R5232C, you can select the Sth pin to Rl [Input)
or WCC (5% Power Supply). If you uze the Digital's RS232C
Isolation Unit, please select it to WCC. Diefault
Device-Specific Settings
Allowveable Mumber Add Device
of Devices/PLCs 16
Add Indirect
Mo. Device Mame Settings Device
lz‘ 1 IF'LEI‘I @ ISIave Equipment Address=1 Fest of the bits in this wol
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MODBUS SIO Master Driver

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] B .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

[Equipment Configuration] tab [Max Query] tab
£ Individual Device Settings 3 x| £ Individual Device Settings x|
PLCI FLCY
Equipment Configuration | Max Cluery | | Equipment Configuration  Max Guery |
—Equipment Address
Slave Equipment Address I] E Address Function Codes Max Cluery
—Bit manipulation {set/reset) to Holding Register ——————————— Cail (0} Read (01H) 2000 ~ bits
Rest of the bitz in this ward ¢ Clear & Da not clear Goil (1) Wirite (OFH) B0l T bite

Mote on when selecting Do not clear” : ) )
If the ladder program writes data to Holding Reeister durine Discrete Input (1) Read (02H) 2000 ~ bits

the read/write process, the resulting data may be incorrect.
Ihput Reeister (31 Read (04H) |]25 E words

Holding Reeister (4) Read (03H) |]25 E words
Holding Reeister (4) ‘Wite {10H) I]DD E words

1 IECE1121 Syntax
fddress Maode |D—based {Default) =

™ SoMachine Basic Syntas

If you change the setting, please reconfirm all address [ Single Bit manipulation to Coil/Discrete nput
settings.

—Wariables
Double Ward word order Lawe word first{L/H) LI

[~ Low Security Level

Detault | Detault |
oK@ | Cancel | oK@ | Cancel |

B Settings of External Device
Use the ladder software "TwidoSoft" for communication settings.
Select "Hardware" from "TWDLMDA40DUK" in "Application Browser" of "TwidoSoft", and right-click on
"Port 1 : Remote Link, 1" to select "Edit Controller Comm Setup...".

Perform the settings in the "Controller Communication Setup" dialog box displayed next.

Setup Items Setup Description

Type Modbus
Protocol

Address 1

Baud Rate 19200

Data Bits 8
Parameters

Parity None

Stop Bits 1
End of Frame 10
Response Timeout 10 x 100msec
Frame Timeout 4msec

® Notes

Please refer to the manual of the ladder software for more detail on other setting description.
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3.7 Setting Example 7
W Settings of GP-Pro EX

4 Communication Settings

MODBUS SIO Master Driver

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Devica/PLC 1 |
Summary Change Device/PLC
M anufacturer ISchneider Electic 54 Series MODEUS 510 baster Part  |COM1
Text Data Mode I‘I_ Change
Communication Settings
SI0 Type  R5232C & R5422/4552wire] A5 422455 wire]
Speed |192DD 'l
Data Length 7 Lol
Parity  HONE &+ EVEN  0oD
Stop Bit 1 -
Flow Contral & HONE  ER[DTRACTS) L el i
Timeout I 3 3: [zec]
Fietry |2 3:
Wwiatt To Send |3 3: [ms] v Default Value
Rl /WCC Lo LT
I the case of R5232C, pou can select the Sth pin to Bl [Input)
or YL (5% Power Supply). If you uze the Digital's A5232C
|zolation Unit, please select it to WL, Diefault
Device-Specific Settings
Allowveable Mumber Add Device
of Devices/PLCs 16
Add Indirect
Mo, Device Mame Seftings Device
lz‘ 1 IF'LEI‘I @ ISIave Equipment Address=1 Fest of the bits in this wol
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MODBUS SIO Master Driver

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] B .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

[Equipment Configuration] tab [Max Query] tab
£ Individual Device Settings 3 x| £ Individual Device Settings x|
PLCI FLCY
Equipment Configuration | Max Cluery | | Equipment Configuration  Max Guery |
—Equipment Address
Slave Equipment Address I] E Address Function Codes Max Cluery
—Bit manipulation {set/reset) to Holding Register ——————————— Cail (0} Read (01H) 2000 ~ bits
Rest of the bitz in this ward ¢ Clear & Da not clear Goil (1) Wirite (OFH) B0l T bite

Mote on when selecting Do not clear” : ) )
If the ladder proeram writes data to Halding Register during Discrete Input (1) Read (02H) 2000 ~ bits

the read/write process, the resulting data may be incorrect.
Ihput Reeister (31 Read (04H) |]25 E words

Holding Reeister (4) Read (03H) |]25 E words
Holding Reeister (4) ‘Wite {10H) I]DD E words

1 IECE1121 Syntax
fddress Maode |D—based {Default) =

™ SoMachine Basic Syntas

If you change the setting, please reconfirm all address [ Single Bit manipulation to Coil/Discrete nput
settings.

—Wariables
Double Ward word order Lawe word first{L/H) LI

[~ Low Security Level

Detault | Detault |
oK@ | Cancel | oK@ | Cancel |

B Settings of External Device
Use the ladder software "TwidoSoft" for communication settings.
Right-click on "Hardware" from "TWDLMDA40DUK" in "Application Browser" of "TwidoSoft" to select "Add
Option...". Right-click on "Port 2 : Modbus, 1" added to "Hardware" in "TWDLMDA40DUK" to select "Edit
Controller Comm Setup...".

Perform the settings in the "Controller Communication Setup" dialog box displayed next.

Setup Items Setup Description

Type Modbus
Protocol

Address 1

Baud Rate 19200

Data Bits 8
Parameters

Parity None

Stop Bits 1
End of Frame 10
Response Timeout 10 x 100msec
Frame Timeout 10msec

# Notes

Please refer to the manual of the ladder software for more detail on other setting description.
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3.8 Setting Example 8
W Settings of GP-Pro EX

4 Communication Settings

MODBUS SIO Master Driver

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Devica/PLC 1 |
Summary Change Device/PLC
M anufacturer ISchneider Electic 54 Series MODEUS 510 baster Part  |COM1
Text Data Mode I‘I_ Change
Communication Settings
SI0 Type &+ R5232C RS 422/4552wire] A5 422455 wire]
Speed |192DD 'l
Data Length 7 Lol
Parity  HONE &+ EVEN  0oD
Stop Bit 1 -
Flow Contral & HONE  ER[DTRACTS) L el i
Timeout I 3 3: [zec]
Fietry |2 3:
Wwiatt To Send |3 3: [ms] v Default Value
Rl /WCC @ Rl  WEC
I the case of R5232C, you can select the Sth pin to Rl [Input)
or WCC (5% Power Supply). If you uze the Digital's RS232C
Isolation Unit, please select it to WCC. Diefault
Device-Specific Settings
Allowveable Mumber Add Device
of Devices/PLCs 16
Add Indirect
Mo, Device Mame Seftings Device
lz‘ 1 IF'LEI‘I @ ISIave Equipment Address=1 Fest of the bits in this wol 8
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MODBUS SIO Master Driver

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] B .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

[Equipment Configuration] tab [Max Query] tab
E;Individual Device Settings & x| ﬁl‘lndividual Device Settings x|
PLCI FLCY
Equipment Gantiguration | Mas Query | Equipment Ganfiguration  Max Query |
—Equipment Address
Slave Equipment Address I] E Address Function Codes Max Cluery
—Bit manipulation {set/reset) to Holding Register ——————————— Cail (0} Read (01H) 2000 ~ bits
Rest of the bitz in this ward ¢ Clear & Da not clear Goil (1) Wirite (OFH) B0l = bits
Mote on when selecting Do not clear” : 5 5
If the ladder program writes data to Holding Reeister durine Digcrete Input (13 Read (02H) 2000 ~| bits
the read/write process, the resulting data may be incorrect.
Ihput Reeister (31 Read (04H) |]25 E words
IECHT131 Synt.
g bl Holding Reeister (4) Read (03H) |]25 E words
fddress Maode |D—based {Default) =
Holding Reeister (4) ‘Wite {10H) I]DD E words
™ SoMachine Basic Syntas
If you chanee the setting, please reconfirm all address [ Single Bit manipulation to Coil/Discrete nput
settings.
—Wariables
Double Word word order Lawe word first{L/H) LI

[~ Low Security Level

Detault | Detault |
oK@ | Cancel | oK@ | Cancel |

B Settings of External Device
Use the ladder software "Concept" for communication settings.
After selecting the External Device in Quantum Series in "PLC Selection" of "Concept", select "Modbus Port

Settings" and perform the settings in the "Modbus Port Settings" dialog box.

Setup Items Setup Description

Baud 19200
Data Bits 8
Stop Bits 1
Parity Even
Delay(ms) 10
Address 1
Head slot 0
Mode RTU
Protocol RS232

@ Notes

Please refer to the manual of the ladder software for more detail on other setting description.

GP-Pro EX Device/PLC Connection Manual 27



3.9 Setting Example 9
W Settings of GP-Pro EX

4 Communication Settings

MODBUS SIO Master Driver

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Devica/PLC 1 |
Summary Change Device/PLC
M anufacturer ISchneider Electic 54 Series MODEUS 510 baster Part  |COM1
Text Data Mode I‘I_ Change
Communication Settings
SI0 Type &+ R5232C RS 422/4552wire] A5 422455 wire]
Speed |192DD 'l
Data Length 7 Lol
Parity  HONE &+ EVEN  0oD
Stop Bit 1 -
Flow Contral & HONE  ER[DTRACTS) L el i
Timeout I 3 3: [zec]
Fietry |2 3:
Wwiatt To Send |3 3: [ms] v Default Value
Rl /WCC @ Rl  WEC
I the case of R5232C, you can select the Sth pin to Rl [Input)
or WCC (5% Power Supply). If you uze the Digital's RS232C
Isolation Unit, please select it to WCC. Diefault
Device-Specific Settings
Allowveable Mumber Add Device
of Devices/PLCs 16
Add Indirect
Mo, Device Mame Seftings Device
lz‘ 1 IF'LEI‘I @ ISIave Equipment Address=1 Fest of the bits in this wol 8
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MODBUS SIO Master Driver

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] B .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

[Equipment Configuration] tab [Max Query] tab
£ Individual Device Settings 3 x| £ Individual Device Settings x|
PLCI FLCY
Equipment Gantiguration | Mas Query | Equipment Ganfiguration  Max Query |
—Equipment Address
Slave Equipment Address I] E Address Function Codes Max Cluery
—Bit manipulation {set/reset) to Holding Register ——————————— Cail (0} Read (01H) 2000 ~ bits
Rest of the bitz in this ward ¢ Clear & Da not clear Goil (1) Wirite (OFH) B0l = bits
Mote on when selecting Do not clear” : 5 5
If the ladder program writes data to Holding Reeister durine Digcrete Input (13 Read (02H) 2000 ~| bits
the read/write process, the resulting data may be incorrect.
Ihput Reeister (31 Read (04H) |]25 E words
IECHT131 Synt.
g bl Holding Reeister (4) Read (03H) |]25 E words
fddress Maode |D—based {Default) =
Holding Reeister (4) ‘Wite {10H) I]DD E words
™ SoMachine Basic Syntas
If you chanee the setting, please reconfirm all address [ Single Bit manipulation to Coil/Discrete nput
settings.
—Wariables
Double Word word order Lawe word first{L/H) LI

[~ Low Security Level

Detault | Detault |
oK@ | Cancel | oK@ | Cancel |

B Settings of External Device
Use the ladder software "Concept" for communication settings.
After selecting the External Device in Momentum Series in "PLC Selection" of "Concept", select "Modbus Port

Settings" and perform the settings in the "Modbus Port Settings" dialog box.

Setup Items Setup Description

Baud 19200
Data Bits 8
Stop Bits 1
Parity Even
Delay(ms) 10
Address 1
Head slot 0
Mode RTU
Protocol RS232

@ Notes

Please refer to the manual of the ladder software for more detail on other setting description.
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3.10 Setting Example 10
W Settings of GP-Pro EX

4 Communication Settings

MODBUS SIO Master Driver

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Devica/PLC 1 |
Summary Change Device/PLC
M anufacturer ISchneider Electic 54 Series MODEUS 510 baster Part  |COM1
Text Data Mode I‘I_ Change
Communication Settings
SI0 Type  R5232C RS 422/4552wire] & R5422/455 wire]
Speed |192DD 'l
Data Length 7 Lol
Parity  HONE &+ EVEN  0oD
Stop Bit 1 -
Flow Contral & HONE  ER[DTRACTS) L el i
Timeout I 3 3: [zec]
Fietry |2 3:
Wwiatt To Send |3 3: [ms] v Default Value
Rl /WCC Lo LT
I the case of R5232C, pou can select the Sth pin to Bl [Input)
or YL (5% Power Supply). If you uze the Digital's A5232C
|zolation Unit, please select it to WL, Diefault
Device-Specific Settings
Allowveable Mumber Add Device
of Devices/PLCs 16
Add Indirect
Mo, Device Mame Seftings Device
lz‘ 1 IF'LEI‘I @ ISIave Equipment Address=1 Fest of the bits in this wol
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MODBUS SIO Master Driver

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] B .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

[Equipment Configuration] tab [Max Query] tab
E;Individual Device Settings & x| ﬁl‘lndividual Device Settings x|
PLCI FLCY
Equipment Gantiguration | Mas Query | Equipment Ganfiguration  Max Query |
—Equipment Address
Slave Equipment Address I] E Address Function Codes Max Cluery
—Bit manipulation {set/reset) to Holding Register ——————————— Cail (0} Read (01H) 2000 ~ bits
Rest of the bitz in this ward ¢ Clear & Da not clear Goil (1) Wirite (OFH) B0l = bits
Mote on when selecting Do not clear” : 5 5
If the ladder program writes data to Holding Reeister durine Digcrete Input (13 Read (02H) 2000 ~| bits
the read/write process, the resulting data may be incorrect.
Ihput Reeister (31 Read (04H) |]25 E words
IECHT131 Synt.
g bl Holding Reeister (4) Read (03H) |]25 E words
fddress Maode |D—based {Default) =
Holding Reeister (4) ‘Wite {10H) I]DD E words
™ SoMachine Basic Syntas
If you chanee the setting, please reconfirm all address [ Single Bit manipulation to Coil/Discrete nput
settings.
—Wariables
Double Word word order Lawe word first{L/H) LI

[~ Low Security Level

Detault | Detault |
oK@ | Cancel | oK@ | Cancel |

B Settings of External Device
Use the ladder software "Concept" for communication settings.
After selecting the External Device in Momentum Series in "PLC Selection" of "Concept", select "Modbus Port

Settings" and perform the settings in the "Modbus Port Settings" dialog box.

Setup Items Setup Description

Baud 19200
Data Bits 8
Stop Bits 1
Parity Even
Delay(ms) 10
Address 1
Head slot 0
Mode RTU
Protocol RS485

@ Notes

Please refer to the manual of the ladder software for more detail on other setting description.
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3.1 Setting Example 11
W Settings of GP-Pro EX

4 Communication Settings

MODBUS SIO Master Driver

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Devica/PLC 1 |
Summary Change Device/PLC
M anufacturer ISchneider Electic 54 Series MODEUS 510 baster Part  |COM1
Text Data Mode I‘I_ Change
Communication Settings
SI0 Type &+ R5232C RS 422/4552wire] A5 422455 wire]
Speed |192DD 'l
Data Length 7 Lol
Parity  HONE &+ EVEN  0oD
Stop Bit 1 -
Flow Contral & HONE  ER[DTRACTS) L el i
Timeout I 3 3: [zec]
Fietry |2 3:
Wwiatt To Send |3 3: [ms] v Default Value
Rl /WCC @ Rl  WEC
I the case of R5232C, you can select the Sth pin to Rl [Input)
or WCC (5% Power Supply). If you uze the Digital's RS232C
Isolation Unit, please select it to WCC. Diefault
Device-Specific Settings
Allowveable Mumber Add Device
of Devices/PLCs 16
Add Indirect
Mo, Device Mame Seftings Device
lz‘ 1 IF'LEI‘I @ ISIave Equipment Address=1 Fest of the bits in this wol 8
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MODBUS SIO Master Driver

@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] B .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

[Equipment Configuration] tab [Max Query] tab
£ Individual Device Settings 3 x| £ Individual Device Settings x|
PLCI FLCY
Equipment Gantiguration | Mas Query | Equipment Ganfiguration  Max Query |
—Equipment Address
Slave Equipment Address I] E Address Function Codes Max Cluery
—Bit manipulation {set/reset) to Holding Register ——————————— Cail (0} Read (01H) 2000 ~ bits
Rest of the bitz in this ward ¢ Clear & Da not clear Goil (1) Wkite (OFH) T T bits
Mote on when selecting Do not clear” : 5 5
If the ladder program writes data to Holding Reeister durine Digcrete Input (13 Read (02H) 2000 ~| bits
the read/write process, the resulting data may be incorrect.
Ihput Reeister (31 Read (04H) |]25 E words
IECHT131 Synt.
g bl Holding Reeister (4) Read (03H) |]25 E words
fddress Maode |D—based {Default) =
Holding Reeister (4) ‘Wite {10H) I]DD E words
™ SoMachine Basic Syntas
If you chanee the setting, please reconfirm all address [ Single Bit manipulation to Coil/Discrete nput
settings.
—Wariables
Double Word word order Lawe word first{L/H) LI

[~ Low Security Level

Detault | Detault |
oK@ | Cancel | oK@ | Cancel |

B Settings of External Device

Use the Web browser and ladder software (Logic Designer) for communication settings.

<Communication Settings for the Serial Port on CPU>
1 Set IP address of the External Device to "192.168.1.1".

NOTE * For more details on how to set IP address of the External Device, refer to the online help of the
dedicated tool for the FCN/FCJ basic settings (Resource Configurator).

2 Connect both the Ethernet ports between a PC and the External Device using the LAN cable. (Connect via HUB.)
3 Start up the Web browser.
4 Enter "http://192.168.1.1/mnt" in the address input box.
5 Enter [User Name] and [Password] in the displayed dialog box to login.
6 Click [Maintenance Menu] to display the [FCX Maintenance Menu] screen.
7 Click [Reboot] to display the [Reboot FCX] screen.
8 Check the [Reboot(Maintenance Mode)] option.
9 Click [OK] to display the [Reboot] screen.
10 Reboot the External Device. Confirm the reboot is complete.
11 Click [Maintenance Homepage] to display the [STARDOM FCX Maintenance Page] screen.
12 cClick [OK] to display the [FCX Maintenance Menu] screen.
13 Click [Edit] to display the [Edit System Setting Files] screen.
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14 Check the [COMI Port Setting File] option and click [OK].

15 Set each item as follows:

Setup Items Setup Description
Baudrate 19200
DataBitLength 8
StopBitLength 1
Parity EVEN

16 Click [OK] to display the [Edit System Setting Files(RESULT)] screen.
17 Click [Maintenance Menu] to display the [FCX Maintenance Menu] screen.

18 click [Reboot] to display the [Reboot FCX] screen.

19 Check the [Reboot(Online Mode)] option and click [OK].

The External Device is rebooted.

<Control Logic Download Procedures>

1 Start up the ladder software.

MODBUS SIO Master Driver

2 Create the control logic in order to start the MODBUS communication (RTU mode) slave function. For the

example of control logic, refer to "4 Control Logic Example".

&~ & Control Logic Example" (page 35)

3 Double-click ['COM1'] next to [PORT] to display the [Variable Properties] dialog box.

4 Enter the connecting port name in [Name], and click [OK].

5 Double-click [UNIT#1] next to [STATION] to display the [Variable Properties] dialog box.

6 Enter the connecting station name in [Name], and click [OK].

7 Select [Rebuild Project] from the [Build] menu.

8 Double-click [Target Setting] in the project tree window to display the [Target] dialog box.

9 Enter "192.168.1.1" in [Host Name/IP Address].

10 Click [OK].

11 Download the communication settings to the External Device.

12 Reboot the External Device.
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MODBUS SIO Master Driver
|

@ Control Logic Example
To connect the Display to the External Device, the control logic is required.

The control logic example is shown below.

SD_CMDBSM_BS_OPEN1
SD_CMDBSM_BS_OPEN

TRUE— REQ VALID —RTU_VALID1
'COM1'— PORT ERROR |—RTU_ERROR1
.— OPTION STATUS —RTU_STATUS1

UNIT#1 — STATION  POSITION —RTU_POSITION1
10.0— TOUT_VAL
FALSE— UNIT_CHARTM

'YOKOGAWA'— VENDOR
'STARDOM'— PRODUCT
'R1.80.01'— REVISION
COIL— COIL COIL COIL
DSCI— DSCI DSCI DSCI
IREG— IREG IREG —IREG
HREG—- HREG HREG +—HREG
ESTS— ESTS ESTS ESTS

RTU_COMERR1— COMERR — COMERR +—RTU_COMERR1
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3.12 Setting Example 12
W Settings of GP-Pro EX

4 Communication Settings

MODBUS SIO Master Driver

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Devica/PLC 1 |
Summary Change Device/PLC
M anufacturer ISchneider Electic 54 Series MODEUS 510 baster Part  |COM1
Text Data Mode I‘I_ Change
Communication Settings
SI0 Type &+ R5232C RS 422/4552wire] A5 422455 wire]
Speed |192DD 'l
Data Length 7 Lol
Parity  HONE &+ EVEN  0oD
Stop Bit 1 -
Flow Contral & HONE  ER[DTRACTS) L el i
Timeout I 3 3: [zec]
Fietry |2 3:
Wwiatt To Send |3 3: [ms] v Default Value
Rl /WCC @ Rl  WEC
I the case of R5232C, you can select the Sth pin to Rl [Input)
or WCC (5% Power Supply). If you uze the Digital's RS232C
Isolation Unit, please select it to WCC. Diefault
Device-Specific Settings
Allowveable Mumber Add Device
of Devices/PLCs 16
Add Indirect
Mo, Device Mame Seftings Device
lz‘ 1 IF'LEI‘I @ ISIave Equipment Address=1 Fest of the bits in this wol 8
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@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] B .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

[Equipment Configuration] tab [Max Query] tab
E;Individual Device Settings & x| ﬁl‘lndividual Device Settings x|
PLCI FLCY
Equipment Configuration | Max Cluery | | Equipment Configuration  Max Guery |
—Equipment Address
Slave Equipment Address I] E Address Function Codes Max Cluery
—Bit manipulation {set/reset) to Holding Register ——————————— Cail (0} Read (01H) 2000 ~ bits
Rest of the bitz in this ward ¢ Clear & Da not clear Goil (1) Wirite (OFH) B0l T bite

Mote on when selecting Do not clear” : ) )
If the ladder proeram writes data to Halding Register during Discrete Input (1) Read (02H) 2000 ~ bits

the read/write process, the resulting data may be incorrect.
Ihput Reeister (31 Read (04H) |]25 E words

Holding Reeister (4) Read (03H) |]25 E words
Holding Reeister (4) ‘Wite {10H) I]DD E words

1 IECE1121 Syntax
fddress Maode |D—based {Default) =

™ SoMachine Basic Syntas

If you change the setting, please reconfirm all address [ Single Bit manipulation to Coil/Discrete nput
settings.

—Wariables
Double Ward word order Lawe word first{L/H) LI

[~ Low Security Level

Detault | Detault |
oK@ | Cancel | oK@ | Cancel |

B Settings of External Device

Use the dedicated tool for basic settings (Resource Configurator) and ladder software (Logic Designer) for

communication settings.

<Communication Settings for the Communication Module>
1 Set IP address of the External Device to "192.168.1.1".

NOTE » For more details on how to set IP address of the External Device, refer to the online help of the
dedicated tool for the FCN/FCJ basic settings.

Start up the dedicated tool for the basic settings.

From the [File] menu, select [Connection] to display the [Connect] dialog box.
Enter "192.168.1.1" in [Host].

Enter [User Name] and [Password] to login.

Select the link I/F to use from the [Controller Configuration] tree view.

Enter the port name in [Port Name].

O~NO O, OWOWDN

Select [Port1] from the link I/F to use the [Controller Configuration] tree view.
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9 set specifications as follows:

Specifications

Setting

Wiring Method

Duplex Operation

Full-duplex

Baud Rate 19200
Data Bits 8
Parity Setting EVEN
Stop Bits 1

Send Signal Check NONE
Receive Flow Control | NONE
API Error Detection YES

10 Download the communication settings to the External Device.

11 Reboot the External Device.

<Control Logic Download Procedures>

N —

example of control logic, refer to "4 Control Logic Example".

& n

Start up the ladder software.

@ Control Logic Example" (page 39)

MODBUS SIO Master Driver

Create the control logic in order to start the MODBUS communication (RTU mode) slave function. For the

3 Double-click ['COM1'] next to [PORT] to display the [Variable Properties] dialog box.

4 Enter the connecting port name in [Name], and click [OK].

5 Double-click [UNIT#1] next to [STATION] to display the [Variable Properties] dialog box.

6 Enter the connecting station name in [Name], and click [OK].
7 Select [Rebuild Project] from the [Build] menu.

8 Double-click [Target Setting] in the project tree window to display the [Target] dialog box.

9 Enter "192.168.1.1" in [Host Name/IP Address].

10 Click [OK].

11 Download the communication settings to the External Device.

12 Reboot the External Device.
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@ Control Logic Example
To connect the Display to the External Device, the control logic is required.

The control logic example is shown below.

SD_CMDBSM_BS_OPEN1
SD_CMDBSM_BS_OPEN

TRUE— REQ VALID —RTU_VALID1
'COM1'— PORT ERROR |—RTU_ERROR1
.— OPTION STATUS —RTU_STATUS1

UNIT#1 — STATION  POSITION —RTU_POSITION1
10.0— TOUT_VAL
FALSE— UNIT_CHARTM

'YOKOGAWA'— VENDOR
'STARDOM'— PRODUCT
'R1.80.01'— REVISION
COIL— COIL COIL COIL
DSCI— DSCI DSCI DSCI
IREG— IREG IREG —IREG
HREG—- HREG HREG +—HREG
ESTS— ESTS ESTS ESTS

RTU_COMERR1— COMERR — COMERR +—RTU_COMERR1
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3.13 Setting Example 13
W Settings of GP-Pro EX

4 Communication Settings

MODBUS SIO Master Driver

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Devica/PLC 1 |
Summary Change Device/PLC
M anufacturer ISchneider Electic 54 Series MODEUS 510 baster Part  |COM1
Text Data Mode I‘I_ Change
Communication Settings
SI0 Type  R5232C RS 422/4552wire] & R5422/455 wire]
Speed |192DD 'l
Data Length 7 Lol
Parity  HONE &+ EVEN  0oD
Stop Bit 1 -
Flow Contral & HONE  ER[DTRACTS) L el i
Timeout I 3 3: [zec]
Fietry |2 3:
Wwiatt To Send |3 3: [ms] v Default Value
Rl /WCC Lo LT
I the case of R5232C, pou can select the Sth pin to Bl [Input)
or YL (5% Power Supply). If you uze the Digital's A5232C
|zolation Unit, please select it to WL, Diefault
Device-Specific Settings
Allowveable Mumber Add Device
of Devices/PLCs 16
Add Indirect
Mo, Device Mame Seftings Device
lz‘ 1 IF'LEI‘I @ ISIave Equipment Address=1 Fest of the bits in this wol
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@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] B .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

[Equipment Configuration] tab [Max Query] tab
E;Individual Device Settings & x| ﬁl‘lndividual Device Settings x|
PLCI FLCY
Equipment Configuration | Max Cluery | | Equipment Configuration  Max Guery |
—Equipment Address
Slave Equipment Address I] E Address Function Codes Max Cluery
—Bit manipulation {set/reset) to Holding Register ——————————— Cail (0} Read (01H) 2000 ~ bits
Rest of the bitz in this ward ¢ Clear & Da not clear Goil (1) Wirite (OFH) B0l T bite

Mote on when selecting Do not clear” : ) )
If the ladder proeram writes data to Halding Register during Discrete Input (1) Read (02H) 2000 ~ bits

the read/write process, the resulting data may be incorrect.
Ihput Reeister (31 Read (04H) |]25 E words

Holding Reeister (4) Read (03H) |]25 E words
Holding Reeister (4) ‘Wite {10H) I]DD E words

1 IECE1121 Syntax
fddress Maode |D—based {Default) =

™ SoMachine Basic Syntas

If you change the setting, please reconfirm all address [ Single Bit manipulation to Coil/Discrete nput
settings.

—Wariables
Double Ward word order Lawe word first{L/H) LI

[~ Low Security Level

Detault | Detault |
oK@ | Cancel | oK@ | Cancel |

B Settings of External Device

Use the dedicated tool for basic settings (Resource Configurator) and ladder software (Logic Designer) for

communication settings.

<Communication Settings for the Communication Module>
1 Set IP address of the External Device to "192.168.1.1".

NOTE » For more details on how to set IP address of the External Device, refer to the online help of the
dedicated tool for the FCN/FCJ basic settings.

Start up the dedicated tool for the basic settings.

From the [File] menu, select [Connection] to display the [Connect] dialog box.
Enter "192.168.1.1" in [Host].

Enter [User Name] and [Password] to login.

Select the link I/F to use from the [Controller Configuration] tree view.

Enter the port name in [Port Name].

O~NO O, OWOWDN

Select [Port1] from the link I/F to use the [Controller Configuration] tree view.
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9 set specifications as follows:

Specifications

Setting

Wiring Method

Duplex Operation

Full-duplex

Baud Rate 19200
Data Bits 8
Parity Setting EVEN
Stop Bits 1

Send Signal Check NONE
Receive Flow Control | NONE
API Error Detection YES

10 Download the communication settings to the External Device.

11 Reboot the External Device.

<Control Logic Download Procedures>

N —

example of control logic, refer to "4 Control Logic Example".

& n

Start up the ladder software.

@ Control Logic Example" (page 43)

MODBUS SIO Master Driver

Create the control logic in order to start the MODBUS communication (RTU mode) slave function. For the

3 Double-click ['COM1'] next to [PORT] to display the [Variable Properties] dialog box.

4 Enter the connecting port name in [Name], and click [OK].

5 Double-click [UNIT#1] next to [STATION] to display the [Variable Properties] dialog box.

6 Enter the connecting station name in [Name], and click [OK].
7 Select [Rebuild Project] from the [Build] menu.

8 Double-click [Target Setting] in the project tree window to display the [Target] dialog box.

9 Enter "192.168.1.1" in [Host Name/IP Address].

10 Click [OK].

11 Download the communication settings to the External Device.

12 Reboot the External Device.
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@ Control Logic Example
To connect the Display to the External Device, the control logic is required.
The control logic example is shown below.

SD_CMDBSM_BS_OPEN1
SD_CMDBSM_BS_OPEN

TRUE— REQ VALID —RTU_VALID1
'COM1'— PORT ERROR |—RTU_ERROR1
.— OPTION STATUS —RTU_STATUS1

UNIT#1 — STATION  POSITION —RTU_POSITION1
10.0— TOUT_VAL
FALSE— UNIT_CHARTM

'YOKOGAWA'— VENDOR
'STARDOM'— PRODUCT
'R1.80.01'— REVISION
COIL— COIL COIL COIL
DSCI— DSCI DSCI DSCI
IREG— IREG IREG —IREG
HREG—- HREG HREG +—HREG
ESTS— ESTS ESTS ESTS

RTU_COMERR1— COMERR — COMERR +—RTU_COMERR1
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3.14 Setting Example 14
W Settings of GP-Pro EX

4 Communication Settings

MODBUS SIO Master Driver

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Devica/PLC 1 |
Summary Change Device/PLC
M anufacturer ISchneider Electic 54 Series MODEUS 510 baster Part  |COM1
Text Data Mode I‘I_ Change
Communication Settings
SI0 Type  R5232C & R5422/4552wire] A5 422455 wire]
Speed |192DD 'l
Data Length 7 Lol
Parity  HONE &+ EVEN  0oD
Stop Bit 1 -
Flow Contral & HONE  ER[DTRACTS) L el i
Timeout I 3 3: [zec]
Fietry |2 3:
Wwiatt To Send |3 3: [ms] v Default Value
Rl /WCC Lo LT
I the case of R5232C, pou can select the Sth pin to Bl [Input)
or YL (5% Power Supply). If you uze the Digital's A5232C
|zolation Unit, please select it to WL, Diefault
Device-Specific Settings
Allowveable Mumber Add Device
of Devices/PLCs 16
Add Indirect
Mo, Device Mame Seftings Device
lz‘ 1 IF'LEI‘I @ ISIave Equipment Address=1 Fest of the bits in this wol
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@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] B .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

[Equipment Configuration] tab [Max Query] tab
E;Individual Device Settings & x| ﬁl‘lndividual Device Settings x|
PLCI FLCY
Equipment Configuration | Max Cluery | | Equipment Configuration  Max Guery |
—Equipment Address
Slave Equipment Address I] E Address Function Codes Max Cluery
—Bit manipulation {set/reset) to Holding Register ——————————— Cail (0} Read (01H) 2000 ~ bits
Rest of the bitz in this ward ¢ Clear & Da not clear Goil (1) Wirite (OFH) B0l T bite

Mote on when selecting Do not clear” : ) )
If the ladder proeram writes data to Halding Register during Discrete Input (1) Read (02H) 2000 ~ bits

the read/write process, the resulting data may be incorrect.
Ihput Reeister (31 Read (04H) |]25 E words

Holding Reeister (4) Read (03H) |]25 E words
Holding Reeister (4) ‘Wite {10H) I]DD E words

1 IECE1121 Syntax
fddress Maode |D—based {Default) =

™ SoMachine Basic Syntas

If you change the setting, please reconfirm all address [ Single Bit manipulation to Coil/Discrete nput
settings.

—Wariables
Double Ward word order Lawe word first{L/H) LI

[~ Low Security Level

Detault | Detault |
oK@ | Cancel | oK@ | Cancel |

B Settings of External Device

Use the dedicated tool for basic settings (Resource Configurator) and ladder software (Logic Designer) for

communication settings.

<Communication Settings for the Communication Module>
1 Set IP address of the External Device to "192.168.1.1".

NOTE | ¢ For more details on how to set IP address of the External Device, refer to the online help of the
dedicated tool for the FCN/FCJ basic settings.

Start up the dedicated tool for the basic settings.

From the [File] menu, select [Connection] to display the [Connect] dialog box.
Enter "192.168.1.1" in [Host].

Enter [User Name] and [Password] to login.

Select the link I/F to use from the [Controller Configuration] tree view.

Enter the port name in [Port Name].

O~NO O, OWOWDN

Select [Port1] from the link I/F to use the [Controller Configuration] tree view.
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9 set specifications as follows:

Specifications

Setting

Wiring Method

Duplex Operation

Full-duplex

Baud Rate 19200
Data Bits 8
Parity Setting EVEN
Stop Bits 1

Send Signal Check NONE
Receive Flow Control | NONE
API Error Detection YES

10 Download the communication settings to the External Device.

11 Reboot the External Device.

<Control Logic Download Procedures>

N —

example of control logic, refer to "4 Control Logic Example".

& n

Start up the ladder software.

@ Control Logic Example" (page 47)

MODBUS SIO Master Driver

Create the control logic in order to start the MODBUS communication (RTU mode) slave function. For the

3 Double-click ['COM1'] next to [PORT] to display the [Variable Properties] dialog box.

4 Enter the connecting port name in [Name], and click [OK].

5 Double-click [UNIT#1] next to [STATION] to display the [Variable Properties] dialog box.

6 Enter the connecting station name in [Name], and click [OK].
7 Select [Rebuild Project] from the [Build] menu.

8 Double-click [Target Setting] in the project tree window to display the [Target] dialog box.

9 Enter "192.168.1.1" in [Host Name/IP Address].

10 Click [OK].

11 Download the communication settings to the External Device.

12 Reboot the External Device.
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@ Control Logic Example
To connect the Display to the External Device, the control logic is required.
The control logic example is shown below.

SD_CMDBSM_BS_OPEN1
SD_CMDBSM_BS_OPEN

TRUE— REQ VALID —RTU_VALID1
'COM1'— PORT ERROR |—RTU_ERROR1
.— OPTION STATUS —RTU_STATUS1

UNIT#1 — STATION  POSITION —RTU_POSITION1
10.0— TOUT_VAL
FALSE— UNIT_CHARTM

'YOKOGAWA'— VENDOR
'STARDOM'— PRODUCT
'R1.80.01'— REVISION
COIL— COIL COIL COIL
DSCI— DSCI DSCI DSCI
IREG— IREG IREG —IREG
HREG—- HREG HREG +—HREG
ESTS— ESTS ESTS ESTS

RTU_COMERR1— COMERR — COMERR +—RTU_COMERR1

GP-Pro EX Device/PLC Connection Manual 47



3.15 Setting Example 15
W Settings of GP-Pro EX

4 Communication Settings

MODBUS SIO Master Driver

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Devica/PLC 1 |
Summary Change Device/PLC
M anufacturer ISchneider Electic 54 Series MODEUS 510 baster Part  |COM1
Text Data Mode IT Change
Communication Settings
SI0 Type &+ R5232C RS 422/4552wire] A5 422455 wire]
Speed |192DD 'l
Data Length 7 Lol
Parity  HONE &+ EVEN  0oD
Stop Bit 1 -
Flow Contral  HONE & ER[DTR/CTS) L el i
Timeout I 3 3: [zec]
Fietry |2 3:
Wwiatt To Send |3 3: [ms] v Default Value
Rl /WCC @ Rl  WEC
I the case of R5232C, you can select the Sth pin to Rl [Input)
or WCC (5% Power Supply). If you uze the Digital's RS232C
Isolation Unit, please select it to WCC. Diefault
Device-Specific Settings
Allowveable Mumber Add Device
of Devices/PLCs 16
Add Indirect
Mo. Device Mame Settings Device
lz‘ 1 IF'LEI‘I @ ISIave Equipment Address=1 Fest of the bits in this wol 8

NOTE I * Set [Text Data Mode] to 2.
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@ Device Setting

MODBUS SIO Master Driver

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]

window, select the external device and click [Settings] B .

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

£ Individual Device Settings

PLC1

x|

Equipment Configuration |

—Equipment fddress

Slave Equipment Address I 1 E

—Eit manipulation {zet/reset) to Holding Register
Rest of the bitz in this ward ¢ Clear ' Da not clear

Mote on when selecting Do not clear” :
If the ladder program writes data to Holding Register during
the read/write process, the resulting data may be incorrect.

—Iv IECE1131 Syntax
Address Mode |D—based (Default) a

¥ SoMachine Basic Syntax

If vou change the setting, please reconfirm all address
settings.

—Variables
Double Word word order Lawe word first{L/H) LI

Default |

QK. (0] I Cancel

B Settings of External Device

Use the ladder software "SoMachine Basic" for communication settings.

1 Start up the ladder software.

2 From the [Configuration] tab, select [SL1 (Serial line)].

3 Set [Serial line configuration] as follows.

Setup Items Settings
Protocol Modbus
Baud rate 19200
Parity Even
Data bits 8
Stop bits 1
Physical medium RS-232C
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4 From the [Configuration] tab, select [Modbus].

5 Set [Modbus] as follows.

Setup Items Settings
Device None
Transmission mode RTU
Addressing Slave
Address 1
Response timeout (x100 ms) 10
Time between frames (ms) 10

6 Download the communication settings to the External Device.

& Notes

MODBUS SIO Master Driver

Please refer to the manual of the ladder software for more detail on other setting description.
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3.16 Setting Example 16
W Settings of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Devica/PLC 1 |
Summary Change Device/PLC
M anufacturer ISchneider Electic 54 Series MODEUS 510 baster Part  |COM1
Text Data Mode IT LChange

Communication Settings

510 Type " RS232C % RS5422/485(2wire] = RS422/485(4wire]
Speed lm

Data Length 7 Lol

Parity = NONE * EVEN 00D

Stop Bit 1 -

Flaws Cantral & NONE " ER[DTR/CTS) 1 KN XOFF

Timeout I 3 3: [zec]
Fietry I 2 3:

Wwiatt To Send |3 3: [ms] v Default Value

Rl /% CC LR LT

I the case of R5232C, pou can select the Sth pin to Bl [Input)
or YL (5% Power Supply). If you uze the Digital's A5232C
|zolation Unit, please select it to WL, Diefault

Device-Specific Settings

Allowveable Mumber Add Device
of Devices/PLCs 16

Add Indirect
Mo. Device Mame Settings Device
lz‘ 1 IF'LEI‘I @ ISIave Equipment Address=1 Fest of the bits in this wol

NOTE I * Set [Text Data Mode] to 2.
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@ Device Setting

MODBUS SIO Master Driver

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]

window, select the external device and click [Settings] B .

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

£ Individual Device Settings

PLC1

x|

Equipment Configuration |

—Equipment fddress

Slave Equipment Address I 1 E

—Eit manipulation {zet/reset) to Holding Register
Rest of the bitz in this ward ¢ Clear ' Da not clear

Mote on when selecting Do not clear” :
If the ladder program writes data to Holding Register during
the read/write process, the resulting data may be incorrect.

—Iv IECE1131 Syntax
Address Mode |D—based (Default) a

¥ SoMachine Basic Syntax

If vou change the setting, please reconfirm all address
settings.

—Variables
Double Word word order Lawe word first{L/H) LI

Default |

QK. (0] I Cancel

B Settings of External Device

Use the ladder software "SoMachine Basic" for communication settings.

1 Start up the ladder software.

2 From the [Configuration] tab, select [SL1 (Serial line)].

3 Set [Serial line configuration] as follows.

Setup Items Settings
Protocol Modbus
Baud rate 19200
Parity Even
Data bits 8
Stop bits 1
Physical medium RS-485
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4 From the [Configuration] tab, select [Modbus].

5 Set [Modbus] as follows.

Setup Items Settings
Device None
Transmission mode RTU
Addressing Slave
Address 1
Response timeout (x100 ms) 10
Time between frames (ms) 10

6 Download the communication settings to the External Device.

& Notes

MODBUS SIO Master Driver

Please refer to the manual of the ladder software for more detail on other setting description.
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3.17 Setting Example 17
W Settings of GP-Pro EX

4 Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Devica/PLC 1 |
Summary Change Device/PLC
M anufacturer ISchneider Electic 54 Series MODEUS 510 baster Part  |COM1
Text Data Mode IT LChange

Communication Settings

510 Type " RS232C % RS5422/485(2wire] = RS422/485(4wire]
Speed lm

Data Length 7 Lol

Parity = NONE * EVEN 00D

Stop Bit 1 -

Flaws Cantral & NONE " ER[DTR/CTS) 1 KN XOFF

Timeout I 3 3: [zec]
Fietry I 2 3:

Wwiatt To Send |3 3: [ms] v Default Value

Rl /% CC LR LT

I the case of R5232C, pou can select the Sth pin to Bl [Input)
or YL (5% Power Supply). If you uze the Digital's A5232C
|zolation Unit, please select it to WL, Diefault

Device-Specific Settings

Allowveable Mumber Add Device
of Devices/PLCs 16

Add Indirect
Mo. Device Mame Settings Device
lz‘ 1 IF'LEI‘I @ ISIave Equipment Address=1 Fest of the bits in this wol

NOTE I * Set [Text Data Mode] to 2.
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@ Device Setting

MODBUS SIO Master Driver

To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]

window, select the external device and click [Settings] B .

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

£ Individual Device Settings

PLC1

x|

Equipment Configuration |

—Equipment fddress

Slave Equipment Address I 1 E

—Eit manipulation {zet/reset) to Holding Register
Rest of the bitz in this ward ¢ Clear ' Da not clear

Mote on when selecting Do not clear” :
If the ladder program writes data to Holding Register during
the read/write process, the resulting data may be incorrect.

—Iv IECE1131 Syntax
Address Mode |D—based (Default) a

¥ SoMachine Basic Syntax

If vou change the setting, please reconfirm all address
settings.

—Variables
Double Word word order Lawe word first{L/H) LI

Default |

QK. (0] I Cancel

B Settings of External Device

Use the ladder software "SoMachine Basic" for communication settings.

1 Start up the ladder software.

2 From the [Configuration] tab, select [SL2 (Serial line)].

3 Set [Serial line configuration] as follows.

Setup Items Settings
Protocol Modbus
Baud rate 19200
Parity Even
Data bits 8
Stop bits 1
Physical medium RS-485
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4 From the [Configuration] tab, select [Modbus].

5 Set [Modbus] as follows.

Setup Items Settings
Device None
Transmission mode RTU
Addressing Slave
Address 1
Response timeout (x100 ms) 10
Time between frames (ms) 10

6 Download the communication settings to the External Device.

& Notes

MODBUS SIO Master Driver

Please refer to the manual of the ladder software for more detail on other setting description.
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3.18 Setting Example 18
W Settings of GP-Pro EX

4 Communication Settings

MODBUS SIO Master Driver

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Devica/PLC 1 |
Summary Change Device/PLC
M anufacturer ISchneider Electic 54 Series MODEUS 510 baster Part  |COM1
Text Data Mode IT Change
Communication Settings
SI0 Type &+ R5232C RS 422/4552wire] A5 422455 wire]
Speed |192DD 'l
Data Length 7 Lol
Parity  HONE &+ EVEN  0oD
Stop Bit 1 -
Flow Contral  HONE & ER[DTR/CTS) L el i
Timeout I 3 3: [zec]
Fietry |2 3:
Wwiatt To Send |3 3: [ms] v Default Value
Rl /WCC @ Rl  WEC
I the case of R5232C, you can select the Sth pin to Rl [Input)
or WCC (5% Power Supply). If you uze the Digital's RS232C
Isolation Unit, please select it to WCC. Diefault
Device-Specific Settings
Allowveable Mumber Add Device
of Devices/PLCs 16
Add Indirect
Mo. Device Mame Settings Device
lz‘ 1 IF'LEI‘I @ ISIave Equipment Address=1 Fest of the bits in this wol 8

NOTE I * Set [Text Data Mode] to 2.
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@ Device Setting
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To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]

window, select the external device and click [Settings] B .

To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

£ Individual Device Settings

PLC1

x|

Equipment Configuration |

—Equipment fddress

Slave Equipment Address I 1 E

—Eit manipulation {zet/reset) to Holding Register
Rest of the bitz in this ward ¢ Clear ' Da not clear

Mote on when selecting Do not clear” :
If the ladder program writes data to Holding Register during
the read/write process, the resulting data may be incorrect.

—Iv IECE1131 Syntax
Address Mode |D—based (Default) a

¥ SoMachine Basic Syntax

If vou change the setting, please reconfirm all address
settings.

—Variables
Double Word word order Lawe word first{L/H) LI

Default |

QK. (0] I Cancel

B Settings of External Device

Use the ladder software "SoMachine Basic" for communication settings.

1 Start up the ladder software.

2 From the [Configuration] tab, select [SL2 (Serial line)].

3 Set [Serial line configuration] as follows.

Setup Items Settings
Protocol Modbus
Baud rate 19200
Parity Even
Data bits 8
Stop bits 1
Physical medium RS-232C
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4 From the [Configuration] tab, select [Modbus].

5 Set [Modbus] as follows.

Setup Items Settings
Device None
Transmission mode RTU
Addressing Slave
Address 1
Response timeout (x100 ms) 10
Time between frames (ms) 10

6 Download the communication settings to the External Device.

& Notes

MODBUS SIO Master Driver

Please refer to the manual of the ladder software for more detail on other setting description.
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4 Setup Items

Set communication settings of the Display with GP-Pro EX or in offline mode of the Display.

The setting of each parameter must be identical to that of External Device.

F g Example of Communication Setting" (page 12)

4.1 Setup Items in GP-Pro EX

B Communication Settings

To display the setup screen, from the [Project] menu, point to [System Settings] and select [Device/PLC].

Devica/PLC 1 |
Summary Change Device/PLC
M anufacturer ISchneider Electic 54 Series MODEUS 510 baster Part  |COM1
Text Data Mode I‘I_ LChange

Communication Settings

SI0 Type &+ R5232C RS 422/4552wire] A5 422455 wire]
Speed lm

Data Length 7 Lol

Parity  HONE &+ EVEN  0oD

Stop Bit 1 -

Flow Contral & HONE © ER[DTRACTS] € =ONMOFF

Timeout m [zec]

Fietry m

Wwiatt To Send m[ms] v Default Value

Rl /WCC @ Rl  WEC

I the case of R5232C, you can select the Sth pin to Rl [Input)
or WCC (5% Power Supply). If you uze the Digital's RS232C
Isolation Unit, please select it to WCC. Diefault

Device-Specific Settings

Allowveable Mumber Add Device
of Devices/PLCs 16
Add Indirect
Mo, Device Mame Seftings Device
lz‘ 1 IF'LEI‘I @ ISIave Equipment Address=1 Fest of the bits in this wol
Setup Items Setup Description
SIO Type Select the SIO type to communicate with the External Device.
Speed Select speed between the External Device and the Display.
Data Length Select data length.
Parity Select how to check parity.
Stop Bit Select stop bit length.

Select the communication control method to prevent overflow of transmission and

Flow Control .
reception data.
' Use an integer from 1 to 127 to enter the time (s) for which the Display waits for the
Timeout .
response from the External Device.
Retry In case of no response from the External Device, use an integer from 0 to 255 to enter how

many times the Display retransmits the command.
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Setup ltems Setup Description

Use an integer from 0 to 255 to enter standby time (ms) for the Display from receiving
packets to transmitting next commands.

When the check box of the default value is checked, the Wait To Send value automatically
changes in the formula below by changing each value for Speed/Data Length/Parity/Stop
Bit.

3500 x (1 + Data Length + Stop Bit + Parity)

Wait To Send (ms) = Speed (bps)

Wait To Send Value for the parity setting is shown below.

No Parity =0
Parity Even =1
Parity Odd =1

 After changing the Wait To Send value for the project, of which [Default Value] is
checked, in the offline mode, the Wait To Send value will be recalculated when the
project is received and communication settings are displayed.

You can switch RI/VCC of the 9th pin when you select RS232C for SIO type.
RI/VCC It is necessary to change RI/5V by changeover switch of IPC when connect with IPC.
Please refer to the manual of the IPC for more detail.

NOTE | * Refer to the GP-Pro EX Reference Manual for Indirect Device.

Cf.  GP-Pro EX Reference Manual "Changing the Device/PLC at Runtime (Indirect
Device)"
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@ Device Setting
To display the [Individual Device Settings] dialog box, from [Device-Specific Settings] in the [Device/PLC]
window, select the external device and click [Settings] B .
To connect multiple External Devices, from [Device-Specific Settings] in the [Device/PLC] window, click [Add

Device] to add another External Device.

[Equipment Configuration] tab

5 Individual Device Settines [ x| # Individual Device Settines x|
PLCI FLCY
Equipment Configuration | Max Query | Equipment Configuration |
—Equipment Address —Equipment Address
Slave Equipment Address I] E Slave Equipment Address Il E
—Bit manipulation (set/teset) to Holding Register ————————— —Bit manipulation (zet/tezet) to Holding Register
Rest of the bits in this word ¢ Glear * Do not clear Rest of the bitz in thiz word ¢ Glear ' Do not clear
Mote on when selecting Do not clear” : Mate on when selecting “ Do not clear” @ _ _
If the ladder program writes data to Holding Reeister durine If the ladder program writes data to Holding Register during
the read/write process, the resulting data may be incorrect. the readwrite process, the resulting data may be incorrect.
1 IECH1131 Syntax —w IEGE1131 Syntax
Addrezs Mode Iﬂ—based [ Diefault! LI Address Mode |D—based (Default) LI
™ SoMachine Basic Syntas ¥ SoMachine Bazic Syntax
If you change the setting, please reconfirm all address If you chanee the setting, please reconfirm all address
settings. zettings.
—Wariables —Wariables
Double Ward word order Lawe word first{L/H) LI Double Ward word order Lawe word first{L/H) LI
[~ Low Security Level
Default | Default |
okm) | Caneel | ok | Cancel |

Setup Items Setup Description

Use an integer from 1 to 247 to enter the slave equipment address of the

Slave Equipment Address External Device.

Bit manipulation (set / reset) to

Holding Resister From "Clear" or "Do not clear", select treatment of the rest of the bits in the
Rest of the bits in | same word when the bit manipulation to Holding Register is performed.

this word

Check this item when you use the IEC61131 syntax for variables. In case that

IEC61131 Syntax you check on, select Address Mode, [0-based] or [1-based].

Check this item when you use SoMachine Basic syntax for variables.

SoMachine Basic Syntax Use this setting with M221 series only.

Select the order of storing double word data from "Low word first" or "High

Double Word word order "
word first".

Low Security Level Put a check when lowering the format check level.
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[Max Query] tab
x

PLC1

MODBUS SIO Master Driver

| Equipment Configuration  Max Cuery |

Address Function Codes Max Cluery

Goil {0} Read (01H) 2000 —| bits
Goil {0} Wirite (OFH) ] —| bits
Discrete Input (13 Read (02H) 2000 | bits
Ihput Reeister (31 Read (04H) Iﬂ words
Holding Reeister (4) Read (03H) Iﬂ words
Holding Reeister (4) ‘Wite {10H) Im words

[~ Sinele Bit manipulation to Goil/Discrete Ihput

Detault |
oK@ | Cancel |

Setup Items

Setup Description

Coil

Set the number of max data for device [coil] which can be read for one

Read

communication, using 16 to 2000 bits.

* When [Single Bit manipulation to Coil/Discrete Input] is checked, set the
data maximum number from 1 to 2000.

Coil

Set the number of max data for device [coil] which can be written for one

Write

communication, using 1 to 800 bits.

Discrete Input

one communication, using 16 to 2000 bits.

Read
» When [Single Bit manipulation to Coil/Discrete Input] is checked, set the
data maximum number from 1 to 2000.
Input Register Set the number of max data for device [input register] which can be read for
| Read one communication, using 1 to 125 words.
Holding Register Set the number of max data for device [holding register] which can be read
| Read for one communication, using 1 to 125 words.
Holding Register Set the number of max data for device [holding register] which can be written
| Write for one communication, using 1 to 100 words.

Single Bit manipulation to Coil/

Discrete Input

Put a check when writing in or reading out coil or discreet input in bits.
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MODBUS SIO Master Driver

4.2 Setup Items in Offline Mode

NOTE | * Refer to the Maintenance/Troubleshooting guide for information on how to enter offline mode or

about the operation.

Cf.  Maintenance/Troubleshooting Guide "Offline Mode"

* The number of the setup items to be displayed for 1 page in the offline mode depends on the

Display in use. Please refer to the Reference manual for details.

€ Communication Settings

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings] in offline mode. Touch the

External Device you want to set from the displayed list.

| Cormm, Device Option

MODBUS S10 Master [GoM1] Page 1/1

510 Type k52320 >

Speed 19200 =

Data Length T e §

Parity NONE o EVEN 0DD

Stop Bit | 2

Flow Control | NONE =]

Timeout(s) 7w a

Retry 7w | a

Wait To Sendims) 7w a

. 2018/83/15
Exit Back 16:19:24

Setup Iltems Setup Description
Select the SIO type to communicate with the External Device.
IMPORTANT
To make the communication settings correctly, confirm the serial interface specifications of
SIO Type Display unit for [SIO Type].
We cannot guarantee the operation if a communication type that the serial interface does
not support is specified.
For details concerning the serial interface specifications, refer to the manual for Display
unit.
Speed Select speed between the External Device and the Display.
Data Length Select data length.
Parity Select how to check parity.
Stop Bit Select stop bit length.
Select the communication control method to prevent overflow of transmission and
Flow Control

reception data.
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Setup ltems Setup Description
) Use an integer from 1 to 127 to enter the time (s) for which the Display waits for the
Timeout .
response from the External Device.
Retr In case of no response from the External Device, use an integer from 0 to 255 to enter how
y many times the Display retransmits the command.
Wait To Send Use an integer from 0 to 255 to enter standby time (ms) for the Display from receiving

packets to transmitting next commands.

@ Device Setting

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings]. Touch the External Device

you want to set from the displayed list, and touch [Device].

(Page 1/2).
Cormm, Device Option
MODBUS SI0 Master [GoM1] Page 1/2
Device/PLC Name [PLCI =]
Slave Address [ T »|a|
Bit manipulation to HR Rest of bits in word are not cleared
[ECE1151 Syntax OFF
SoMachine Syntaw OFF
Double Word word order Low word first
Low Security Level OFF
-
; 2018/03/15
Exit Back | 16:19:31 |
Setup Items Setup Description

Device/PLC Name

Select the External Device for device setting. Device name is a title of External Device set
with GP-Pro EX. (Initial value [PLC1])

Slave Address

Use an integer from 1 to 247 to enter the slave equipment address of the External Device.

Bit manipulation to HR

From "Rest of bits in word are cleared" or "Rest of bits in word are not cleared", select
treatment of the rest of the bits in the same word when the bit manipulation to Holding
Register is performed. (Not available to set in offline mode.)

IEC61131 Syntax

Displays the usage status of the currently set IEC61131 syntax in ON/OFF. (Not available
to set in offline mode.)

SoMachine Syntax

Displays the usage status of the currently set SoMachine Basic syntax in ON/OFF. (Not
available to set in offline mode.)

Double Word word
order

Displays the currently set order of storing double word data from "Low word first" or
"High word first". (Not available to set in offline mode.)

Low Security Level

When an format check level is lowered, ON/OFF is displayed. When the level is lowered,
ON is displayed. (Not available to set in offline mode.)
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(Page 2/2).
Cormm, Device Option
MODBUS SI0 Master [GoM1] Page 2/2
Device/PLC Name [PLCI =]
Max Query
Read Goil 2000 bits
Write Coil 300 bits
Read Discrete Input 2000 bits
Read Input Register 120 | &
Read Holding Register 195 w| &
Write Holding Register AR w | &
Single Bit manipulation OFF
R
: Z018/03/ 15
Setup Items Setup Description
. Displays the number of max data for device [coil] which can be read for one
Read Caill . . . .
communication. (Not available to set in offline mode.)
Write Coil Displays the number of max data for device [coil] which can be written for one

communication. (Not available to set in offline mode.)

Read Discrete Input

Displays the number of max data for device [discrete input] which can be read for one
communication. (Not available to set in oftline mode.)

Read Input Register

Set the number of max data for device [input register] which can be read for one
communication, using 1 to 125 words.

Read Holding Register

Set the number of max data for device [holding register] which can be read for one
communication, using 1 to 125 words.

Write Holding Register

Set the number of max data for device [holding register] which can be written for one
communication, using 1 to 100 words.

Single Bit manipulation

ON/OFF display shows whether the coil or discreet input is written or read out in bits. If
ON is displayed, writing or reading can be executed in bits. (Not available to set in offline
mode.)
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@ Option

To display the setting screen, touch [Device/PLC Settings] from [Peripheral Settings]. Touch the External Device
you want to set from the displayed list, and touch [Option].

Comm, Device Option
MODBUS SI0 Master [GOM1] Page 1/1
RI / WCC e RI YOO
In the case of RS232C, wou can select
the 9th pin to RI{Input} or WCG{HY
Power Supply). If you use the Digital's
k52320 Isolation Unit, please select
it to VGC,
: 2018/M3/15
Exit Back 16:19:44
Setup Iltems Setup Description
You can switch RI/VCC of the 9th pin when you select RS232C for SIO type.
RI/VCC It is necessary to change RI/5V by changeover switch of IPC when connect with IPC.
Please refer to the manual of the IPC for more detail.
NOTE * GP-4100 series, GP-4*01TM, GP-Rear Module, LT-4*01TM and LT-Rear Module do not

have the [Option] setting in the offline mode.
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5 Cable Diagram
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The following cable diagrams may be different from cable diagrams recommended by External Device

Manufacturer.

Please be assured there is no operational problem in applying the cable diagram shown in this manual.

* The FG pin of the External Device body must be grounded according to your country’s applicable standard.

Refer to your External Device manual for details.

* SG and FG are connected inside the Display. When connecting the External Device to SG, design your system

to avoid short-circuit loops.

* Connect an isolation unit if the communication is not stable due to noise or other factors.

51 Cable Diagram 1
Displa
p. v Cable Notes
(Connection Port)
. COM Port Conversion Adapter by Pro-face
GP3000 ° (COM1) CA3-ADPCOM-01
AGP-3302B (COM2) +
GP-4*01TM (COM1) 1A Terminal Block Conversion Adapter by Pro-face The cable length
GP-Rear Module CA3-ADPTRM-01 must be 200m or
(COM1) + less.
*2
ST~ (COM2) User-created cable
LT3000 (COM1)
1B User-created cable
Online Adapter by Pro-face
CA4-ADPONL-01
+
1C Terminal Block Conversion Adapter by Pro-face
CA3-ADPTRM-01 The cable |
*3 e cable length
GP3000 ~ (COM2) + must be 200m or
User-created cable less.
Online Adapter by Pro-face
D CA4-ADPONL-01
+
User-created cable
COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01
+
PC*4 1E Terminal Block Conversion Adapter by Pro-face The cable length
CA3-ADPTRM-01 must be 200m or
+ less.
User-created cable
IF User-created cable
GP-4106 (COM1) The cable length
GP-4116T (COM1) 1G User-created cable must be 200m or
less.
Gr-4107 CoM The bl engt
1H User-created cable must be 200m or

GP-4203T (COM1)

less.
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Displa
p. y Cable Notes
(Connection Port)
RS-422 Terminal Block Conversion Adapter by Pro-face
GP4000°® (COM2 PFXZCBADTMI
GP-4201T ((COMI)) 11 7 The cable length
SP5000 (COM1/2) + must be 200m or
User-created cable less.
1B User-created cable
4%
Ilﬁ-‘l‘{e(:lilT\/ll\g éliSMl) RJ45 RS-485 Cable (5m) by Pro-face The cable length
(COMI) H PFXZLMCBRIRS! must be 200m or
less.
- *8 The cable length
555%%%28}3 1K User-created cable must be 200m or
less.

*1 All GP3000 models except AGP-3302B
*2 All ST models except AST-3211A and AST-3302B
*3  All GP3000 models except GP-3200 series and AGP-3302B

*4  Only the COM port which can communicate by RS-422/485 (2 wire) can be used. (Except PE-4000B, PS5000)
m |[PC COM Port (page 8)

*5  Except GP-4203T
*6  All GP4000 models except GP-4100 series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T

*7  When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 1A.
*8  Only the COM port which can communicate by RS-422/485 (2 wire) can be used.
H |PC COM Port (page 8)
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1A)

¢ 1:1 Connection
External Device side

Display side Shield Terminal block
Signal name Signal name
Display ~ CA3-ADPCOM-01 RDA A
RDB B
[ =
= SDA SG
CA3-ADPTRM-01 SDB
TRMRX
SG
FG
User-created cable
* 1:n Connection
. External Device side External Device side
Terminal block Shield Terminal block Shield Terminal block
Signal name /I ’/ \\ Signal name I:" s \‘ Signal name
.V DON
RDA f AV v A i //}\ A
Display ~ CA3-ADPCOM-01 RDB - T B :. i B
] H \ \ )
! | RS W
- SDB :: I'; I:
CA3-ADPTRM-01 | TRMRX \ i -
SG : i
FG
User-created cable
NOTE I * The cable length must be 200m or less.
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¢ 1:1 Connection

Display side

MODBUS SIO Master Driver

External Device side

D-sub 9 pin (socket) §t"_e_'9 Terminal block
Pin Signal name ',/ ';7“.‘ Signal name
1 RDA AV A
=| PO
_ 7 2 RDB sndiA B
ey Termination 3 SDA j; :'I l: SG
w7 e Hi A4
S SG =
4 ERA
8 CSA :I
9 ERB :I
6 CSB
Shell FG T “_\,,"
¢ 1:n Connection
oumBoh el sy TamnAben T gyge | Temben
Pin | Signal name fA Signal name VAN Signal rame
1 RDA AV A / /\, \ A
=| 2 RDB |+ / \ 5 / \ ‘ S
Display Termirﬁon 3 SDA —J:-" :-'I ": sSG ".\ “.\ /." SG
o I I S N I
5 SG 1 : i =
4 ERA
8 Son I
9 ERB
6 CSB ]
Shell FG _'5 ‘\J"

NOTE I

+ The cable length must be 200m or less.
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1C)

¢ 1:1 Connection
External Device side

Terminal block Shield Terminal block
Signal name ',’l TAY Signal name
VAR
) CA4-ADPONL-01 RDA T \ A
Display : '.'
RDB + i B
l = ! !
1 = SDA ; : SG
1
' ]
CA3-ADPTRM-01 SDB i :
' ]
TRMRX : H
' ]
SG : ;
1
FG !
User-created cable
¢ 1:n Connection
) ) External Device side External Device side
Terminal block _S_[n_e_lgl’ Terminal block Shield Terminal block
1 Y ’ Y
Signal name '/ '," \‘ Signal name ,/ /! \‘ Signal name
| [ | ;oA
Display ~ CA4-ADPONL-O1 RDA T X ' A //\:'\ : A
RDB [+ : B ‘. B
1 \ 1 1
SDA ; SG ] SG
] \ \ /
CA3-ADPTRM-01 SDB ] I""
TRMRX i ! =
) 1}
SG j
[}
FG /
h User-created cable i
NOTE I * The cable length must be 200m or less.
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1D)

e 1:1 Connection

Display

* 1:n Connection

CA4-ADPONL-01

Display [I{p

Shield Terminal block
Pin | Signal name '/', ',I'A\“ Signal name
CA4-ADPONL-01 2 RDA ',"' / I'.' A
7 RDB i ; B
3 SDA ,-: l': SG
8 SDB o
9 TRMRX
s T | ]
1 | TRMRX
Shell FG | — & I‘\"/
) User-created cable -
External Device side External Device side
D-sub 9 pin (plug) Shield Terminal block Shield Terminal block
Pin Signal name ‘," ,/7‘\‘ Signal name ’,’/ /’7\“\‘ Signal name
2 RDA LAY A CA A
7 RDB / \\ B : / \ j B
3 SDA SG o SG
8 SDB _L ’
1 | TRMRX AN =
5 SG o
9 | TRMRX
Shell G —= ./

D-sub 9 pin (plug)

MODBUS SIO Master Driver

External Device side

\ 4

A

User-created cable

NOTE I

+ The cable length must be 200m or less.
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1E)

¢ 1:1 Connection
External Device side

Display side Shield Terminal block
Signal name ,’l ,r' ‘\ Signal name
! A
RDA T — A
Display CA3-ADPCOM-01 :. / \ \
RDB * I B
// = SDA | L — SG
' ! H
CA3-ADPTRM-01 SDB E d I!
' ]
TRMRX Vo
\ 1 h
SG =N
\ v
FG % ‘\‘,’l
N User-created cable g
¢ l:n Connection
. External Device side External Device side
Terminal block Shield Terminal block Shield Terminal block
Signal name / i \\‘ Signal name '/' 7N Signal name
AVNE . e
RDA ! ‘ ‘-'I A i / :-\ A
Display ~ CA3-ADPCOM-01 RDB t : —— B = B
1 ' \ \ H
'E SDA Pt SG —— SG
_ SDB : : .E l‘“':’
CA3-ADPTRM-01 | TRMRX ". : ,- =
] '. !
s /4
\
FG [\
User-created cable
NOTE I + The cable length must be 200m or less.
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1F)
* 1:1 Connection
Display side External Device side
D-sub 9 pin (socket) Shield Terminal block
ST
Pin | Signal name \ Signal name
\
Display % 1 DATA+ : A
1
7 2 | DATA- B
1
Termination 3 NC SG
resistance 7
100Q 1/2W NC
5 GND(SG)
4 ERA
8 CSA
9 ERB
6 CSB
Shell FG
¢ 1:n Connection
Display side External Device side External Device side
D-sub 9 pin (socket) Shield Terminal block Shield Terminal block
Pin Signal name ,:’, /-.‘\ Signal name / / Y Signal name
Display % 1 DATA+ HEAVAR! A ' /\' } A
e o M N
3 P L
Termination NC ! VAR SG \ NS SG
resistance 7 NC H i —
100Q 1/2W : o L
5 GND(SG) . b -
4 ERA I
8 | csa 4_—|
9 ERB oo
6 CcsB :I Voo
Shell FG —‘Q‘ "\/"
NOTE I * The cable length must be 200m or less.
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1G)
¢ 1:1 Connection

Display side External Device side

Terminal block Shield Terminal block
Signal name ',' ,’l “. Signal name
N ER
=— 1/ —
] ) H
RDB = B
Display / ! ol
Termination SDA :' :' ' SG
resistance*1 | '
SDB ; I; E
5G =
1 \ !
ERA :l ! E :l
CSA b
\ Vo
ERB :l R
1 [
CSB [
IRY
* 1:n Connection
Display side External Device side External Device side
Terminal block Shield Terminal block Shield Terminal block
Signal name ':'I ‘,’"\ Signal name I’I /, “.‘ Signal name
=l o AT e A
) RDB el B L B
Display ! o \ i
Termination SDA ﬂ i ! ' SG \ N/ SG
resistance*1 SDB E t ! T
SG ] -
ERA ] N
CSA b
ERB ] Voot
CcsB VoL

i

*1 The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the
rear of the Display as shown in the table below.
DIP Switch No. Set Value
1 OFF
2 OFF
3 ON
4 ON

NOTE I

+ The cable length must be 200m or less.
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1H)
¢ 1:1 Connection
Display side External Device side
D-Sub 9pin (plug) I_S_h_ifl_d_ . Terminal block
Pin Signal name ’," :'/ “.‘ Signal name
Display % 3 LINE(+) '." : l'l‘ A
/ 8 LINE(-) B
Termination 1 NC :: é SG
mel e T | A4
= !
5 GND(SG) E |
4 RS(RTS) i
6 5V
7 NC
9 NC
Shell FG —* /
¢ l:n Connection
DSBmn Ly ses  lemaater " g emaabge
Pin Signal name ! ,"\‘ Signal name / ',’l N Signal name
Display 3 LINE(+) ’,"' ; I“.I A 1 /\"l ; A
/% 8 LINE(-) ; B . / \ B
Termination 1 NC :': |: SG “‘\ ___“_\_v,"’ SG
mee 2 [ w |4 A I
5 GND(SG) : | =
4 | RrsRrS) | |
6 5V ' i
7 NC i
9 NC |“.‘ ,':
sl | Fo —% 4/

IVlel=ar\\ill «+ The 5V output (Pin #6) on the Display is the power for the Siemens AG’s PROFIBUS
connector. Do not use it for other devices.

NOTE * In COM on the GP-4107, the SG and FG terminals are isolated.
* The cable length must be 200m or less.
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11)

e 1:1 Connection
External Device side

Display side Shield Terminal block
Signal name ," ,/ \\ Signal name
LA
. RDA T — A
Display ; / \ ',|
RDB + A B
| = P
/ SDA E ! : SG
' ! H
PFXZCBADTM1 SDB oA
1 H H
TRMRX A
\ \ H
\ \ h
°° Voo
\
FG —__\/
User-created cable
* 1:n Connection
. External Device side External Device side
Terminal block Shield Terminal block Shield Terminal block
Signal name '/ :’l ‘\ Signal name // 7 ‘\‘ Signal name
/ \ ! [
RDA f x A L /\‘\ : A
] \ H |
Display RDB ! : |- B :, I'- B
H i \ v
= SDA é ] SG Y ___:‘1,/' SG
SDB ' ;
PFXZCBADTM1 | TRMRX : , =
G "
[}
FG f
User-created cable
NOTE I * The cable length must be 200m or less.
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1J)
¢ 1:1 Connection

External Device side
Terminal block

Disol Signal name
isplay D1
A
DO
B
GND
PFXZLMCBRJRS1 SG
¢ 1:n Connection
E;E{Qﬁﬂg” External Device side External Device side
100Q 1/2W Terminal block Shield Terminal block
Signal name /’"“,?\\ Signal name
. D1 ' FARY 9
Display g A ! //?‘\ \ A
H ! 1
DO ! i !
GND SG “‘ v ’,' SG
PFXZLMCBRJR81 A
NOTE I * The cable length must be 200m or less.
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1K)
¢ 1:1 Connection
Display side External Device side
D-sub 9 pin (socket) Shield Terminal block
ST
Pin | Signal name ! ! \ Signal name
. AL
Display % 2 DATA+ '.' / \ ¢ A
I ! \
1 DATA- o B
/S P
Termination NC ,: : SG
resistance 7 H
100Q 1/2W NC i
5 GND :
]
4 NC i
[}
8 | NC ;
]
9 NC '
)
1
6 NC i
\
Shell FG
¢ 1:n Connection
Display side External Device side External Device side
D-sub 9 pin (socket) Shield Terminal block Shield Terminal block
Pin | Signal name ! A} Signal name / ,/\‘\ Signal name
NA DA
Display % 2 DATA+ '.‘ / \{'\ I|| A / ;\ A
5 1 | DATA- i B P\ B
3 oo [
Termination NC :I .; \ SG \ N/ SG
resistance 7 NC ' \ S
1000 1/2W AN L
N ] ]
v |
8 NC b
1 1 ]
9 NC Voo
6 NC Voo
shell | FG  |—a i
[ P, ¥

NOTE I

+ The cable length must be 200m or less.
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5.2 Cable Diagram 2

MODBUS SIO Master Driver

Display

Cabl
(Connection Port) avie

Notes

GP3000 (COM1)
GP4000"! (COM1)

SP5000 (COM1/72) Cable by Schneider Electric Industries

ST (COM1) 2A 3
LT3000 (COM1) TSX PCX 1031 (2.5m)

IPC™?

PC/AT

GP-4105 (COM1) User-created cable
GP-4115T (COM1) B +

GP-4115T3 (COM1) Cable by Schneider Electric Industries

TSX PCX 1031 (2.5m)"?

*1  All GP4000 models except GP-4100 series and GP-4203T

*2  Only the COM port which can communicate by RS-232C can be used.
m |PC COM Port (page 8)

*3  Set the rotary switch to "3 (OTHER DIRECT)".

2A)
External Device
Display
TSXPCX 1031 /O
] =X o / EI
TER port
Mini DIN 8 pin
2B)
Display side External Device side
Terminal block Shield D-sub 9 pin (plug)
ii,—fr?f;l : o Pin iiﬁ?:]ael External Device
Display : P —
RD(RXD) 2 RD(RXD)
SD(TXD) 3 |SD(TXD) TSX PCX 1031 o)
ER(DTR) 4 ER(DTR) |. [S] O /o
SG 5 SG “TER port I:l
RS(RTS) 7 RS(RTS) Mini DIN 8 pin
CS(CTS) 8 CS(CTS)

j;'_

User-created cable

F
v
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5.3 Cable Diagram 3

MODBUS SIO Master Driver

Display
(Connection Port)

Cable

Notes

GP3000"! (COM1)
AGP-3302B (COM2)
GP-4*01TM (COM1)
GP-Rear Module
(COM1)

ST*? (COM2)
LT3000 (COM1)

3A

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01
+
Terminal Block Conversion Adapter by Pro-face
CA3-ADPTRM-01
+
User-created cable
+
Accessory box by Schneider Electric Industries
TSX SCA 50

3B

User-created cable
+
Accessory box by Schneider Electric Industries
TSX SCA 50

The cable length must
be 10m or less.™

GP3000"* (COM2)

3C

Online Adapter by Pro-face
CA4-ADPONL-01
+
Terminal Block Conversion Adapter by Pro-face
CA3-ADPTRM-01
+
User-created cable
+
Accessory box by Schneider Electric Industries
TSX SCA 50

3D

Online Adapter by Pro-face
CA4-ADPONL-01
+
User-created cable
+
Accessory box by Schneider Electric Industries
TSX SCA 50

The cable length must
be 10m or less.*>

PC*?

3E

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01
+
Terminal Block Conversion Adapter by Pro-face
CA3-ADPTRM-01
+
User-created cable
+
Accessory box by Schneider Electric Industries
TSX SCA 50

3F

User-created cable
+
Accessory box by Schneider Electric Industries
TSX SCA 50

The cable length must
be 10m or less.*>
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Display
(Connection Port)

Cable

Notes

GP-4106 (COMI)
GP-4116T (COM1)

3G

User-created cable
+
Accessory box by Schneider Electric Industries
TSX SCA 50

The cable length must
be 10m or less.*>

GP-4107 (COM1)
GP-4*03T"® (COM2)
GP-4203T (COM1)

3H

User-created cable
+
Accessory box by Schneider Electric Industries
TSX SCA 50

The cable length must
be 10m or less.*>

GP4000"7 (COM2)
GP-4201T (COM1)
SP5000 (COM1/2)

31

RS-422 Terminal Block Conversion Adapter by Pro-face

PFXZC%ADTMI
+
User-created cable
+
Accessory box by Schneider Electric Industries
TSX SCA 50

3B

User-created cable
+
Accessory box by Schneider Electric Industries
TSX SCA 50

The cable length must
be 10m or less.*>

LT-4*01TM (COM1)
LT-Rear Module
(CoM1)

3]

RJ45 RS-485 Cable (5m) by Pro-face
PFXZLMCBRIJRS81
+
Accessory box by Schneider Electric Industries
TSX SCA 50

The cable length must
be 5m or less.*>

PE-4000B™
PS5000™

3K

User-created cable
+
Accessory box by Schneider Electric Industries
TSX SCA 50

The cable length must
be 10m or less.*>

*1 All GP3000 models except AGP-3302B
*2  All ST models except AST-3211A and AST-3302B

*3  Max length between the Display and the "Accessory Box connected to Display". Total cable length between
accessory boxes must be 1000m or less (for LT-4*01TM and LT-Rear Module, 195m or less).

*4  All GP3000 models except GP-3200 series and AGP-3302B

*5  Only the COM port which can communicate by RS-422/485 (2 wire) can be used. (Except PE-4000B, PS5000)
m |[PC COM Port (page 8)

*6  Except GP-4203T

*7  All GP4000 models except GP-4100 series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T

*8  When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 3A.
*9  Only the COM port which can communicate by RS-422/485 (2 wire) can be used.
H |PC COM Port (page 8)
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3A)
¢ 1:1 Connection
Terminal block Shield External Device side
ro==== 2,
Signal name ,'I ,’l \‘\‘ Signal name
! /\,’ \
[ U \
Display CA3-ADPCOM-01 RDA ; / ;\ ' Blue | D(B)
)
[E/]] — RDB r— | \———{whie| D(A)
! )
= SDA | i Red | SG
] : !
CA3-ADPTRM-01 SDB b :’ White|  SG
)
TRMRX 1t /i |
\ \ '
SG o
\ [}
FG _.\\\_____“\Jl/

User-created cable

¢ 1:n Connection

Terminal block Shield External Device side Shield External Device side
Signal name '," ';"‘\“ Signal name //"_““;/?\\ Signal name
RDA :" A—Tsue| ) F—+—~A—— sue] DE)
Display CA>ADPCOM-01 RDB [+ / \ —Jwnie| DA) / \ T white| D(A)
[lf[] SDA [ il :: ; Red | SG "\ "‘ ’," Red | SG
SDB ; } :- white| SG i ‘\v," white| SG
CA3-ADPTRM-01 TRMRX '- :‘ ’ I """
s /i -
6 —* A/
< User-created cable >
NQTEI » The cable length must be 10m or less.”!

*1  Max length between the Display and the "Accessory Box connected to Display". Total cable length
between accessory boxes must be 1000m or less.
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3B)
* 1:1 Connection
Display side
D-sub 9 pin (socket) Shield External Device side
re=—-= b2
Pin Signal name ! ;'\‘. Signal name
A
% 1 RDA ] //\" L {Bue| D@B)
E 2 RDB -/ N—fwnite| D(A)
oo
Display Termination 3 SDA j :' ,: II Red SG
resistance 7 SDB ! ! \ Whit
100Q 1/2W ; P e] SG
5 SG 0 ' H
' o
4 ERA Pl
[l | H
8 CSA 4_—| '-, '-I !
\ \ !
9 ERB :I b
1 1 1
6 CSB Voo
Shell FG —* Vi
...... 4
b User-created cable "
¢ 1:n Connection
DispIay side
D-sub 9 pin (socket) Shield External Device side Shield External Device side
[T n 4 N,
Pin Signal name ! A Signal name / PN Signal name
=] 1 RDA A Tewe] pE) [ //\\ i eue] DE)
E 2 RDB white| D(A) [— i \——{white| D(A)
Display Termination 3 SDA Red SG "‘ I“ :" Red SG
resistance . \ v }
1000 1/2W 7 SDB White] SG - v White] SG
5 sG l """
4 ERA =
8 CSA
9 ERB
6 CSB
Shell FG
) User-created cable "
NOTE I * The cable length must be 10m or less."!

*1  Max length between the Display and the "Accessory Box connected to Display". Total cable length
between accessory boxes must be 1000m or less.
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3C)
* 1:1 Connection
Terminal block Shield External Device side
ym==== )
Signal name / T Signal name
NE
, CA4-ADPONL-01 RDA 4 — Blue [ D(B)
Display ! / ¥\ \
RDB i i ———White| D(A)
= P
//':' SDA | L Red | SG
| /oo .
CA3-ADPTRM-01 SDB : i | White] SG
! ]
TRMRX \ !
' ]
SG " !
1
]
FG /
) User-created cable "
* 1 Connection
Terminal block Shield External Device side Shield External Device side
Signal name /, ','/ ‘\‘ Signal name // /'7\\ Signal name
Display  CAADPONL-O! RDA f ; +—{ Biue | D(B) [—F / :\ +—{Blue | D(B)
[ﬁ] RDB ,-' i white| D(A) § i \——fwhite| D(A)
SDA .’ Red | SG |—t i—+—{Red | sG
CA3-ADPTRM-01 SDB : White| ~ SG i —|white| G
v S —_— el 293
TRMRX [— _T_
SG ' -
FG
< User-created cable >
NOTE I * The cable length must be 10m or less.™!

*1  Max length between the Display and the "Accessory Box connected to Display". Total cable length
between accessory boxes must be 1000m or less.
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3D)
* 1:1 Connection
D-sub 9 pin (plug) Shield External Device side
Pin Signal name i ',I'A\‘ Signal name
DiSplayCA4-ADF>0N|_-01 2 RDA :," /A\i I',l Blue | D(B)
7 RDB p i ———White| D(A)
[lﬁ] 3 SDA Red| SG
8 SDB { Hwnie|  sG
1 TRMRX
5 SG
o | TRWRX| i
Shell FG — ‘\v,:‘
< User-created cable >
¢ l:n Connection
D-sub 9 pin (plug) Shield External Device side Shield External Device side
Pin Signal name ,:', ,"'\\‘ Signal name ,// :’/ \‘\‘ Signal name
pispy O 2 RDA //\\ L Teue] pE) - //\‘\ t—{eue| DB)
7 RDB ' M—wnie| D) | { \——{white| D(A)
[ﬁ] 3 SDA it TRed| so ——F—Red | SG
8 SDB i : § White]  SG “.\ “\ ," White|  SG
1 TRMRX _[ /
s | so /1] -
o | TRMRx | % i i
Shell FG —‘\ \‘\, ,:"
< User-created cable >
lﬁ' * The cable length must be 10m or less.”!

*1  Max length between the Display and the "Accessory Box connected to Display". Total cable length
between accessory boxes must be 1000m or less.
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3E)

¢ 1:1 Connection

Terminal block Shield External Device side
ro———- 7,
Signal name / / \‘\‘ Signal name
/ /\,’ \
RDA ! — Blue | D(B)
Display CA3-ADPCOM-01 :' / :\ ':
RDB *- ! 1 White| D(A)
[ = ! o
= SDA 5 o Red | SG
] : [} K
CA3-ADPTRM-01 SDB b 1 {white| SG
\ H 1
TRMRX v/
AN
SG o
\ ]
FG —=2____\/
D User-created cable "
¢ 1:n Connection
Terminal block Shield External Device side Shield External Device side
Signal name ','I /' ‘\ Signal name ,/' / \ Signal name
— ', /\’: -, Blue | D(B) //\.",\ '| Blue | D(B)
Display CADPCOM-01 RDB : ,‘\—";—wmte D(A) [— i \——wnite| D(A)
q’j |E SDA ’ b Red | SG . L ," Red | SG
SDB i Vo1 Dwnite| sG i S——{White|  SG
CA3-ADPTRM-01 TRMRX -,. :‘. ".' _'L
se /1] ]
6 %\

v

A

User-created cable

NOTE I

+ The cable length must be 10m or less.”!

*1

between accessory boxes must be 1000m or less.

Max length between the Display and the "Accessory Box connected to Display". Total cable length
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3F)
¢ 1:1 Connection
Display side
D-sub 9 pin (socket) Shield External Device side
’ A
Pin Signal name i A Signal name
! i\
Display =] 1 | DaTA+ j /\\ — sue | DB)
)
/ 2 DATA- ! ‘-' 'I White] D(A)
)
! P
Termination 3 NC ,: :' ] Red SG
resistance 7 NC ! q H Whit
100Q 1/2W f i i "] SG
5 GND(SG) : b
H ] 1
4 ERA A
H | ]
) ]
8 CSA j bl
\ \ i
9 ERB Voo
\ Vo
6 csB J ooy
\ v
Shell FG —4  \/
| P ¥
User-created cable
¢ 1:n Connection
Display side
D-sub 9 pin (socket) Shield External Device side Shield External Device side
Pin Signal name ,:" ,:'“‘.‘ Signal name ,’/ ! \\‘ Signal name
Display % 1 DATA+ "v' A! “‘ Blue | D(B) '." //\"’\ “. Blue | D(B)
/ 2 DATA- .' H White| D(A) : i \———white| D(A)
ot 3 NC i ; Red | SG L L' fRed| sG
ermination ! ! \ \ i
w7 T no | A | M se | fme] s
5| GND(SG) — i )
4 ERA : ' =
8 CsA
9 ERB ; ,:
6 csB
Shell FG ¢ ,"'
) User-created cable -
NOTE I « The cable length must be 10m or less.”!

*1  Max length between the Display and the "Accessory Box connected to Display". Total cable length
between accessory boxes must be 1000m or less.
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3G)
e 1:1 Connection
Display side
Terminal block Shield External Device side
Phueeniie =
Signal name ,’I ," \ Signal name
NER
é RDA T / ‘{'\‘ Blue | D(B)
] 1 1
/4_ RDB - I White| D(A)
] i L]
] 1 '
Display  Termination SDA :' :' Iu Red SG
. * [}
resistance*1 SDB :: |' E white|  SG
] : !
SG =
] ] !
ERA :I S
] 1 :
CSA b
] \ !
ERB :l ' :
] h !
CSB \ \ ,"
(R
“ “l”
User-created cable
* 1:n Connection
Display side
Terminal block Shield External Device side Shield External Device side
y===== A ’ N
Signal name ! ;'\I Signal name 7 J Y Signal name
= RDA //\\ Bue| D) | /\  TBie| D@)
/ RDB " ,. I‘. white| D(A) :' i\ twhie| D(A)
Display Termination SDA j:’ :' ': Red SG I“ ‘.‘ :': Red SG
resistance*1 SDB ': t E White sG “‘ \‘ ’: White sSG
SG A
ERA j =
CSA oo
ERB j Voo
CSB Voo

A

v

User-created cable
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|

*1 The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the
rear of the Display as shown in the table below.
DIP Switch No. Set Value
1 OFF
2 OFF
3 ON
4 ON
Iﬁ' + The cable length must be 10m or less.™!
*1

Max length between the Display and the "Accessory Box connected to Display". Total cable length
between accessory boxes must be 1000m or less.
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3H)
* 1:1 Connection
Display side
D-Sub 9pin (plug) Shield External Device side
Pin Signal name ',’I A Signal name
N
Display % L|NE(+) ‘,/ \"\'ll Blue D(B)
1 )
7 8 LINE(-) i/ N——white| D(A)
.' ] 1
H ] 1
Termination 1 NC :v :' ' Red SG
resistance ] | .
1000 12w|___2 NC : E' E White|  SG
5 GND(SG) ' P
H ] ]
4 RS(RTS) ! o
: 1 1
6 5V | P
oo
7 NC '.. (I
1 i "
9 NC Voo
\ \ g
Shell FG — \/
User-created cable
* 1:n Connection
Display side
D-Sub 9pin (plug) Shield External Device side Shield External Device side
Pin Signal name '," ,,T\‘ Signal name /, / ‘\‘ Signal name
NE PN
Display % 3 LINE(+) ‘, /A¥\“ Buue| D(B) R Blue| D(B)
/ 8 LINE(-) i White| D(A) [ 1 ——White|] D(A)
Termination 1 NC :" i I: Red | SG 1 t ‘;' Red |  SG
resistance ! Y i . \ \ ! _
100Q 1/2W 2 NC ! P White]  SG o 7 White| SG
5 |enpse) —— i T
4 RSRTS) | | 1 i =
6 | sv b
7 |~ | i
N I IR
Shell G —a A

A

v

User-created cable

IVIlel=ar\\ill « The 5V output (Pin #6) on the Display is the power for the Siemens AG’s PROFIBUS

connector. Do not use it for other devices.
NOTE

*1

e In COM on the GP-4107, the SG and FG terminals are isolated.

* The cable length must be 10m or less."!

Max length between the Display and the "Accessory Box connected to Display". Total cable length
between accessory boxes must be 1000m or less.
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=

PFXZCBADTM1 TRMRX

31)
* 1:1 Connection
Terminal block Shield External Device side
rom———— ?,
Signal name '," ,'I “\ Signal name
1
RDA - Blue | D(B)
Display !
RDB > White| D(A)
l =l H
= SDA i Red [ SG
1
PFXZCBADTMA1 SDB i White|  SG
1
TRMRX \
1
SG :
FG
b User-created cable g
* 1:n Connection
Terminal block Shield External Device side Shield External Device side
Signal name l,’l ,"”‘\ Signal name I/I“““,?\\ Signal name
RDA ! //\\ Blue| D(B) — //\:\ 1 Bue] D)
Display RDB i/ N —wnie] DA) =—/ | \——{wnie| D(A)
= sbA H | ! Red | SG ¥ +—1{{ Red| SG
= H ! L \ v
SDB :I Y White] SG Y \\ + White] SG

SG
FG — \
h User-created cable i’
NOTE I * The cable length must be 10m or less.™

*1  Max length between the Display and the "Accessory Box connected to Display". Total cable length
between accessory boxes must be 1000m or less.
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3J)
e 1:1 Connection
External Device side

Signal name
Display
D1 Biue | D(B)
White| D(A)
Red | SG
PFXZLMCBRJR81
White] SG
¢ 1:n Connection
Esrgtiggggn External Device side Shield External Device side
100Q 1/2W ) / ™ )
Signal name / AR Signal name
Displa D1 ! [
ey Blue| D(B) |— //\:\ ' Blue | D(B)
i i \
White| D(A) 5 i — White| D(A)
1 1
Red| sG "I i— 1 Red| SG
PFXZLMCBRJR81 ) \ v -
White] SG Y AN ya White] SG
NOTEI * The cable length must be 5Sm or less."!

*1  Max length between the Display and the "Accessory Box connected to Display". Total cable length
between accessory boxes must be 195 or less.
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3K)
¢ 1:1 Connection
Display side
D-sub 9 pin (socket) Shield External Device side
Pin Signal name ':’, A Signal name
! i\
Display =] 2 | pata+ /\\ —Bue | D)
) )
/ 1 DATA- i/ I\ ——white| D(A)
)
! P
Termination 3 NC ,: :' ] Red SG
resistance 7 ! q | ;
100Q 1/2W NC f i i White] SG
5 GND —
H | |
4 NC S
! : H
8 NC S
H 1 ]
9 NC oo
\ Vo
6 NC Voo
\ \
Shell FG & A/
‘\ ----- ¥
User-created cable
¢ 1:n Connection
Display side
D-sub 9 pin (socket) Shield External Device side Shield External Device side
Pin Signal name ! it Signal name // ,"’\\ Signal name
i /\." \ PN N
Display % 2 DATA+ :-/ ‘{:\ ' Blue [ D(B) :: / :\ : Blue [ D(B)
1 DATA- i/ INd—{wnite| D(A) { \—— white| D(A)
] ] 1 : .. ll
/ 3 NC . Red | SG ! ' lRed| sG
Termination ! ! ! ‘\ \ H
resistance 7 NC i d \ White| SG A v White| SG
1000 1/2W ; o e 3\
5 GND — l
] ] 1
4 NC A =
s v ||
] ] 1
9 NC oo
x| 4L
Shell 6 —a &
| P, ~
User-created cable
NOTE I + The cable length must be 10m or less.”!

*1  Max length between the Display and the "Accessory Box connected to Display". Total cable length
between accessory boxes must be 1000m or less.

GP-Pro EX Device/PLC Connection Manual 95



5.4 Cable Diagram 4

MODBUS SIO Master Driver

Display
(Connection Port)

Cable

Notes

GP3000 (COM1)
GP4000"! (COM1)
SP5000 (COM1/2)

User-created cable
+

RS 232 D tap link cable by Schneider Electric

The cable length must

TSX SCP CC 1030 (3m)
+
PCMCIA card for RS232C by Schneider Electric
TSX SCP 111

ST (COM1) 4A TSX SCP CC 1030 (3m) be 15m or less.*?
LT3000 (COM1) + ’
IPC*? PCMCIA card for RS232C by Schneider Electric
PC/AT TSX SCP 111
User-created cable
+
GP-4105 (COMI) RS 232 D tap link cable by Schneider Electric
GP-4115T (COM1) 4B TSX SCP CC 1030 (3m) The cable length must
GP-4115T3 (COM1) N be 15m or less.™
PCMCIA card for RS232C by Schneider Electric
TSX SCP 111
RJ45 RS-232C Cable (5m) by Pro-face
PFXZLMCBRIJR21
+
LT-4*01TM (COM1) . . .
LT-Rear Module (COM1) 4C RS 232 D tap link cable by Schneider Electric The cable length must

be 8m or less.

*1  All GP4000 models except GP-4100 series and GP-4203T

*2  Only the COM port which can communicate by RS-232C can be used.
Hm |PC COM Port (page 8)

*3  Total length for TSX SCP CC 1030 and User-created cable.
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4A)
Display side External Device side
D-sub 9 pin (socket) Shield D-sub 25 pin (socket)
Pin Signal name / '/A‘\‘ Pin Signal name
food TSX SCP 111
2 RD(RXD) |«—i Y- TXD
! o
Display 3 SD(TXD) ——> RXD
4 ER(DTR) , b E RTS
6 DR(DSR) ; b CTS TSX SCP CC 1030
! N
7 RS(RTS) 5 o 20 DTR
! I
8 CS(CTS) ] i Vo E DSR
! Vo
5 SG — SG
Shell FG —“o‘ A
) User-created cable -
NOTE * The cable length must be 15m or less. “l
(o)
*1  Total length for TSX SCP CC 1030 and User-created cable.
4B)
Display side External Device side
Terminal block Shield D-sub 25 pin (socket)
Signal name ! '/“‘\‘ Pin Signal name
R TSX SCP 111
RD(RXD) fe—i — TXD
Display SD(TXD) 3 RXD
ER(DTR) ! o II RTS
DR(DSR) : oo CTS TSX SCP CC 1030
RS(RTS) :I ! |: 20 DTR
CS(CTS) oot 6 DSR
SG N SG
) User-created cable "
NOTE I * The cable length must be 15m or less. ¥l

*1  Total length for TSX SCP CC 1030 and User-created cable.
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4C)

Display

PFXZLMCBRJR21

/

RXD

External Device side
D-sub 25 pin (socket)

Pin Signal name
2 TXD
RXD
RTS
CTS
20 DTR
6 DSR
7 SG

TSX SCP 111

TSX SCP CC 1030

NOTE I

» The cable length must be 8m or less. *

*1  Total length for TSX SCP CC 1030 and User-created cable.
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5.5 Cable Diagram 5

Display

Cable Notes
(Connection Port)

COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01
+
Terminal Block Conversion Adapter by Pro-face
CA3-ADPTRM-01

+
o S5A User-created cable
GP3000 " (COM1) +
AGP'*?’ 302B (COM2) Uni-Telway cable by Schneider Electric Industries
GP-4*01TM (COM1) TSX SCP CU 4030 (3m)
GP-Rear Module +
(C%Ml) PCMCIA card for RS485 by Schneider Electric Industries
ST*2 (COM2) TSX SCP 114

LT3000 (COM1)

User-created cable
+
Uni-Telway cable by Schneider Electric Industries
5B TSX SCP CU 4030 (3m)
+
PCMCIA card for RS485 by Schneider Electric Industries
TSX SCP 114

Online Adapter by Pro-face
CA4-ADPONL-01
+
Terminal Block Conversion Adapter by Pro-face
CA3-ADPTRM-01
+
5C User-created cable
+
Uni-Telway cable by Schneider Electric Industries
TSX SCP CU 4030 (3m)
+
GP3000" (COM2) PCMCIA card for RS485 by Schneider Electric Industries
TSX SCP 114

Online Adapter by Pro-face

CA4-ADPONL-01
+

User-created cable
+

Uni-Telway cable by Schneider Electric Industries
TSX SCP CU 4030 (3m)
+
PCMCIA card for RS485 by Schneider Electric Industries
TSX SCP 114

5D
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Display
(Connection Port)

Cable

Notes

IpC™

SE

COM Port Conversion Adapter by Pro-face

CA3-ADPCOM-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable
+

Uni-Telway cable by Schneider Electric Industries
TSX SCP CU 4030 (3m)
+
PCMCIA card for RS485 by Schneider Electric Industries
TSX SCP 114

SF

User-created cable
+
Uni-Telway cable by Schneider Electric Industries
TSX SCP CU 4030 (3m)
+
PCMCIA card for RS485 by Schneider Electric Industries
TSX SCP 114

GP-4106 (COM1)
GP-4116T (COM1)

5G

User-created cable
+
Uni-Telway cable by Schneider Electric Industries
TSX SCP CU 4030 (3m)
+
PCMCIA card for RS485 by Schneider Electric Industries
TSX SCP 114

GP-4107 (COM1)
GP-4*03T"° (COM2)
GP-4203T (COM1)

SH

User-created cable
+
Uni-Telway cable by Schneider Electric Industries
TSX SCP CU 4030 (3m)
+
PCMCIA card for RS485 by Schneider Electric Industries
TSX SCP 114

GP4000"® (COM2)
GP-4201T (COM1)
SP5000 (COM1/2)

51

RS-422 Terminal Block Conversion Adapter by Pro-face
PFXZCBADTMI1
7

+
User-created cable
+
Uni-Telway cable by Schneider Electric Industries
TSX SCP CU 4030 (3m)
+
PCMCIA card for RS485 by Schneider Electric Industries
TSX SCP 114

5B

User-created cable
+
Uni-Telway cable by Schneider Electric Industries
TSX SCP CU 4030 (3m)
+
PCMCIA card for RS485 by Schneider Electric Industries
TSX SCP 114
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Displa
p, v Cable Notes
(Connection Port)
RJ45 RS-485 Cable (5m) by Pro-face
PFXZLMCBRIJRS1
LT-4*01TM (COM1) +
LT-Rear Module 5] Uni-Telway cable by Schneider Electric Industries
(coml) TSX SCP CU 4030 (3m)
+
PCMCIA card for RS485 by Schneider Electric Industries
TSX SCP 114
User-created cable
+
* Uni-Telway cable by Schneider Electric Industries
PE-4000B"8
PS5000°8 5K TSX SCP CE 4030 (3m)
PCMCIA card for RS485 by Schneider Electric Industries
TSX SCP 114

*1 All GP3000 models except AGP-3302B

*2 All ST models except AST-3211A and AST-3302B

*3  All GP3000 models except GP-3200 series and AGP-3302B

*4  Only the COM port which can communicate by RS-422/485 (2 wire) can be used. (Except PE-4000B, PS5000)
m |[PC COM Port (page 8)

*5  Except GP-4203T

*6  All GP4000 models except GP-4100 series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T

*7  When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block

Conversion Adapter, refer to Cable Diagram 5A.

*8  Only the COM port which can communicate by RS-422/485 (2 wire) can be used.

Hm |PC COM Port (page 8)

5A)
Terminal block Shield External Device side
Signal name /I ,r' ‘\‘ Signal name
N - TSX SCP 114
Display  CA3-ADPCOM-01 RDA i / ;\ : ue| D(B) Y
RDB ~—/ I \“———white| D(A) 1
= Pl
// SDA ~ |i : : Red [ SG -
H ] |
CA3-ADPTRM-01 SDB b Y 1 Dwnie| SG {°  Tsx'scpcu 4030
! i
TRMRX I'. !
{ i
SG 0 !
FG “ f

v

User-created cable
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5B)
Display side
D-sub 9 pin (socket) Shield External Device side
Pin Signal name ," ," 5 Signal name
NE TSX SCP 114
% 1 RDA ,.' / i\ 3 Blue | D(B) Y
2 RDB i/ N—wnie| D(A)
Termination 3 SDA _J l' : i Red SG 1
resistance .: AE_E
100012W| 7 SDB ! i L{wnite| SG 1 TSX SCP CU 4030
Display 5 SG —é— i
4 ERA |
8 CSA ]
9 ERB ] oo
6 CSB Voo
Shell FG  —= \/
\ A"
h User-created cable g
5C)
Terminal block Shield External Device side
Signal name ! ," \ Signal name
! /\',' \ TSX SCP 114
. CA4-ADPONL-01 RDA { t Blue | D(B)
Display | / ,\ \
RDB :' i White| D(A)
= 1 H
[ /|:| SDA H E E L Red SG
CA3-ADPTRM-01 SbB b White|  SG TSX SCP CU 4030
TRMRX !
SG :
FG

v

A

User-created cable

GP-Pro EX Device/PLC Connection Manual

102



MODBUS SIO Master Driver

5D)
D-sub 9 pin (plug) Shield External Device side
Pin | Signal name T Signal name
N TSX SCP 114
Display 2 RDA T / '\ T Blue | D(B)
7 RDB > H |'. White| D(A)
p 3 SDA P e Red | sG
CA4-ADPONL-01 8 SDB i : i White|  SG TSX SCP CU 4030
1 TRMRX i : ::
s | so 1—+/ | |
o |TRMRX| i i {
shel | FG |—&
) User-created cable g
5E)
Terminal block Shield External Device side
Signal name Signal name
TSX SCP 114
Display ~ CA3-ADPCOM-01 RDA Blue| D(B) Y
RDB White D(A) 1
|
l //':' SDA Red | SG -
CA3-ADPTRM-01 SDB white| SG 1 TSX SCP CU 4030
TRMRX
SG
FG

v

F 3

User-created cable
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5F)

=

Termination
resistance

Display side
D-sub 9 pin (socket)

Pin

Signal name

Shield
-

DATA+

External Device side

DATA-

NC

100Q 1/2W

Display

NC

GND(SG)

ERA

CSA

]

Olo|dh|lO|N|WIN]|—~

ERB

CSB

]

Shell

FG

)

A

Signal name
TSX SCP 114
Blue | D(B) 3
White| D(A) 1
Red SG 1
White] SG 1 TSX SCP CU 4030

User-created cable

A 4
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5G)
Display side
Terminal block Shield External Device side
y===== a
Signal name ! ! \ Signal name
N TSX SCP 114
% RDA ‘.‘ / }‘\ ! Blue | D(B) §
RDB i/ —whie| D(A) ]
Termination SDA :' :' \ Red SG -
resistance*1 I} | E
SDB b} L White] SG TSX SCP CU 4030
Display SG ; é i
ERA P
CSA :l A
ERB :| oo
CSB i

F 3

User-created cable

4

*1 The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the
rear of the Display as shown in the table below.

DIP Switch No. Set Value
1 OFF
2 OFF
3 ON
4 ON
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5H)
Display side
D-sub 9 pin (plug) Shield External Device side
I I'\\ .
Pin Signal name H Y Signal name
/ i TSX SCP 114
% 3 LINE(+) ; — Blue [ D(B) 1
8 LINE(-) ; ——{white| D(A)
Termination 1 NC :' ' Red SG 1
resistance E 1
100Q 1/2W 2 NC ! i White| SG 1 TSX SCP CU 4030
Display 5 GND(SG) |— i
4 RS(RTS) | !
'. ]
6 5V ‘. i
)
7 NC ' i
9 NC ;
Shell FG [ !

\4

A

User-created cable

IV[=0l>a\\il © The 5V output (Pin #6) on the Display is the power for the Siemens AG’s PROFIBUS
connector. Do not use it for other devices.

¢ In COM on the GP-4107, the SG and FG terminals are isolated.

NOTE I

51)
Terminal block Shield External Device side
Signal name ! FAY Signal name
NE TSX SCP 114
RDA - Lt Blue D(B) J
Display i / '}\ \
RDB } | White| D(A)
| = ! H 1
/l=' SDA g P — Red [ SG
' ] i )
PEXZCBADTM1 SDB § / 5 White| SG 1 TSX SCP CU 4030
TRMRX —I% /4 !
\ Vo
SG AR
F6 —=  \/

v

F 3

User-created cable
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5J)
External Device side
Signal name
Display D1 TSX SCP 114
Blue| D(B) Y
DO Twhite| D(A)
GND Red SG
PFXZLMCBRJR81
White SG 1 TSX SCP CU 4030
5K)
Display side
D-sub 9 pin (socket) Shield External Device side
Pin Signal name ! ,"\‘\ Signal name
NE TSX SCP 114
% 2 DATA+ ! / "\ L Blue | D(B) 3
i N\
1 DATA- ' i White| D(A) 1
Termination 3 NC -'I -'I : Red SG
resistance :' H '
1000 12w | 7 NC b A L{wnie| SG TSX SCP CU 4030
Display 5 GND | i ;
i i !
4 NC ] 1 !
] v
g | N | i
9 NC b
[} [} H
6 NC Voo
\ \
Shell FG — \/

A

User-created cable

v
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5.6

Cable Diagram 6

MODBUS SIO Master Driver

Display
(Connection Port)

Cable

Notes

GP3000 (COM1)
GP4000"! (COM1)
SP5000 (COM1/2)

User-created cable

ST (COMI) 6A 'lf;e; c:rbllzslsength must be
LT3000 (COM1) :

IPC*?

PC/AT

GP-4105 (COM]1)

GP-4115T (COM1) The cable length must be
GP-4115T3 (COM1) 6B User-created cable 15m or less.

LT-4*01TM (COM1) RJ45 RS-232C Cable (5m) by Pro-face

LT-Rear Module (COM1) 6C PFXZLMCBRIR21 The cable length must be

Sm or less.

*1  All GP4000 models except GP-4100 series and GP-4203T

*2  Only the COM port which can communicate by RS-232C can be used.
m |[PC COM Port (page 8)

6A)

Display

Display side

D-sub 9 pin (socket)

External Device side

Shield

Pin

Signal name

D-sub 9 pin (plug)

Pin

RD(RXD)

Signal name

SD(TXD)

RXD

ER(DTR)

TXD

SG

SG

DR(DSR)

DTR

Njo|loa|d~|W]|N

RS(RTS)

DSR

CS(CTS)

RTS

o I|IN|jo|~|j]O|JW]|DN

Shell

FG

CTS

A

User-created cable

A 4

NOTE I

* The cable length must be 15m or less.
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6B)
Display side External Device side
Terminal block Shield D-sub 9 pin (plug)
Signal name l,’l ,” “\‘ Pin Signal name
RD(RXD : L
( ) i >< :. 2 RXD
SD(TXD) { ! 3 TXD
Display ER(DTR) P 5 SG
SG —-—/ I: 4 DTR
DR(DSR) P 6 DSR
RS(RTS) b 7 RTS
CS(CTS) :l Voo I: 8 CcTS
User-created cable
NOTE I * The cable length must be 15m or less.
6C)
External Device side
D-sub 9 pin (plug)
Displa Pin Signal name
Py TXD
2 RXD
RXD
3 TXD
GND
PFXZLMCBRJR21 5 SG
I: 4 DTR
6 DSR
7 RTS
I: 8 CTS
NOTE I » The cable length must be 5m or less.
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5.7 Cable Diagram 7
Displa
p. y Cable Notes
(Connection Port)
* D-Shell adapter chneider Electric
ggiggg (IC(C)I(\)/[;ZI) Shell adapter by Schneider Electri
( 110 XCA 203 00 The cable
SP5000 (COM1/2) . Jength must
E’??)E)ggl\éng A RS232 communication cable RJ45 to RJ45 by Schneider Electric be 9.5m or
*) ( ) 110 XCA 282 01(1m), 110 XCA 282 02(3m) or 110 XCA 282 03(6m) | less.
IPC
PC/AT
User-created cable
+
GP-4105 (COM1) D-Shell adapter by Schneider Electric The cable
p y
GP-4115T (COM1) 7B 110 XCA 203 00 length must
GP-4115T3 (COM1) . be 9.5m or
RS232 communication cable RJ45 to RJ45 by Schneider Electric less.
110 XCA 282 01(1m), 110 XCA 282 02(3m) or 110 XCA 282 03(6m)
*1  All GP4000 models except GP-4100 series and GP-4203T
*2  Only the COM port which can communicate by RS-232C can be used.
m |PC COM Port (page 8)
7A)
110 XCA 282 01
or .
) 110 XCA 282 02 Extermal Device
Display or
110 XCA 282 03
= o c
-
110 XCA 203 00 \
Modbus port 1
NOTE I » The cable length must be 9.5m or less.
7B)
Display side External Device side
Terminal block Shield D-sub 9 pin (plug)
Signal ! B Pin Signal 110 XCA 282 01
Display name ; P name or i
RD(RXD) t — 2 |RD(RXD) 110 XCA 282 02 Extermal Device
SD(TXD) 3 [SD(TXD) oxcazezes /S
ER(DTR) 4 [erRoR)| [EO———M™] m
SG 5 SG__ 110 xCA 203 00
RS(RTS) T 7 RS(RTS) Modbus port 1
CS(CTS) A 8 |CS(CTS)
L
) User-created cable .
NOTE I * The cable length must be 9.5m or less.
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5.8 Cable Diagram 8
Displa
p, v Cable Notes
(Connection Port)
GP3000"! (COM1) COM Port Conversion Adapter by Pro-face
AGP-3302B (COM2) CA3-ADPCOM-01
GP-4*01TM (COM1) +
GP-Rear Module 8A Terminal Block Conversion Adapter by Pro-face The cable lenath
(COMI) CA3-ADPTRM-01 e 50 Omg |
ST"2 (COM2) N ust be or less.
LT3000 (COM1) User-created cable
IPC"3
8B User-created cable
Online Adapter by Pro-face
CA4-ADPONL-01
+
8C Terminal Block Conversion Adapter by Pro-face
. CA3-ADPTRM-01
GP3000" (COM2) + The cable length
User-created cable must be 500m or less.
Online Adapter by Pro-face
CA4-ADPONL-01
8D
+
User-created cable
GP-4106 (COM1)
GP-4116T (COM1) 8E User-created cable The cable length
must be 500m or less.
RS-422 Terminal Block Conversion Adapter by Pro-face
GP4000*5 (COM2) PEXZCBADTMI
GP-4201T (COM1) 8F The cable length
SP5000 (COM1/2) * must be 500m or less.
User-created cable
8B User-created cable
PE-4000B"7 The cable length
P$5000°7 8G User-created cable must be 500m or less.
*1 All GP3000 models except AGP-3302B
*2 All ST models except AST-3211A and AST-3302B
*3  Only the COM port which can communicate by RS-422/485 (4 wire) can be used. (Except PE-4000B, PS5000)
m |[PC COM Port (page 8)
*4  All GP3000 models except GP-3200 series and AGP-3302B
*5  All GP4000 models except GP-4100 series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T
*6  When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 8A.
*7  Only the COM port which can communicate by RS-422/485 (4 wire) can be used.

Hm |PC COM Port (page 8)
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8A)
External Device Modbus port 2
Terminal block Shield D-sub 9 pin (plug)
Signal name ,/’ TR Pin Signal name
b ALY
Di CA3-ADPCOM-01 RDA [« / ‘{\ \ 1 TXD+
isplay | ! !
[E/]] — RDB (e i\ 6 TXD-
[ = SDA //\: < RXD+
]
CA3-ADPTRM-01 SDB ; > 7 RXD-
TRMRX (— & L — 3 SG
sG —/ .-'
FG _‘*‘ ‘\\vll'
h User-created cable "
NOTE I + The cable length must be 500m or less.
8B)
Display side External Device Modbus port 2
D-sub 9 pin (socket) Shield D-sub 9 pin (plug)
Pin Signal name :’I '/ ‘\ Pin Signal name
] Py
% 1 RDA i\ 1 TXD+
! i\
E 2 RDB —— M— 6 TXD-
N
Display Termination 3 SDA 5 / :\ 2 RXD+
resistance 1 >
100Q 1/2W 7 SbB i > 7 RXD-
5 SG E 3 SG
4 ERA i
]
8 CSA :I bl
H 1 1
9 ERB
6 CSB
Shell FG 4 v/
NOTE I + The cable length must be 500m or less.
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8C)

Display

CA4-ADPONL-01

| =
/
/

CA3-ADPTRM-01

External Device Modbus port 2

Terminal block Shield D-sub 9 pin (plug)

Signal name ,",-““1,7\\‘ Pin [ Signal name
RDA |« ‘,'I /\"' “‘. 1 TXD+
RDB [« / \ ': 6 TXD-
SDA A ‘B RXD-+
SDB i / i\ > 7 RXD-

TRMRX {— ': 3 SG
s 1]
Fa —

A

v

User-created cable

NOTE I

+ The cable length must be 500m or less.

8D)

Display

D-sub 9 pin (plug)

External Device Modbus port 2

Shield D-sub 9 pin (plug)

Pin  [Signal name '//“-“,:'7\“\‘ Pin | Signal name
CA4-ADPONL-01|__2 RDA | ','I /A‘}"\ ‘-,‘ 1 TXD+

7 RDB  [e9 i 6 TXD-

3 SDA LN » 2 RXD+

8 SDB / 5\ > 7 RXD-

1 [ TRMRX i | 3 SG

5 | s6 —"t

9 |TRMRX | % i

Shell FG _“*\----.\5, ,:"

A

\ 4

User-created cable

NOTE I

* The cable length must be 500m or less.
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8E)
Display side External Device Modbus port 2
Terminal block Shield D-sub 9 pin (plug)
Signal name ,,'I ‘,"“‘\‘ Pin Signal name
RDA  l—A\ 1 TXD+
= RDB <—‘—/ \—-— 6 TXD-
Display ~ Termination SDA : //\\ 2 RXD+
fesistance™ SDB 7 RXD-
SG 3 SG
ERA
CSA :I | !
ERB
CSB ]
lﬁ' * The cable length must be 500m or less.

*1 The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the
rear of the Display as shown in the table below.

DIP Switch No. Set Value
1 OFF
2 OFF
3 ON
4 ON
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8F)

Terminal block

MODBUS SIO Master Driver

External Device Modbus port 2

Shield D-sub 9 pin (plug)
Signal name l:'l ----- ?\\ Pin Signal name
RDA |« ,'l A ‘I'- 1 TXD+
Dicplay RDB ey / \ 6 TXD-
M= SDA At RXD+
PFXéCBADTM1 SDbB E / i\—;—’ 7 RXD-
TRMRX [ L — 3 SG
6 |— Y

A

User-created cable

\ 4

NOTE I

* The cable length must be 500m or less.

8G)
Display side External Device Modbus port 2
D-sub 9 pin (socket) Shield D-sub 9 pin (plug)
Pin Signal name ‘,’I ----- ',?‘\‘ Pin Signal name
3 Rt |— AL 1 TXD+
/% 4 Rx- <—J \—|— 6 TXD-
oy el 2| T A 2 [ RO,
100Q 1/2W 1 Tx i f ; 7 RXD-
5 GND ——t— 3 SG
7 NC
8 NC
9 NC
6 NC
sl | FG |—4 b/

NOTE I

* The cable length must be 500m or less.
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5.9 Cable Diagram 9
Displ
p, 2y Cable Notes
(Connection Port)
GP3000 (COM1)
GP4000"! (COM1)
SP5000 (COM1/2)
ST (COM1) 9A User-created cable T?;i?ﬂ::ngth must be
LT3000 (COM1) :
1PC*?
PC/AT
GP-4105 (COM1)
GP-4115T (COM1) The cable length must be
GP-4115T3 (COM1) B User-created cable 15m o less.

*1  All GP4000 models except GP-4100 series and GP-4203T

*2  Only the COM port which can communicate by RS-232C can be used.
m |PC COM Port (page 8)
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|

9A)
Display side External Device side
D-sub 9 pin (socket) Shield D-sub 9 pin (socket)
Pin  |Signal name ','/ ,,’7“\ Pin Signal name
2 [RD(RXD)—— 3 SD
3 |spmxp)l——EL 4+ 5 2 RD
Display !
4 [ERDTR) L 6 DR
5 SG i—rt 5 SG
7 |RsRTS)H L 7 RS
8 CS(CTS):I Voo I: 8 cs
Shell | FG  —-.%
lﬁl * The cable length must be 15m or less.
9B)
Display side External Device side
Terminal block Shield D-sub 9 pin (socket)
Signal name ,,'/ ,,’7“\ Pin Signal name
RD(RXD) [—f— 3 SD
SD(TXD) A S N RD
Display !
ER(DTR) i 6 DR
SG i—rt 5 SG
RS(RTS) 7 RS
CS(CTS) :I "\‘ / I: 8 cs
1
lﬁl * The cable length must be 15m or less.

GP-Pro EX Device/PLC Connection Manual 117



MODBUS SIO Master Driver

5.10 Cable Diagram 10
Displ
|sp. 2y Cable Notes
(Connection Port)
GP3000 (COM1)
GP4000"! (COM1)
SP5000 (COM1/2)
ST (COM1) 10A User-created cable T?;?ﬂ:::ngth must be
LT3000 (COM1) :
IPC*?
PC/AT
GP-4105 (COM1)
GP-4115T (COM1) The cable length must be
GP-4115T3 (COM1) 108 User-created cable 15m or less.

*1  All GP4000 models except GP-4100 series and GP-4203T

*2  Only the COM port which can communicate by RS-232C can be used.
m |PC COM Port (page 8)

10A)
Display side External Device side
D-sub 9 pin (socket) Shield D-sub 9 pin (plug)
Pin Signal name '/’, ',’7“\ Pin Signal name
2 |RoRxXD)le—— 3 SD
3 |soxp)b——++ M 2 RD
Display ! !
4 ER(DTR) E Lo—i> 6 DR
5 SG — 5 SG
7 |rRswTgl L b i 7 RS
8 |cs(CTs) :I I: 8 cs
Shell F6 - Lyl CD
lﬁ' + The cable length must be 15m or less.
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|

10B)
Display side External Device side
Terminal block _S_h_l(_el_d D-sub 9 pin (plug)
Signal name ','I ',’I ‘\ Pin Signal name
RD(RXD) _je—F—F— 3 SD
SD(TXD) A S N RD
Display !
ER(DTR) » 6 DR
SG b H 5 SG
RS(RTS) 7 RS
CS(CTS) :I Voo I: 8 cs
— i 1 CD
NOTE I * The cable length must be 15m or less.

GP-Pro EX Device/PLC Connection Manual 119



MODBUS SIO Master Driver

51 Cable Diagram 11
Displa
p, v Cable Notes
(Connection Port)
GP3000"! (COM1) COM Port Conversion Adapter by Pro-face
AGP-3302B (COM2) CA3-ADPCOM-01
GP-4*01TM (COM1) +
GP-Rear Module 11A Terminal Block Conversion Adapter by Pro-face The cable length
(COM1) CA3-ADPTRM-01 must be 1000m or
ST*2 (COM2) + less.
LT3000 (COM1) User-created cable
IPC™3
11B User-created cable
Online Adapter by Pro-face
CA4-ADPONL-01
+
11C Terminal Block Conversion Adapter by Pro-face
CA3-ADPTRM-01
GP3000™ (COM2) N The cable length
must be 1000m or
User-created cable
less.
Online Adapter by Pro-face
1D CA4-ADPONL-01
+
User-created cable
GP-4106 (COM1) The cable length
GP-4116T (COM1) 11E User-created cable must be 1000m or
less.
RS-422 Terminal Block Conversion Adapter by Pro-face
* PFXZCBADTMI
GP4000" (COM2) v
GP-4201T (COM1) 11F The cable length
SP5000 (COM1/2) + must be 1000m or
User-created cable less.
11B User-created cable
PE-4000B"7 G eercrented cabt The cable length
P85000*7 ser-created ¢ € ;nust be 1000m or
ess.

*1 All GP3000 models except AGP-3302B
*2 All ST models except AST-3211A and AST-3302B

*3  Only the COM port which can communicate by RS-422/485 (4 wire) can be used. (Except PE-4000B, PS5000)
m |PC COM Port (page 8)

*4  All GP3000 models except GP-3200 series and AGP-3302B
*5  All GP4000 models except GP-4100 series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T

*6  When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 11A.
*7  Only the COM port which can communicate by RS-422/485 (4 wire) can be used.
m |[PC COM Port (page 8)
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11A)
¢ 1:1 Connection
Display side External Device side
Terminal block RS-422/485
- Communication
Signal name Shield Terminal block
Termination| ST i
resistance | 1 ERM / ! 5 Signal name
! \
1209 1/2W P [
Display CASADPCOM-01 g RDA ! / '}\ ! Tt
isplay RDB < ! Tx- Termination
— /\E resistance
q = SDA X »  RX+ §091/2W
1
1
1
CA3-ADPTRM-01 SDB \ Vo RX-
1
SG ——— SG
\ vy
FG . N
h User-created cable "
¢ 1:n Connection
Display side External Device side External Device side
Terminal block RS-422/485 RS-422/485
- Communication Communication
Signal name Shield Terminal block Shield Terminal block
roomaneel TERM FEE A Signal name A Signal name
1200 1/2W VY .VIR! NI
Dispjay CASADPCON-O1 g RDA ] / }\ ' Tx+ i / }\ ¥ Tx+
Spay RDB < H Tx- H Tx- Termination
= /\; /\; resistance
= SDA % >  RX+ / \ RX+  [120012W
] ]
CA3-ADPTRM-01 SbB ' ".‘ I RX- \ "-‘ ! RX-
SG ¥ — SG ¥ — SG
\ A \ Ay
FG I S V) R ‘j'_
h User-created cable g
NOTE I * The cable length must be 1000m or less.
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11B)

e 1:1 Connection

MODBUS SIO Master Driver

External Device side
RS-422/485

Display side Communication
D-sub 9 pin (socket) Shield Terminal block
Esrirgtlgﬁggn Pin  [Signal name ! A Signal name|
120Q 1/2W ! i
g 1 RDA  f+— /\,'\ '-. Tx+
2 RDB 4—1J i\ Tx- | Termination
| o resistance
3 SDA PN LT Ry 1200 12w
Display / %
7 SDB P RX-
5 SG SG
4 ERA
8 CSA :| [
9 ERB :| oo
6 CSB Voo
Shell G |—a 4/
* 1:n Connection
External Device side External Device side
. . RS-422/485 RS-422/485
Display side Communication Communication
D-sub 9 pin (socket) Shield Terminal block Shield Terminal block
fermination) - pin | Signal name ‘/' ’,'l ‘\‘ Signal name '," ’.’I “\‘ Signal name
1200020 ROA —iA\ k Tx+ : /\'\ - Tx+
g 2 RDB q—IA'J .'?\_“‘_ Tx- :'I Tx- Ter_mination
. 1200 112
3 SDA » RX+ 4 RX+
Display / \ ! / ‘.\ i %
7 SDB > RX- r \ ,-' RX-
5 SG SG s SG
4 ERA _L
8 CSA :| : v
' [
9 ERB :| | Vo
' Vo
6 CsB Voo
shell | FG  |—a i/

* The cable length must be 1000m or less.

NOTE I

GP-Pro EX Device/PLC Connection Manual 122



11C)

e 1:1 Connection

Display side

Terminal block

MODBUS SIO Master Driver

External Device side

RS-422/485

) . Communication
Signal name I_S_fll_ejg\ Terminal block
Terminati : .
roaiataeel  TERM YA Signal name
] ) \
1200 1/2W P [
Dispjay CA4ADPONLO1 g RDA | i / '}\ \ Tx
isplay RDB < ! Tx- Termination
' resistance
= SDA N > RXs |120012wW
)
L/—l /N, E
H -
CA3-ADPTRM-01 SDB \ v RX
1
SG —— SG
\ v\ g
FG |—%----¥
N User-created cable "
* 1:n Connection
Display side External Device side External Device side
Terminal block RS-422/485 RS-422/485
- Communication Communication
Signal name Shield Terminal block Shield Terminal block
,Teiﬁ’;”tg‘,?c“;’r TERM i FAY Signal name i FAY Signal name
1200 1/2W P AVER JONS
) CA4-ADPONL-01 g RDA i / }\ f Tx+ i / }\ f Txt
Display RDB < ! Tx- ! Tx- Termination
= /\; /\; resistance
[| = SDA - > RX+ - > RX+ [L20012W
] ]
CA3-ADPTRM-01 Sbe \ ".‘ ! RX- | "-‘ ! RX-
SG A —F SG ¥ —F SG
FG I N ¥ N ‘j’_
h User-created cable -
NOTE I * The cable length must be 1000m or less.
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11D)
¢ 1:1 Connection

External Device side

) _ RS-422/485
Display side Communication
D-sub 9 pin (plug) Shield Terminal block
. . J AN
megn Pin  |Signal name| ,,'l ',” ‘\‘ Signal name
1 1
1200 1/2% > RDA | :, //\‘,\ “. Tx+
Display 7 RDB [« ! ," Tx- Termination
/\: resistance
3 SDA > RX+ 1200 1/2W
a
8 SDB /1> RX-
|
CA4-ADPONL-01 \ \
5 SG i SG
Shell FG [—%--¥
N User-created cable e
¢ l:n Connection
External Device side External Device side
. . RS-422/485 RS-422/485
Dlsplgy side Communication Communication
D-sub 9 pin (plug) Shield Terminal block Shield Terminal block
- ’ n ’ n
%Q@ﬁégn Pin Signal name / ',” \ Signal name / ',” N\ Signal name
/ [ / [
1200 ”2% 2 RDA [+—+ /\,\ ; Tx+ 7 ,\ ; T+
Display 7 RDB [+ / ," h Tx- ! ," h Tx- Termination
/\: /\!: resistance
3 SDA >  RX+ 7N RX+ é‘m vaw
/0 i
8 SDB /1 RX- = RX-
[} I} ! [} I} !
CA4-ADPONL-01 5 SG l“ '.‘ "-' SG n“ 1“ ".' SG
\ ] \ N
Shell [ZCT S — A — j_
N User-created cable "
NOTE I * The cable length must be 1000m or less.
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11E)
* 1:1 Connection
External Device side
_ . RS-422/485
Display side Communication
Terminal block Shield Terminal block
Termination | Signal name AN Signal name|
resistance*1 ! [
g RDA s Al t Tx+
RDB [+ A L5
»  RXs |120012wW
Display SDA / \
SDB > RX-
SG SG
ERA :|
CSA | Vo
ERB :| oo
CsB
* 1:n Connection
External Device side External Device side
RS-422/485 RS-422/485
Display side Communication Communication
Terminal block Shield Terminal block Shield Terminal block
Termination Signal name '," /\:/l "-“ Signal name ',/ /\',’/ \\“ Signal name
resistance*1 RDA < " L I'. Tx+ " / :\ '.‘ Tx+
g RDB «— i\ Tx- { Tx- Termination
i /\' ! A resistance
) SDA > RX+ : RX+ 1200 1/2W
Display / \ ! / "\ ! %
SDB »  RX- ) VT RX-
SG SG L SG
ERA :| _I__
CSA Vol
ERB :| oo
csB Voo
*1 The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the
rear of the Display as shown in the table below.
DIP Switch No. Set Value
1 OFF
2 OFF
3 ON
4 ON

NOTE I

* The cable length must be 1000m or less.
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11F)
* 1:1 Connection
Display side External Device side
Terminal block RS-422/485
Communication
Signal name Shield Terminal block
Terminati 2 A
r:srirgtlgra\égn TERM ’," ,,’I ‘\ Signal name
\
120Q 172W ! [
g RDA — //\;'\ ] Tx+
i ]
Display RDB  —+ i H Tx- Termination
H resistance
= SDA N > RX+  |120Q 12w
1
1
PFXZCBADTM1 SDB '.‘ ". ! RX-
1
SG —— SG
FG NV
h User-created cable "
¢ l:n Connection
Display side External Device side External Device side
Terminal block RS-422/485 RS-422/485
X Communication Communication
Signal name Shield Terminal block Shield Terminal block
- , , ”
;E;ir:tlgﬁggn TERM ',” ’," '\“ Signal name ',” ’,” ‘\“ Signal name
1200120 P e Af Y Tt HEVAVAR Txt
1 1
Display g| AN AN inat
RDB < i Tx- i Tx- Termination
H H resistance
= SDA N > Rx+ //\e\ RX+  |1200 172w
L/—‘ / \ : =
PFXZCBADTM1 SbB '.I "II H RX- '.I "II H RX-
1 1
SG T T i SG T T i SG
FG SV Y

\4

User-created cable

NOTE I * The cable length must be 1000m or less.
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11G)

¢ 1:1 Connection

MODBUS SIO Master Driver

External Device side

RS-422/485

Display side Communication
D-sub 9 pin (socket) Shield Terminal block
— / -A
roumionee'| _Pin_[Signalmamel / /% [signal name
120Q 1/2W P H /\‘;' \
g 3 Rx+ «— t Tx+
)
4 Rx- 4—-—/: :"\—"— Tx- Termination
! /\. ' resistance
- 2 Tx+ .: : : > RX+ 120Q 172W
isplay H / ;\ ! %
1 Tx- :' .: > RX-
]
5 GND —— SG
] ]
7 NC too
! | 1
8 NC A
oo
9 NC i Vo
\ \ '
6 NC | -
| v
Shell FG  |—a \/
\ V
¢ 1:n Connection
External Device side External Device side
. . RS-422/485 RS-422/485
Display side . Communication . Communication
D-sub 9 pin (socket) Shield Terminal block Shield Terminal block
Termination|  pin | signal name "/ ,," \‘. Signal name /', l,’l “‘. Signal name
] Rt fe— AN Tx+ LN Tx+
PN YA
g 4 Rx- <—,:J .'}\—i— Tx- / H ; Tx- Termination
! /\' \ /{ r ce
Dicol 2 Tx+ ; / \ —>  RX+ / i\ : Rx+  {120012W
isplay \ AN
1 Tx- > RX- i RX-
\ N
5 GND SG " SG
7 NC 1
8 NC b
' 1 ]
o v | b
6 NC Voo
Voo
Shell FG  |—= 1/

NOTE I

* The cable length must be 1000m or less.
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512 Cable Diagram 12
Displa
P v Cable Notes
(Connection Port)
COM Port Conversion Adapter by Pro-face
GP3000"! (COM1) CA3-ADPCOM-01
AGP-3302B (COM2) + he cabl
GP-4*01TM (COM1) 12A Terminal Block Conversion Adapter by Pro-face The cable
GP-Rear Module (COM1) CA3-ADPTRM-01 1165‘(;552‘2??2::
ST*2 (COM2) + :
LT3000 (COM1) User-created cable
12B User-created cable
Online Adapter by Pro-face
CA4-ADPONL-01
+
12C Terminal Block Conversion Adapter by Pro-face
CA3-ADPTRM-01 The cabl
3 e cable
GP3000 * (COM2) + length must be
User-created cable 1000m or less.
Online Adapter by Pro-face
12D CA4-ADPONL-01
+
User-created cable
COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01
+
PC*4 12E Terminal Block Conversion Adapter by Pro-face The cable
CA3-ADPTRM-01 length must be
T 1000m or less.
User-created cable
12F User-created cable
GP-4106 (COM1) The cable
GP-4116T (COM1) 12G User-created cable length must be
1000m or less.
GP-4107 (COM1)
GP-4+03T" (COM2) 12H User-created cable Erlle tchaﬂist be
GP-4203T (COMI) g
1000m or less.
RS-422 Terminal Block Conversion Adapter by Pro-face
*6 PFXZCBADTMI
GP4000 ° (COM2) I o The cable
GP-4201T (COM1) leneth must be
SP5000 (COM1/2) + g
User-created cable 1000m or less.
12B User-created cable
LT-4*01TM (COM1) RJ45 RS-485 Cable (5m) by Pro-face The cable
LT-Rear Module (COM1) 12] PFXZLMCBRIJRS81 length must be
200m or less.
PE-4000B"* 12K User-created cabl he cable
PS500078 ser-created cable length must be
1000m or less.

*1 All GP3000 models except AGP-3302B
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)
*3
*4

*5
*6
*7

*8

MODBUS SIO Master Driver

All ST models except AST-3211A and AST-3302B
All GP3000 models except GP-3200 series and AGP-3302B
Only the COM port which can communicate by RS-422/485 (2 wire) can be used. (Except PE-4000B, PS5000)
Hm |PC COM Port (page 8)
Except GP-4203T
All GP4000 models except GP-4100 series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T
When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 12A.
Only the COM port which can communicate by RS-422/485 (2 wire) can be used.
m |[PC COM Port (page 8)
12A)
* 1:1 Connection
Display side External Device side
Terminal block RS-422/485
. Communication
Signal name §b_lt_91(1\ Terminal block
Termination|  TERM SA Signal name
1200 1/2W [
! '.| Tx+
.: :, Tx- Termination
! ! resistance
AN+ T Ry, |tzoetew

SDA

SDB

N

SG

CA3-ADPTRM-01

1
’l
]
]
. CA3-ADPCOM-01 g RDA /
Display RDB e |1
|
i
|
\
\
‘\

SG
FG |f—----Y
- User-created cable "
* 1:n Connection
Display side External Device side External Device side
Terminal block RS-422/485 RS-422/485
) . Communication . Communication
Signal name §[1_|(_9|_q\ Terminal block I§_h_lglq\ Terminal block
Termination|  TERM '," ,,’I \ Signal name '," ,,’I \ Signal name
1200 1/2W ! [ ! [
Display CASADPOOMO1 RDA ';' ';' \ T+ ';' ';' ' Tt o
RDB i : \ Tx- | | H Tx- Termination
H H H H H ! resistance
SDA N L RX+ N RX+ 1202 1/2W
VAN 7 E
H W\ H P\
CA3-ADPTRM-01 SbB ' Vo RX- y Vo RX-
1 1
SG T T i SG T T i SG
\ L \ L
FG |—»----V L S— ‘l
) User-created cable "
* The cable length must be 1000m or less.
g
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12B)

e 1:1 Connection

External Device side

Display side RS-422/485
play i Communication
D-sub 9 pin (socket) Shield Terminal block
ronmnee”|  Pin  [signal name '," ,," \\‘ Signal name
120Q 1/2W \
5 1 RDA fooi Tx+
! !
] H ' T inati
2 RDB ¢! i i Tx- | resistance
3 SDA L A o Rx+ [1200172wW
Display /
7 SDB > RX-
5 SG SG
4 ERA
8 CSA :I i !
] 1
9 ERB :I oot
\ I
6 CSB Voot
\ (]
Shell FG  |—a 1/
* 1:n Connection
External Device side External Device side
Displ d RS-422/485 RS-422/485
Isplay side ) Communication ) Communication
D-sub 9 pin (socket) Shield Terminal block Shield Terminal block
fermination  pin  [Signal name ::’ ’," “.‘ Signal name '/' ’," “.‘ Signal name
1200 1’2% 1 RDA P T+ P Tx+
H I 1l H Il ' -
2 ROB [er | | i Tx- Pl Tx- | rcamtance”
] H 1
3 SDA LA » RX+ FA RX+ 1200120
Display / '.‘ / \I\ !
7 SDB » RX- i RX-
5 SG SG A SG
4 ERA _L
8 CSA :| P )
9 ERB :| oo
' Vo
6 CsB Voo
shel | FG |—a i/
NOTE I * The cable length must be 1000m or less.
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12C)
¢ 1:1 Connection
Display side External Device side
Terminal block RS-422/485
Communication
Signal name Shield Terminal block
Terminati / A -
roamraton TERM / / \\‘ Signal name
120Q 1/2W ! [
. CA4-ADPONL-01 g RDA [ T
Display RDB e |! ! | Tx- Termination
H H ! resistance
= SDA PN LT Rx; 2001w
! / N %
LN,
CA3-ADPTRM-01 SDB ] '-‘ 7 RX-
1
SG T T i SG
FG eV
N User-created cable e
¢ l:n Connection
Display side External Device side External Device side
Terminal block RS-422/485 RS-422/485
- Communication Communication
Signal name Shield Terminal block Shield Terminal block
- K ™ / ™
L‘Z’{;}Lj‘ﬁéﬁ” TERM ,,’ ’,” \ Signal name ,,’ ’,” \ Signal name
1200 1/2W ! [ ! [
' CA4-ADPONL-01 g RDA ! P Tx+ ! P T+
Display RDB e :- i Tx- :' ! Tx- Termination
— N : N : resistance
—= SDA / —>  RX+ / \ : RX+ [1202 172w
) I H '
N\ 1 ]
CA3-ADPTRM-01 SDB \ ".‘ ! RX- \ "‘ ! RX-
1 1
SG T —t SG T —t SG
FG —b-“ “v’/ \ \jl_/

\4

A

User-created cable

NOTE I

* The cable length must be 1000m or less.
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12D)

¢ 1:1 Connection

External Device side

RS-422/485
Display side Communication
D-sub 9 pin (plug) Shield Terminal block
. . J Al
Lesrirsr{gr?égn Pin  [Signal name| ,:'l '/l \ Signal name|
1200 1/2W ! b
5 2 RDA P Tx+
Display 7 RDB | ! ," I: Tx- Termination
/\: ! resistance
l HE 1200 1/2W
3 SDA / : : RX+ %
1
8 SDB i~/ \——»  RX-
\ \ !
CA4-ADPONL-01 5 SG 3 X "‘ sG
\ \
Shell FG |—e----V
N User-created cable "
¢ 1:n Connection
External Device side External Device side
RS-422/485 RS-422/485
Display side Communication Communication
D-sub 9 pin (plug) Shield Terminal block Shield Terminal block
. ; n p N
Termination  pin  [signal name ,," '," \\‘ Signal name ,," '," \\‘ Signal name
12002 1/2W ! ! ! !
o 5 2 RDA [ Tx+ P Tx+
Display 7 RDB [+ |i | |} Tx- . Tx- | Termination
l: N : l: N : resistance
3 SDA : / Py RX+ : / \ : RX+ L1202 12w
1l ! H 1l ! '
8 SDB e RX- i b RX-
\ \ \ \
CA4-ADPONL-01 5 sSG 2 - ".‘ sSG 2 - ".‘ sSG
Shell FG ——V e j_
- User-created cable i’
NOTE I * The cable length must be 1000m or less.
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12E)
¢ 1:1 Connection
Display side External Device side
Terminal block RS-422/485
Communication
Signal name Shield Terminal block
. . 4 o, . .
Lesrir:gﬁégr TERM '," ',” \ Signal name ;';}es’ig‘tg‘ﬁég”
1200 1/2W o NN 1200 1/2W
Display CASADPCOM-01 g RDA VA N RX+ %
oy RDB i RX-
— H .
= SDA ool Tx+
\ i H
CA3-ADPTRM-01 SbB ".‘ “. : Tx
1
(! \ L
SG ¥ W, SG
]
FG |—--¥
h User-created cable "
¢ 1:n Connection
Display side External Device side External Device side
Terminal block RS-422/485 RS-422/485
- Communication Communication
Signal name Shield Terminal block Shield Terminal block
- K A K A _—
Termination  TERM / ’,”\‘ Signal name / ’,”\‘ Signal name | Termination
1200120 [ oo T [ Al HEN RX+ H Al i RX+ |12001/2W
CA3-ADPCOM-01 i \ l \
Displa AR ! / \ i
Py 2| RDB i RX- =i RX-
1 1 1 1
= SDA oo Tx+ oo T+
' . i .
\ Voo \ Voo
CA3-ADPTRM-01 SDB Voo : Tx Voo : Tx
\ ! \ !
SG T T SG T T SG
F G ‘\ “V/ ‘\‘ ‘\ /

1|

User-created cable

NOTE I

* The cable length must be 1000m or less.
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12F)
¢ 1:1 Connection

External Device side

! ) RS-422/485
Display side Communication
D-sub 9 pin (socket) Shield Terminal block
%Eégi%%: Pin Signal name /" ",‘“\“ Signal name ;';gsfirgtiggtcign
g 1 DATA+ |e——tA\ {4 Rx+ |20n2w
2 | pam <—f/ \—.—> e 15
3 NC oo +
Display | b Tx
7 NC ! o Tx-
5 | GND(SG) f——rt— SG
4 ERA oo
! '
8 CsA :|
9 ERB :|
6 csB Voo
1 v
Shell FG  —a 3/
¢ 1:n Connection
External Device side External Device side
) ! RS-422/485 RS-422/485
Display side ) Communication ) Communication
D-sub 9 pin (socket) Shield Terminal block Sh|e|d" Terminal block
;E;gtigﬁggn Pin Signal name ','I ’,‘l “‘“ Signal name '," "l’ “\“ Signal name ;Esrirgtigra\ggn
ot DATA+ fe—Ad——{  Rx L AG Rx+  [12001/2W
| ¢ ! 1
3| 2 DATA- 4_‘_/ \——> RX- / \ RX-
3 NC Pl Tx+ oo Tx+
: P : bl
Display ! H ! Voo
7 NC ' o Tx- Voo Tx-
H bl \ -
5 GND(SG) — SG SG
4 ERA :| _T:_
8 CSA N
9 ERB :| oo
' Vo
6 CsB Voo
Shell I Y
NOTE I * The cable length must be 1000m or less.
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12G)

e 1:1 Connection

External Device side
RS-422/485

Display side ) Communication
Terminal block Shield Terminal block
. Signal name ! A Signal name]
Ter_mmatlop ! [
resustancigi RDA i :" I‘. Tx+
Pl Terminati
RDB 7 ! :'l ‘II Tx- reesrirsqgr?cgn
oA VAN R SN Ir=tvay [P RV
Display / \
SDB ™ RX
SG SG
ERA :|
CSA vl
' v
ERB :| f Vo
\ Vo
CSB Voo
* 1:n Connection
External Device side External Device side
) X RS-422/485 RS-422/485
DISP!ay side . Communication . Communication
Terminal block Shield Terminal block Shield Terminal block
o Signal name / A Signal name| S /' Signal name|
Termination ! [ ! foA
feS'S‘a”Ce‘g RDA P Tx+ oo Tx+
' I H ! ' _
RDB [ | i i} Tx- N Tx | reastanes”
! i 1l H ! '
SDA L A N HIEWAY ; AX+ 1202 12w
Display / '-‘/ \.\ !
SDB > RX- T V7 RX-
SG SG SG
ERA :| _I__
CSA ! ]
! Voo
ERB :| i Vo
! Vol
CSB [
\ v

*1 The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the
rear of the Display as shown in the table below.

DIP Switch No. Set Value
1 OFF
2 OFF
3 ON
4 ON
NOTE I * The cable length must be 1000m or less.
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12H)

e 1:1 Connection

External Device side

, ) RS-422/485
Display side Communication
D-sub 9 pin (plug) Shield Terminal block
oo Pin Signal name :‘/ ’,‘l “.‘ Signal name | Termination
1200 1/2W ! [
g 3 LINE() A T
8 LINE() [+—+ M= RX-
, 1 NC [ Tx+
Display i : i
2 NC ! P Tx-
' | |
5 | aND(sG) F———+— SG
4 RS(RTS) oo
6 | sv S
7 | e b
s v | i
Shell F6 —=  \/
* 1:n Connection
External Device side External Device side
. . RS-422/485 RS-422/485
Dlsplay_S|deI ) Communication ) Communication
D-sub 9 pin (plug) Shield Terminal block Shield Terminal block
Lesrirggﬁésn Pin Signal name /' ’,'l ‘\‘ Signal name ’," A ’.’I “.‘ Signal name L‘z@g‘ﬁg’"
1200 1/2W | [N ! IR
g 3 LINE(+) [« ; A — RX+ ,‘ / L RX4+ 1200 1/2W
8 LINE(-) 4—f/ M RX- o RX-
' H H H i 1
1 NC i o Tx+ i oo Tx+
Display i ! ! | \ :
2 NC ! oo - \ Vo Tx-
P VoA
5 | GND(SG) ———F— SG — SG
4 RS(RTS) N _l_
H | | =
6 5V [
[l H H
7 NC Voo
| Vool
s | no oL
Shell G —=  \/

IV[=lel=a/\\ill ¢« The 5V output (Pin #6) on the Display is the power for the Siemens AG’s PROFIBUS
connector. Do not use it for other devices.

NOTE * In COM on the GP-4107, the SG and FG terminals are isolated.
* The cable length must be 1000m or less.
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121)

1:1 Connection

Display side
Terminal block

External Device side

RS-422/485

. . Communication
Signal name Shield Terminal block
Terminati / X i
rouoei"|  TERM / / ‘\‘ Signal name
120Q 1/2W ! )
oat 5 RDA P Tx+
Display RDB [ -" n" :. Tx- Termination
= PN 1200 112W
. — +
= SDA i / ? i RX %
PFXZCBADTM1 SDB \ ".‘ ' RX-
1
SG T T H SG
\
FG  ——vV
b User-created cable g
1:n Connection
Display side External Device side External Device side
Terminal block RS-422/485 RS-422/485
) . Communication . Communication
Signal name Shield Terminal block Shield Terminal block
- ’ n , n
:;esri";t'gggg” TERM ','l ’,” \\‘ Signal name ','l ’,” \\‘ Signal name
! !
1200 ”2% RDA Pl Tx+ Pl Tx+
Display RDB e :-' :-' :. Tx- :" :" :- Tx- Termination
—= H N : H N : resistance
= SDA T —»  RX+ T T RX+ éoo 12w
PN ANE
PFXZCBADTM1 SbB \ ".‘ ! RX- \ "-‘ ! RX-
1 1
se ' s6 ' s6
Y Y l

\4

A

User-created cable

NOTE I

* The cable length must be 1000m or less.
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12J)

¢ 1:1 Connection

External Device side

RS-422/485

Communication
Terminal block

: Signal name | Termination
Display resistance
D1 RX+ 120Q 1/2W
DO
RX- %
+
PFXZLMCBRJR81 %
Tx-
GND
SG
¢ 1:n Connection
External Device side External Device side
Termination RS-422/485 RS-422/485
resistance Communication . Communication
2200 1/2W Terminal block Sth-"d" Terminal block
Di pi\ |Serdreme | 7 R | snatrame | iR
spay RX+ AL RX+  [2200 1/2W
! (!
RX- : / \,'\ ', RX- E
) )
Tx+ :g :, ,: Tx+
PFXZLMCBRJR81 | Voo
Tx- \ Vo Tx-
\ \ I,'
SG * = SG

NOTE I

+ The cable length must be 200m or less.
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12K)

¢ 1:1 Connection

External Device side

Display side Communication
D-sub 9 pin (socket) Shield Terminal block
L. ’ A
E;{Q{gﬁgg” Pin Signal name i A Signal name Ter.mti”aﬁo”
120Q 1/2W AL 100 1/2W
2 DATA+ [« + ——> RX+
]
3 1 DATA- <—-/ \——> RX- E
] ! H
. 3 NC P Tx+
Display ! ! !
7 NC E |: i TX'
5 GND — SG
H 1
4 NC A
| 1
8 NC b
H ' 1
9 NC oo
\ vl
6 NC Voo
\ Vo
Shell FG  —a  \/
¢ 1:n Connection
External Device side External Device side
) . RS-422/485 RS-422/485
Display side . Communication ) Communication
D-sub 9 pin (socket) Shle|dﬁ Terminal block Sh|e|d” Terminal block
;Esr%%ﬁg%: Pin Signal name ::' ‘,'l”“.‘ Signal name ':'I ",’I “\' Signal name ;rgsrir;‘tigﬁgg”
oo 5 2 | patar LA Rx+ LA RX+ ?QWW
] ' : :
1 DATA- 4—4/ \——> RX- (—+ iM—— RX-
] 1 H | ]
_ 3 NC oo Tx+ A Tx+
Display | ' ' \ \ H
) ]
7 NC ! b Tx- \ v Tx-
! H ' \ v
5 GND ——t— SG SG
' ! v s TTEEE
4 NC 5 5 _l__
8 NC oo
| H B
9 NC I
6 NC oo
\
Shell FG |—a 1/

NOTE I

* The cable length must be 1000m or less.
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513 Cable Diagram 13
Displa
p. v Cable Notes
(Connection Port)

GP3000 (COM1)
GP4000"! (COM1)
SP5000 (COM1/2)
ST (COMI) 13A User-created cable ;frh]eecszsable length must be 3m
LT3000 (COM1) '
IPC*?
PC/AT
GP-4105 (COM1)
GP-4115T (COM1) The cable length must be 3m
GP-4115T3 (COMI) 13B User-created cable or less.
LT-4*01TM (COM1) RJ45 RS-232C Cable (5m) by Pro-face
LT-Rear Module (COM1) | 13C PFXZLMCBRIR21 zrhfezsable length must be 3m

*1  All GP4000 models except GP-4100 series and GP-4203T

*2  Only the COM port which can communicate by RS-232C can be used.
m |[PC COM Port (page 8)

13A)

Display

Display side External Device side
D-sub 9 pin (socket) Shield RJ45 (plug)

Pin  |Signal name .'/ .’?“\ Pin Signal name
3 |sD(TXD) R RD(RXD)
2 |roErxD)le— 2 SD(TXD)
8 CS(CTS) |« 3 RS(RTS)
7 |RsRTS) |———+——> 6 | cs(cTs)
5 SG 8 SG
4 [erom)| LN/

6 |DR(DSR) _I -----
Shell FG

A

User-created cable

\ 4

GP-Pro EX Device/PLC Connection Manual

140




MODBUS SIO Master Driver

13B)
Display side External Device side
Terminal block Shield RJ45 (plug)
Signal name ’," .’/ ‘\‘ Pin Signal name
SD(TXD) 1 RD(RXD)
Display RD(RXD) [« 2 SD(TXD)
CS(CTS) |« : — 3 RS(RTS)
RS(RTS) — 6 | cs(cTs)
SG T —F 8 SG
ER(DTR)
DROSR) | . L
User-created cable
13C)
External Device side
RJ45 (plug)
Display 50 Pin Signal name
1 RD(RXD)
RXD 2 SD(TXD)
(1) 3 RS(RTS)
6 CS(CTS)
GND 8 SG
No. Name Notes
RJ45 RS-232C Cable (5m) by Pro-face
1) PFXZLMCBRIR21

IVI=lel=a\\ill| * VWhen using this connection, in the RS-232C communication settings set the
[Flow Control] to [None].
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5.14 Cable Diagram 14
Displa
p. v Cable Notes
(Connection Port)
. COM Port Conversion Adapter by Pro-face
GP3000 * (COMI) CA3-ADPCOM-01
AGP-3302B (COM2) +
GP-4*01TM (COMI) 14A Terminal Block Conversion Adapter by Pro-face The cable length
GP-Rear Module CA3-ADPTRM-01 must be 15m or
(COM1) + less.
*2
ST ~ (COM2) User-created cable
LT3000 (COM1)
14B User-created cable
Online Adapter by Pro-face
CA4-ADPONL-01
+
14C Terminal Block Conversion Adapter by Pro-face
CA3-ADPTRM-01 The cable 1
*3 e cable length
GP3000°* (COM2) + must be 15m or
User-created cable less.
Online Adapter by Pro-face
14D CA4-ADfONL-01
User-created cable
COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01
+
IPC*4 14E Terminal Block Conversion Adapter by Pro-face The cable length
CA3-ADPTRM-01 must be 15m or
+ less.
User-created cable
14F User-created cable
GP-4106 (COM1) The cable length
GP-4116T (COM1) 14G User-created cable must be 15m or
less.
GP-4107 (*(S:OMI) The cable length
GP-4*03T * (COM2) 14H User-created cable must be 15m or
GP-4203T (COM1) less
RS-422 Terminal Block Conversion Adapter by Pro-face
GP4000° (COM2) PFXZCBADTMI
*7
GP-4201T (COMI) 141 Elhe tc}i‘blf Slzlg;h
SP5000 (COM1/2) + ustbe 1omo
User-created cable less.
14B User-created cable
4%
II:;-;;;;L{X;SSMD RJ45 RS-485 Cable (5m) by Pro-face The cable length
14] PFXZLMCBRIJRS81 must be 15m or
(comi)
less.
PE-4000B" 14K User-created cabl Ilhe tCEbITSIrer? g;h
PS5000"8 ser-created cable ust be 0

less.
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*1 All GP3000 models except AGP-3302B
*2 All ST models except AST-3211A and AST-3302B
*3  All GP3000 models except GP-3200 series and AGP-3302B

*4  Only the COM port which can communicate by RS-422/485 (2 wire) can be used. (Except PE-4000B, PS5000)
m |[PC COM Port (page 8)

*5  Except GP-4203T
*6  All GP4000 models except GP-4100 series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T

*7  When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 14A.
*8  Only the COM port which can communicate by RS-422/485 (2 wire) can be used.
H |PC COM Port (page 8)

GP-Pro EX Device/PLC Connection Manual 143



MODBUS SIO Master Driver

14A)
e 1:1 Connection
Display side External Device side
Terminal block RJ45 (plug)
- Shield . .
Signal name Wit n Pin Signal name
RDA 4 D1
Dispiay CA3-ADPCOM-01 RDB 5 Do
Pay SDA 7 5Vdc
=
| = SDB 8 SG
/
CA3-ADPTRM-01 | TERMRX
SG
FG
D User-created cable g
e 1:n Connection
Display side External Device side External Device side
Terminal block ) RJ45 (plug) . RJ45 (plug)
Signal name ,E-h-'?-",i\ Pin Signal name ,—S-h-'fa-'fi\ Pin Signal name
RDA ; /\\ + 4 D1 - /\,\ 4 D1
Display CA3-ADPCOM-01 RDB 5 DO 5 DO
Pay soA  H |1 7 5Vdc I 7 5Vdc
[| = SDB P A 8 G s 8 SG
CA3-ADPTRM-01 | TERMRX f L
SG N
——
6 —1

\4

A

User-created cable

[VI=le>3\\il| * Do not connect the cable to the 5 Vdc pin on the External Device.
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14B)

e 1:1 Connection

Display side External Device side
D-sub 9 pin (socket) RJ45 (plug)
Pin Signal name /_S_bi_gljfi\ Pin Signal name
1 RDA |« '," s 4 D1
2 RDB ety / \——> 5 DO
Display 3 sbA | 7 5Vdc
7 SDB ;/— 8 SG
5 SG
| SR v
4 ERA —
8 CSA <+—
9 ERB —
6 CSB <«
Shell FG
* 1:n Connection
Display side External Device side External Device side
D-sub 9 pin (socket) RJ45 (plug) RJ45 (plug)
Pin Signal name I,—S-hi-qlf,jr\ Pin Signal name /§-h-i?-k,j . Pin Signal name
1 RDA  |e4—+ AL L D1 ’,." i ‘\‘ p o
2 RDB </\——> 5 DO /\ 5 DO
Display 3 DA ﬂ = svdc 7 5Vdc
7 SDB b 8 SG i 8 G
5 sG f I
4 ERA | -
8 CSA 4_—|
9 ERB
6 CSB 4_—|
Shell FG

1\V=lel>ar\\ill © Do not connect the cable to the 5 Vdc pin on the External Device.
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14C)
e 1:1 Connection
Display side External Device side
Terminal block RJ45 (plug)
- Shield . .
Signal name Pin Signal name
RDA 4 D1
Display CA4-ADPONL-O1 RDB 5 Do
Pay SDA 7 5Vdc
=
| = SDB 8 SG
/
CA3-ADPTRM-01 | TERMRX
SG
FG
D User-created cable g
e 1:n Connection
Display side External Device side External Device side
Terminal block ) RJ45 (plug) ) RJ45 (plug)
Signal name /§b_l§lcli“ Pin Signal name /§_h_|_e_lt7:|'\ Pin Signal name
RDA - /\\ + 4 D1 - /\,\ 4 D1
Dispay CA4-ADPONL01 | RDB S Do 5 DO
pay [I__/D soA  H[i 7 5Vdc I T 7 5Vdc
— \ \ ! \ v
[| = SDB ' Y 8 SG 8 SG
CA3-ADPTRM-01 | TERMRX f -L
SG Y
_____ LY
6 |—

A
\4

User-created cable

[VI=lel>3/\\il *© Do not connect the cable to the 5 Vdc pin on the External Device.
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14D)
e 1:1 Connection
Display side
D-sub 9 pin (plug) External Device side
Pin Signal name RJ45 (plug)
Shield . .
1 TERMRX ST Pin Signal name
2 RDA LA 4 D1
Display ! / }\ \
7 RDB > P 5 DO
3 SDA  H|i b 7 5Vdc
] H 1
i v
CA4-ADPONL-01| 2 SDB RV 8 SG
9 TERMTX VoA
5 SG VAR
Shell FG —T
b User-created cable "
* 1:n Connection
Display-side
D-sub 25 pin (plug) External Device side External Device side
Pin Signal name . RJ45 (plug) ) RJ45 (plug)
1 TERMRX ’,-s-blgl-,d\ Pin Signal name ,5‘-'1'-9-'% Pin Signal name
2 RDA LA 4 D1 LN 4 D1
Display . RDB N / Y\ \ 5 Do H / \ : 5 DO
ﬂ;_l] 3 SDA ﬂ 7 5Vdc 7 5Vdc
CAd-ADPONL.O1 8 SDB L 8 SG Y] 8 SG
9 TERMTX VA I
5 sG kY h
Shell FG T

User-created cable

I\V=lel=ar\\ill © Do not connect the cable to the 5 Vdc pin on the External Device.
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Display

1:1 Connection

Display

1:n Connection

CA3-ADPCOM-01

=

CA3-ADPTRM-01

{1

MODBUS SIO Master Driver

Display side External Device side
Terminal block RJ45 (plug)
- Shield ) .
Signal name Pt i Pin Signal name
RDA 4 D1
CA3-ADPCOM-01 |__RDB 5 DO
SDA 7 5Vdc
=
, =3 SDB 8 SG
/
CA3-ADPTRM-01 | TERMRX
SG
FG
D User-created cable g
Display side External Device side External Device side
Terminal block ) RJ45 (plug) ) RJ45 (plug)
Signal name ;-S-hl-e-l,d‘ Pin Signal name /-S-hl-ql;q\ Pin Signal name
RDA - /\\ + 4 D1 - /\,\ 4 D1
RDB 5 DO i 5 DO
SDA oo 7 5Vdc Voot 7 5Vdc
SDB RS 8 sG St 8 SG
TERMRX f I
sG Y i
_____ LY
6 |—

\4

A

User-created cable

IV[>lel=ar\\ill *+ Do not connect the cable to the 5 Vdc pin on the External Device.
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14F)

e 1:1 Connection

Display side External Device side
D-sub 9 pin (socket) RJ45 (plug)
. i Shield - -
Pin Signal name s Pin Signal name
1 DATA+ [e——FA\——> 4 D1
] i 1
2 DATA- 4—‘J \——> 5 DO
Displ : b
iSpiay 3 NC P 7 5Vdc
7 NC —/—— 8 SG
5 SG Y
| SRR v
4 ERA
8 CSA 4_—|
9 ERB :I
6 CSB
Shell FG
* 1:n Connection
Display side External Device side External Device side
D-sub 9 pin (socket) ) RJ45 (plug) RJ45 (plug)
Pin Signal name S_hl_gl_d_l'\‘ Pin Signal name Pin Signal name
1 DATA+  [¢——A\—% 4 D1 £ 4 D1
2 DATA- <—~—/ A 5 DO \ 5 DO
Display 3 NC oo 7 5vdc oo 7 5vdc
7 NC _/—‘— 8 G it 8 SG
5 SG YV I
4 ERA B
[ osn
9 ERB
6 CSB 4_—|
Shell FG

1\V=lel=ar\Mill © Do not connect the cable to the 5 Vdc pin on the External Device.
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14G)
* 1:1 Connection
Display side External Device side
Terminal block . RJ45 (plug)
Signal name ,,-SHI?-'?»\ Pin Signal name
RDA [« '," ——» 4 D1
| RDB [efti / \—> 5 DO
Display sbA i1 7 5Vdc
SDB —_/—— 8 sG
ERA | j__
CSA —
ERB —
CSB «—
* 1 Connection
Display side External Device side External Device side
Terminal block RJ45 (plug) RJ45 (plug)
Signal name ,,S-hi-e-lg-,»\ Pin Signal name I§_h_i_e_|(_1?\ Pin Signal name
ROA  |eq— A 4 D1 A 4 D1
RDB </ 5 DO .'/\ 5 Do
Display SDA —J 7 5Vdc 7 5Vdc
sDB —/— 8 SG 8 SG
SG I
ERA  |— j__ -
CSA 4——| )
ERB
CSB 4——|

1V[>lel=ar\\ill «+ Do not connect the cable to the 5 Vdc pin on the External Device.
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14H)
* 1:1 Connection
Display side External Device side
D-sub 9 pin (socket) RJ45 (plug)
. i Shield ) -
Pin Signal name ST Pin Signal name
1 ,I ‘\
3 LINE+ [e——F/Y——> 4 D1
PN
8 LINE- — 5 DO
Displa | b
Pay 1 NC P 7 5Vdc
\ \ H
2 NC _‘.‘-/\/—’,t— 8 SG
I‘ \ 1
5 SG . ‘\\ ,'I
| SEETTE v
4 RS
6 5V
7 NC
9 NC
Shell FG
* 1:n Connection
Display side External Device side External Device side
D-sub 9 pin (socket) Shield RJ45 (plug) Shield RJ45 (plug)
Pin Signal name I,----Ig-,»\‘ Pin Signal name /---I-e-;n\ Pin Signal name
3 LNE+ A 4 D1 f //\,"\ 3 4 D1
8 LINE- <—~—/ N 5 DO i 5 Do
Display 1 NC oo 7 5Vdc I S 7 5Vdc
2 NG f 8 SG A 8 SG
5 SG N I
| S =
4 RS
6 5V
7 NC
9 NC
Shell FG

IVIlel=ar\\ill «+ The 5V output (Pin #6) on the Display is the power for the Siemens AG’s PROFIBUS
connector. Do not use it for other devices.

* Do not connect the cable to the 5 Vdc pin on the External Device.

NOTE I ¢ In COM on the GP-4107, the SG and FG terminals are isolated.
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Display

1:1 Connection

MODBUS SIO Master Driver

Display side External Device side
Terminal block RJ45 (plug)
Shield
Signal name Pin Signal name
RDA 4 D1
RDB 5 DO
Displa
Pay SDA 7 5Vdc
=
| = SDB 8 SG
/
PFXzCBADTM1|_TERMRX
SG
FG
D User-created cable g
1:n Connection
Display side External Device side External Device side
Terminal block ) RJ45 (plug) ) RJ45 (plug)
Signal name ;-S-rll?-l?\ Pin Signal name /-S-hl-e-l;('j\ Pin Signal name
RDA ; /\\ : 4 D1 £ /\\ 4 D1
RDB 5 DO i 5 DO
SDA j P 7 5vdc Voo 7 5Vdc
= sDB R 8 SG A 8 SG
PFXZCBADTM1| TERMRX f _L
SG RV
_____ LY
6 —1T

v

A

User-created cable

[\V=lel=ar\\ill © Do not connect the cable to the 5 Vdc pin on the External Device.
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14J)

e 1:1 Connection

External Device side

RJ45 (plug)
. Pin Signal name
Display D1
4 D1
DO
5 DO
) 7 5Vdc
GND 8 sG
* 1:n Connection
External Device side External Device side
RJ45 (plug) RJ45 (plug)
hield
) Pin Signal name ,/§--I?-7\ Pin Signal name
DlSpIay D1 / /N
4 D1 ? / 1’\ ¥ 4 D1
D 5 DO : : 5 DO
M 7 5Vdc I S 7 5Vdc
GND 8 SG — 8 SG
No. Name Notes

RJ45 RS-485 Cable (5m) by Pro-face
(1) PFXZLMCBRIJRS81

IV[2lel=ar\\ill + Do not connect the cable to the 5 Vdc pin on the External Device.
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Display

1:1 Connection

MODBUS SIO Master Driver

Display side External Device side
D-sub 9 pin (socket) RJ45 (plug)
. i Shield ) -
Pin Signal name s Pin Signal name
1 ,I ‘\
2 DATA+ |[&——FY—r—» 4 D1
] i 1
1 DATA- 4_.J \——> 5 DO
Displa ; b
Py 3 NC P 7 5Vdc
\ H H
7 NC —/—— 8 SG
\ \ 1
5 GND N
B -mmmav
4 NC
8 NC
9 NC
6 NC
Shell FG
1:n Connection
Display side External Device side External Device side
D-sub 9 pin (socket) Shield RJ45 (plug) Shield RJ45 (plug)
Pin Signal name ,---I-e--,»\ Pin Signal name /---I?-;«‘ Pin Signal name
2 DATA+ — AN 4 D1 a /\,\ 5 4 D1
1 DATA- : Y\——r 5 DO N 5 DO
3 NC oo 7 5Vdc R T 7 5Vdc
7 NC _lll“/“/_"‘l_ 8 SG ‘\\ “\\ Il" 8 SG
5 GND v I
.Y L
4 NC
8 NC
9 NC
6 NC
Shell FG

[YI=lel>3/\\il °© Do not connect the cable to the 5 Vdc pin on the External Device.
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5.15 Cable Diagram 15
Displa
p. v Cable Notes
(Connection Port)
. COM Port Conversion Adapter by Pro-face
GP3000 ° (COM1) CA3-ADPCOM-01
AGP-3302B (COM2) +
GP-4*01TM (COMI) 15A Terminal Block Conversion Adapter by Pro-face The cable length
GP-Rear Module CA3-ADPTRM-01 must be 15m or
(COM1) + less.
*2
ST~ (COM2) User-created cable
LT3000 (COM1)
15B User-created cable
Online Adapter by Pro-face
CA4-ADPONL-01
+
15C Terminal Block Conversion Adapter by Pro-face
CA3-ADPTRM-01 The cable 1
3 e cable length
GP3000 ~ (COM2) + must be 15m or
User-created cable less.
Online Adapter by Pro-face
15D CA4-ADfONL-01
User-created cable
COM Port Conversion Adapter by Pro-face
CA3-ADPCOM-01
+
IPC*4 15E Terminal Block Conversion Adapter by Pro-face The cable length
CA3-ADPTRM-01 must be 15m or
+ less.
User-created cable
1SF User-created cable
GP-4106 (COM1) The cable length
GP-4116T (COM1) 15G User-created cable must be 15m or
less.
GP-4107 (*(S:OMI) The cable length
GP-4*03T * (COM2) 15SH User-created cable must be 15m or
GP-4203T (COM1) less
RS-422 Terminal Block Conversion Adapter by Pro-face
GP4000° (COM2) PFXZCBADTMI
*7
GP-4201T (COM1) 151 ;he tcsblfslzlgih
SP5000 (COM1/2) + ust be 1om o
User-created cable less.
15B User-created cable
4%
II:;-;;;;L{X;SSMD RJ45 RS-485 Cable (5m) by Pro-face The cable length
15J PFXZLMCBRIJRS1 must be 15m or
(comi)
less.
PE-4000B™* 15K User-created cabl Ilhe tCEbITSIrer? g;h
PS5000"8 ser-created cable ust be 0

less.
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*1 All GP3000 models except AGP-3302B
*2 All ST models except AST-3211A and AST-3302B
*3  All GP3000 models except GP-3200 series and AGP-3302B

*4  Only the COM port which can communicate by RS-422/485 (2 wire) can be used. (Except PE-4000B, PS5000)
m |[PC COM Port (page 8)

*5  Except GP-4203T
*6  All GP4000 models except GP-4100 series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T

*7  When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 15A.
*8  Only the COM port which can communicate by RS-422/485 (2 wire) can be used.
H |PC COM Port (page 8)
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15A)
e 1:1 Connection
Display side External Device side
Terminal block RJ45 (plug)
- Shield . .
Signal name P iy Pin Signal name
RDA 4 D1
Display CAS-ADPCOM-01 RDB 5 Do
Pay SDA 7 NC
=
| = SDB 8 SG
/
CA3-ADPTRM-01 | TERMRX
SG
FG
D User-created cable g
e 1:n Connection
Display side External Device side External Device side
Terminal block ) RJ45 (plug) . RJ45 (plug)
Signal name ;-S-hl-e-l,g\ Pin Signal name /-S-hl-ql;q\ Pin Signal name
RDA - /\\ + 4 D1 - /\,\ 4 D1
Dicojay CA3-ADPCOM-01 RDB S Do > Do
Py soA  H[i 7 NC I T 7 NC
[| = SDB 8 SG s 8 G
CA3-ADPTRM-01 | TERMRX f -L
SG Y
_____ LY
FG I

\4

A

User-created cable

GP-Pro EX Device/PLC Connection Manual 15_7



15B)

Display

1:1 Connection

MODBUS SIO Master Driver

Display side External Device side
D-sub 9 pin (socket) RJ45 (plug)
. i Shield ) -
Pin Signal name ST Pin Signal name
1 RDA |le——A—+» 4 D1
AN
2 RDB [~ i\ 5 DO
Displ ' b
iSpiay 3 sbA i1 7 NC
7 SDB ;/— 8 SG
5 SG Y
| SRR v
4 ERA —
8 CSA <+—
9 ERB —
6 CSB <«
Shell FG
1:n Connection
Display side External Device side External Device side
D-sub 9 pin (socket) ) RJ45 (plug) ) RJ45 (plug)
Pin Signal name §b_|<_a|_l<3\ Pin Signal name ; -S-hl-ql;('j\ Pin Signal name
. AL .V
1 RDA - Y 4 D1 1 ¥ 4 D1
2 RDB__[efys / \—-—> 5 DO / \ 5 DO
3 SDA ﬂ b 7 NC oo 7 NC
7 SDB f 8 SG L . 8 sG
5 SG vV I
4 ERA B
s [ osn o
9 ERB
6 CSB 4_—|
Shell FG
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15C)
e 1:1 Connection
Display side External Device side
Terminal block RJ45 (plug)
- Shield . }
Signal name Pin Signal name
RDA 4 D1
Dispiay CA4-ADPONL-O1 RDB 5 Do
Pay SDA 7 NC
=
| = SDB 8 SG
/
CA3-ADPTRM-01 | TERMRX
SG
FG
D User-created cable g
e 1:n Connection
Display side External Device side External Device side
Terminal block ) RJ45 (plug) ) RJ45 (plug)
Signal name ,/-S-'l'-e-'f-i‘ Pin Signal name /-S-hl-e-l;q\ Pin Signal name
RDA - /\\ + 4 D1 - /\,\ 4 D1
Dispjay CA4-ADPONL01 | OB 5 Do S Do
SPay sbA  H|b i 7 NC I T 7 NC
[I = SDB 8 SG s 8 SG
CA3-ADPTRM-01 | TERMRX f -L
SG ‘\ “\ II’
_____ LY
FG I

\4

A

User-created cable
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15D)
e 1:1 Connection

Display side
D-sub 9 pin (socket)

External Device side
Pin Signal name RJ45 (plug)
Shield . .
1 TERMRX ST Pin Signal name
2 RDA 4 D1
Display 7 RDB 5 DO
3 SDA 7 NC
CA4-ADPONL-01 8 SDB 8 SG
9 TERMTX
5 SG \
Shell FG —T

A

v

User-created cable

* 1:n Connection

Display side
D-sub 9 pin (sockef) External Device side External Device side
Pin Signal name RJ45 (plug) RJ45 (plug)
Shield Shield
1 TERMRX ’,""I?-,\ Pin Signal name /---I-e-y\ Pin Signal name
2 RDA LA 4 D1 LA 4 D1
Display . RDB i/ \ \ 5 Do : / \ : 5 DO
. b
3 SDA ﬂ: . 7 NC | v 7 NC
H Voo \ Vo
CA4-ADPONL-01 8 SbB RV 8 S6 DAY 8 SG
9 TERMTX VA I
5 SG Y h
Shell FG —T

User-created cable
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15E)
e 1:1 Connection
Display side External Device side
Terminal block RJ45 (plug)
- Shield ) .
Signal name P sy Pin Signal name
RDA 4 D1
Dispjay CA3-ADPCOM-01 RDB 5 DO
Pay SDA 7 NC
=
= SDB 8 SG
/
CA3-ADPTRM-01 | TERMRX
SG
FG
D User-created cable g
e 1:n Connection
Display side External Device side External Device side
Terminal block ) RJ45 (plug) ] RJ45 (plug)
Signal name ,/§-h-'91‘,i‘ Pin Signal name /-SHI?-I?A\ Pin Signal name
RDA - /\\ + 4 D1 - /\,\ 4 D1
Dicojay CA3-ADPCOM-01 RDB S Do > Do
Py SDA . 7 NC I S 7 NC
[| = SDB 8 SG s 8 G
CA3-ADPTRM-01 | TERMRX f -L
SG Y
_____ LY
FG —

A
\4

User-created cable

GP-Pro EX Device/PLC Connection Manual 161



15F)

Display

1:1 Connection

MODBUS SIO Master Driver

Display side External Device side
D-sub 9 pin (socket) RJ45 (plug)
. i Shield ) -
Pin Signal name s Pin Signal name
1 DATA+ [e——FA\——> 4 D1
] i 1
2 DATA- 4_.J \——> 5 DO
Displa i oo
iSpiay 3 NC P 7 NC
7 NC —/—— 8 SG
5 SG Y
| SRR v
4 ERA
8 CSA 4_—|
9 ERB :I
6 CSB
Shell FG
1:n Connection
Display side External Device side External Device side
D-sub 9 pin (socket) ) RJ45 (plug) ) RJ45 (plug)
Pin Signal name /§[1_I§|_lq\ Pin Signal name ; -S-hl-e-l;q\ Pin Signal name
 DNSN AW,V
1 DATA+  [¢— Y 4 D1 1 ¥ 4 D1
2 DATA- <—~—/ AN 5 DO / \ 5 Do
3 NC oo 7 NC oo 7 NC
7 NG f 8 SG A 8 SG
5 SG N I
4 ERA h
[ osn ]
9 ERB
6 csB 4_—|
Shell FG
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15G)

e 1:1 Connection

Display side External Device side
Terminal block . RJ45 (plug)
Signal name ,,-S-bl-ql%‘ Pin Signal name
RDA [« '," ——» 4 D1
| RDB [efti / \—> 5 DO
Display sbA i 7 NC
SDB —_/—— 8 sG
SG : i
ERA  |— j__
CSA —
ERB —
CSB «—
* 1 Connection
Display side External Device side External Device side
Terminal block RJ45 (plug) RJ45 (plug)
Signal name I,-S-bigl-,q\ Pin Signal name /-S-r-]i-e-j;-\ Pin Signal name
ROA  |le—A— 4 D1 LA 4 D1
RDB </ 5 DO :/\ 5 DO
Display SDA —J 7 NC 7 NC
SDB —/— 8 SG 8 SG
ERA  — j__ -
CSA 4——| )
ERB
CSB 4——|
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15H)
e 1:1 Connection
Display side External Device side
D-sub 9 pin (socket) RJ45 (plug)
, ) Shield ) -
Pin Signal name ST Pin Signal name
VNA
3 LINE+ [&— 1 ‘l > 4 D1
] h 1
8 LINE- 4_.J \——> 5 DO
Displa : Voo
pay 1 NC Lo 7 NC
\ ! !
2 NC _/_._ 8 SG
\ 1
5 SG N
(W4
| "
4 RS
6 5V
7 NC
9 NC
Shell FG
* 1:n Connection
Display side External Device side External Device side
D-sub 9 pin (socket) Sh RJ45 (plug) Sh RJ45 (plug)
Pin Signal name /__Dl?'_lq\ Pin Signal name /-—hl-elllg\ Pin Signal name
3 LINE+ |[e—F /\ > 4 D1 /\,\ y 4 D1
8 LINE- <—J\—> 5 DO A 5 DO
Dicplay 1 NC P 7 NC v 7 NC
5 SG Vi I
| TEEEE =
4 RS
6 5V
7 NC
9 NC
Shell FG

IV[=lel=a/\\il ¢« The 5V output (Pin #6) on the Display is the power for the Siemens AG’s PROFIBUS
connector. Do not use it for other devices.

NOTE I e In COM on the GP-4107, the SG and FG terminals are isolated.
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151)
e 1:1 Connection
Display side External Device side
Terminal block RJ45 (plug)
- Shield ) .
Signal name P e A Pin Signal name
RDA 4 D1
RDB 5 DO
Displa
Pay SDA 7 NC
=
| = SDB 8 SG
/
PFXzCBADTM1|_TERMRX
SG
FG
D User-created cable g
* 1:n Connection
Display side External Device side External Device side
Terminal block ) RJ45 (plug) ) RJ45 (plug)
Signal name ;-S-hl-e-lfvj\ Pin Signal name /-S-hl-e-l;?\ Pin Signal name
RDA ; /\\ . 4 D1 £ /\\ 4 D1
RDB 5 DO 5 Do
Display soa H|i i 7 NG I 7 NG
= sDB b 8 sG it 8 sG
PFXzCBADTM1 | TERMRX f _L
SG Y
_____ LY
6 —

A

v

User-created cable
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15J)

e 1:1 Connection

External Device side

RJ45 (plug)
Pin Signal name
Display D1 9
4 D1
DO

5 DO

(1) 7 NC

GND 8 SG

* 1:n Connection
External Device side External Device side
RJ45 (plug) RJ45 (plug)
Shield
. Pin Signal name /---Le-;\ Pin Signal name
Display D1 .V
4 D1 0 / ,’\ ¥ 4 D1
=0 5 DO i 5 DO
M 7 NC Voo 7 NC
GND 8 SG 8 SG
I----y
No. Name Notes
RJ45 RS-485 Cable (5m) by Pro-face
(1) PFXZLMCBRIJRS81
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15K)

e 1:1 Connection

Display side External Device side
D-sub 9 pin (socket) RJ45 (plug)
. i Shield ) -
Pin Signal name s Pin Signal name
1 ,I ‘\
2 DATA+ |[&——FY—r—» 4 D1
f /N
1 DATA- — 5 DO
Displa | b
Pay 3 NC P 7 NC
\ \ H
7 NC _‘.‘-/\/—’,t— 8 SG
I‘ \ 1
5 GND ‘,,,____\‘;,"I
4 NC
8 NC
9 NC
6 NC
Shell FG
* 1:n Connection
Display side External Device side External Device side
D-sub 9 pin (socket) Shield RJ45 (plug) Shield RJ45 (plug)
Pin Signal name I,----"-e-, \ Pin Signal name ; ___|_e_7\‘ Pin Signal name
2 DATA+  |[e——A—— 4 D1 £ /\\ 4 D1
1 DATA- <—~—/ N 5 Do i 5 DO
Display 3 NC oo 7 NC I S 7 NC
7 NG f 8 SG A 8 SG
5 GND “,,____“:, _L
4 NC
8 NC
9 NC
6 NC
Shell FG
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5.16 Cable Diagram 16
Displa
p. v Cable Notes
(Connection Port)

GP3000 (COM1)
GP4000"! (COM1) User-created cable
SP5000 (COM1/2)
ST (COMI) 16A . ;frh]eecszsable length must be 3m
LT3000 (COM1) Cartridges TMC2SL1 or TMC2CONVO1 '
IPC*? by Schneider Electric
PC/AT
GP-4105 (COM1) User-created cable
GP-4115T (COM1) 16B + The cable length must be 3m
GP-4115T3 (COM1) Cartridges TMC2SL1 or TMC2CONVO01 or less.

by Schneider Electric

RJ45 RS-232C Cable (5m) by Pro-face
LT-4*01TM (COM1) PRAZMEBRIR The cable length must be 3m
LT-Rear Module (COM1) 16C &
+ or less.
Cartridges TMC2SL1 or TMC2CONVO1
by Schneider Electric

*1  All GP4000 models except GP-4100 series and GP-4203T

*2  Only the COM port which can communicate by RS-232C can be used.
m |PC COM Port (page 8)

16A)

Display

Display side External Device side
D-sub 9 pin (socket) §_h_l?1<1\ Terminal block
Pin  [Signal name .'/ .’/ ‘\‘ Signal name
3 |spxp) —F—— RD(RXD)
2 |RD(RXD)|« TD(TXD)
7__|RSRIS)[— i | GND
8 |cs(cTs) [+ |
5 | s L
4 ER(DTR) ,
6 |DR(DSR) _[ -----
Shell FG
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16B)
Display side . External Device side
Terminal block §_h_|_e1(1\ Terminal block
Signal name / .’/ ‘\‘ Signal name
SD(TXD) s RD(RXD)
h ] ]
. RD(RXD) — TD(TXD)
Display i i i
RS(RTS) e GND
! ] i
CS(CTS) VoA
= AN
ER(DTR) \ A/
..... ¥
DR(DSR) ’
Shell
16C)
External Device side
Terminal block
Display Signal name
TXD
RD(RXD)
RXD
TD(TXD)
(1) GND GND
No. Name Notes
RJ45 RS-232C Cable (5m) by Pro-face
1) PFXZLMCBRIR21

IVI=lel2aV\\ill| * VWhen using this connection, in the RS-232C communication settings set the
[Flow Control] to [None].
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Display
(Connection Port)

Cable

Notes

GP3000"! (COM1)
AGP-3302B (COM2)
GP-4*01TM (COM1)
GP-Rear Module
(COM1)

ST*2 (COM2)
LT3000 (COM1)

17A

COM Port Conversion Adapter by Pro-face

CA3-ADPCOM-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable
+

Cartridges TMC2SL1 or TMC2CONVO01
by Schneider Electric

17B

User-created cable
+
Cartridges TMC2SL1 or TMC2CONVO01
by Schneider Electric

The cable length
must be 15m or
less.

GP3000"3 (COM2)

17C

Online Adapter by Pro-face

CA4-ADPONL-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable
+

Cartridges TMC2SL1 or TMC2CONVO01
by Schneider Electric

17D

Online Adapter by Pro-face
CA4-ADPONL-01
+
User-created cable
+
Cartridges TMC2SL1 or TMC2CONVO01
by Schneider Electric

The cable length
must be 15m or
less.

PC™

17E

COM Port Conversion Adapter by Pro-face

CA3-ADPCOM-01

+
Terminal Block Conversion Adapter by Pro-face

CA3-ADPTRM-01
+

User-created cable
+

Cartridges TMC2SL1 or TMC2CONVO01
by Schneider Electric

17F

User-created cable
+
Cartridges TMC2SL1 or TMC2CONVO01
by Schneider Electric

The cable length
must be 15m or
less.

GP-4106 (COM1)
GP-4116T (COM1)

17G

User-created cable
+

Cartridges TMC2SL1 or TMC2CONVO01
by Schneider Electric

The cable length
must be 15m or
less.
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Displa
Q y Cable Notes
(Connection Port)
GP-4107 (COM1) User-created cable The cable length

GP-4*03T" (COM2)

+

GP-4203T (COM1) 171 Cartridges TMC2SL1 or TMC2CONVO1 {2;‘? be 15m or
by Schneider Electric ’
RS-422 Terminal Block Conversion Adapter by Pro-face
PFXZCBADTM1
*7
171 -
GP4000*® (COM2) User-created cable he cable lonath
The cable lengt
GP-4201T (COM1) ' + e L5 ir
SP5000 (COM1/2) Cartridges TMC2SL1 or TMC2CONVO01
by Schneider Electric less.
User-created cable
17B "
Cartridges TMC2SL1 or TMC2CONVO01
by Schneider Electric
RJ45 RS-485 Cable (5m) by Pro-face
LT-4*01TM (COM1) PFXZLMCBRIJRS1
Taodie |
(CoOM1) + less
Cartridges TMC2SL1 or TMC2CONVO01 '
by Schneider Electric
User-created cable The cable length
PE-4000B™8 +
PS5000"8 17K Cartridges TMC2SL1 or TMC2CONVO1 must be 15m or

by Schneider Electric

less.

*1 All GP3000 models except AGP-3302B

*2 All ST models except AST-3211A and AST-3302B

*3  All GP3000 models except GP-3200 series and AGP-3302B
*4  Only the COM port which can communicate by RS-422/485 (2 wire) can be used. (Except PE-4000B, PS5000)

m |PC COM Port (page 8)
*5  Except GP-4203T

*6  All GP4000 models except GP-4100 series, GP-4*01TM, GP-Rear Module, GP-4201T and GP-4*03T

*7  When using a Terminal Block Conversion Adapter (CA3-ADPTRM-01) instead of the RS-422 Terminal Block
Conversion Adapter, refer to Cable Diagram 17A.

*8  Only the COM port which can communicate by RS-422/485 (2 wire) can be used.

m |PC COM Port (page 8)
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17A)
e 1:1 Connection
Display side External Device side
Terminal block Terminal block
. Shield -
Signal name Py i Signal name
RDA AL D1 Termination
resistance
Display CAS-ADPCOM-01 RDB Do 120Q 1/2W
Pay SDA GND
=
[ = SDB
/
CA3-ADPTRM-01 | TERMRX
SG
FG
) User-created cable g
* 1:n Connection
Display side External Device side External Device side
Terminal block Terminal block . Terminal block
Signal name Signal name /,'-S-rll-e-l,g\ Signal name
/ R Termination
RDA D1 .,' / ‘,’\ i D1 resistance
Ciaojay CAB-ADPCOM-O1 RDB DO i DO 120Q 1/2W
pay SDA GND —— GND
= SDB l'

CA3-ADPTRM-01 | TERMRX
SG

FG

A
v

User-created cable
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17B)
* 1:1 Connection
Display side External Device side
D-sub 9 pin (socket) Terminal block
. . Shield )
Pin  [Signal name Py ™ Signal name
1 [ Y i .
1 RDA |es—+ /\," — D1 Termination
/ / N ) % resistance
2 RDB 7 ] DO 120Q 1/2W
Displa ' !
Pay 3 SDA i GND
1
7 SDB '
)
)
5 SG
4 ERA
8 CSA
9 ERB —
6 CSB <«
Shell FG
* 1:n Connection
Display side External Device side External Device side
D-sub 9 pin (socket) Terminal block ) Terminal block
Pin Signal name Signal name /,'-S-hl-e-l,g\ Signal name
ki /\’,’ \ Terminati
1 RDA D1 7 ‘ D1 ermination
i / ,?\ | %resistance
2 RDB DO ¥ Lt Y 120Q 1/2W
Display 3 SDA GND — GND
7 SDB l'
5 SG =
4 ERA
8 CSA
9 ERB
6 CSB
Shell FG
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17C)
e 1:1 Connection
Display side External Device side
Terminal block Terminal block
. Shield -
Signal name Py ™ Signal name
RDA D1 Termlnatlon
resistance
Disola CA4-ADPONL-01 RDB DO 120Q 1/2W
Pay SDA GND
=
| = SDB
/
CA3-ADPTRM-01 | TERMRX
SG
FG
) User-created cable g
e 1:n Connection
Display side External Device side External Device side
Terminal block Terminal block Terminal block
- Shield - Shield :
Signal name Py Y Signal name ST Signal name
— !\ D1 "/ Al “‘ D1 Termination
: / ‘.\ ': resistance
Diaojay CA4-ADPONLO RDB DO i DO 1200 1/2W
pay SDA GND ——— GND
= SDB l'

CA3-ADPTRM-01 | TERMRX
SG

FG

A

v

User-created cable
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17D)

e 1:1 Connection

Display side
D-sub 9 pin (plug)

External Device side
Pin Signal name Terminal block
1 TERMRX Signal name
2 RDA D1 Termination
Displa resistance
play 7 RDB DO 120Q 1/2W
3 SDA GND
8 SDB
CA4-ADPONL-01
9 TERMRX
5 SG
Shell FG
User-created cable
* 1:n Connection
Display side
D-sub 9 pin (plug) External Device side External Device side
Pin Signal name Terminal block Terminal block
Shield
1 TERMRX Signal name /,'---I-e-,v\ Signal name
2 RDA D1 ,” / “ D1 Termination
. | N resistance
Display 7 RDB DO ; / é\ t DO 120Q 1/2W
3 SDA GND S GND
8 sbB l'
CA4-ADPONL-01 L
9 TERMRX =
5 SG
Shell FG
- User-created cable g
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17E)
e 1:1 Connection
Display side External Device side
Terminal block Terminal block
) Shield -
Signal name Py ™ Signal name
RDA D1 Termination
resistance
. CA3-ADPCOM-01 | __RPB DO 120Q 1/2W
Display SDA GND
[lj] M= SDB

/
CA3-ADPTRM-01 | TERMRX
SG
FG

A

\ 4

User-created cable

* 1:n Connection

Display side

External Device side
Terminal block

External Device side
Terminal block

Terminal block

Shield
Signal name Signal name /___l_e_;\ Signal name

RDA D1 N “‘ D1 Termination

! / ‘?\ | %resistance

__ cAs-ADPCOM-01 | DB Do i DO 1200 1/2W

Display SDA GND |“ .“ / GND

— \ \/
= SDB I---.\,

CA3-ADPTRM-01 | TERMRX
sG
FG

A

v

User-created cable
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17F)
e 1:1 Connection
Display side External Device side
D-sub 9 pin (socket) Terminal block
. . Shield -
Pin Signal name Py ™ Signal name
1 1
1 DATA+ |e—& /\I’ \ > D1 Termination
VAR W resistance
2 DATA- ; ] DO 120Q 1/2W
Displa !
Pay 3 NC GND
7 NC
5 SG
4 ERA
8 CSA
9 ERB
6 CSB
Shell FG
e 1:n Connection
Display side External Device side External Device side
D-sub 9 pin (socket) Terminal block Terminal block
’ ) Shield ; Shield -
Pin Signal name P ey Signal name ST Signal name
] DATA+ |e—i /\',' LN D1 N "‘ D1 Termination
fSON | / ‘?\ | resistance
2 DATA- : ;' ] DO + ! ,: DO 120Q 1/2W
Display 3 NC E E ; GND I“ |“ I',’ GND
7 NC A _T_’
5 SG — 4 =
4 ERA IRV
»omens v
8 CSA 4_—|
9 ERB
[ oss |
Shell FG
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e 1:1 Connection

MODBUS SIO Master Driver

Display side External Device side
D-sub 9 pin (socket) Terminal block
. Shield )
Signal name ST Signal name
*4 RDA [|e¢9— D1 Termination
% | resistance
RDB [« DO 120Q 1/2W
Displa '
ey S GND
)
sbB i
1
SG -
ERA |—
CSA |« =
ERB —
CSB |+
* 1 Connection
Display side External Device side External Device side
D-sub 9 pin (socket) Terminal block Terminal block
- Shield ) Shield :
Signal name ST Signal name Ve ey Signal name
*q RDA |« AV, Lyl D1 AV \'. D1 Termination
% i / .‘\ \ i / ?\ ! resistance
RDB |ert+/ [\ DO — DO 120Q 1/2W
Display SDA ﬂi b GND ‘_\ -“ ; GND

SDB Voa _T_

SG A =

ERA “»-----ji

CSA 4——| =

ERB

CSB 4——|

*1 The resistance in the Display is used as the termination resistance. Set the value of the DIP Switch on the

rear of the Display as shown in the table below.

DIP Switch No. Set Value
1 OFF
2 OFF
3 OFF
4 OFF
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17H)

e 1:1 Connection

Display side External Device side
D-sub 9 pin (socket) Terminal block
. . Shield )
Pin Signal name Py Y Signal name
I’ I’ \ . .
3 LINE+ |e—F /\,' — D1 Termination
‘.’ /N resistance
8 LINE- ] DO 120Q 1/2W
Displa !
Pay 1 NC GND
2 NC
5 SG
4 RS
6 5V
7 NC
9 NC
Shell FG
e 1:n Connection
Display side External Device side External Device side
D-sub 9 pin (socket) Terminal block Terminal block
- - Shield - Shield :
Pin Signal name P Y Signal name oy ey Signal name
3 LINE+ |e— Al “. > D1 '," A “‘ D1 Termination
!/ .‘\ \ ' / ‘?\ \ resistance
8 LINE- — i DO — DO 1200 1/2W
Display 1 NC E E ; GND I“ |“ /, GND
> |~ | L/ e
5 SG — 4 =
4 RS Y
»omeaa v
6 5V
7 NC
9 NC
Shell FG

IV[=0l>a\\il ¢« The 5V output (Pin #6) on the Display is the power for the Siemens AG’s PROFIBUS
connector. Do not use it for other devices.

NOTE I

¢ In COM on the GP-4107, the SG and FG terminals are isolated.
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171)
e 1:1 Connection
Display side External Device side
Terminal block Terminal block
. Shield -
Signal name Fail Y Signal name
RDA D1 Termination
resistance
RDB DO 120Q 1/2W
Displa
Pay SDA GND
=
= SDB
PFXzCBADTM1 | TERMRX
SG
FG
User-created cable
e 1:n Connection
Display side External Device side External Device side
Terminal block Terminal block Terminal block
) ) Shield -
Signal name Signal name Vanay ey Signal name
RDA D1 ',:’ AV "‘ D1 Termination
: / ‘.\ ! resistance
RDB DO + Lt DO 120Q 1/2W
Display SDA GND |“ .“ /. GND
= SDB l'
PFXZCBADTM1 | TERMRX -
SG
FG

v

A

User-created cable
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17J)
e 1:1 Connection

External Device side
Terminal block

Disol Signal name
ISplay D1 D1 Termination
DO resistance
DO 120Q 1/2W
(1) GND GND
* 1:n Connection
External Device side External Device side
Terminal block Terminal block
. Shield -
Displ Signal name Ve 7 Signal name
Isplay D1 D1 AV “'. D1 Termination
DO | / .'\ ! resistance
DO ,| ! ': DO 120Q 1/2W
(1) GND GND — GND
No. Name Notes

RJ45 RS-485 Cable (5m) by Pro-face
(1) PFXZLMCBRIJR81
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17K)
e 1:1 Connection
Display side External Device side
D-sub 9 pin (socket) Terminal block
. . Shield -
Pin Signal name Py ™ Signal name
1 1
2 DATA+ |« ,.’ JAY ." \ > D1 Termination
VAR W resistance
1 DATA- ; ] DO 120Q 1/2W
Displa !
Pay 3 NC GND
7 NC
5 GND
4 NC
8 NC
9 NC
6 NC
Shell FG
e 1:n Connection
Display side External Device side External Device side
D-sub 9 pin (socket) Terminal block Terminal block
) : Shield - Shield B
Pin Signal name P Y Signal name Vanay ey Signal name
2 DATA+  |—t ! ‘\‘ N D1 AV “‘ D1 Termination
!/ ‘\ \ ! / ‘.\ | resistance
1 DATA- 7 ] DO : L DO 120Q 1/2W
Display 3 NC GND |“ .“ /. GND
7 NC l'
5 GND =
4 NC
8 NC
9 NC
6 NC
Shell FG

GP-Pro EX Device/PLC Connection Manual

182



MODBUS SIO Master Driver

6 Supported Device

Range of supported device address is shown in the table below. Please note that the actually supported range of
the devices varies depending on the External Device to be used. Please check the actual range in the manual of
your External Device.

6.1 Micro/Premium/Twido/Quantum/Momentum/M221 Series

[E==——=]) This address can be specified as system data area.

32
Device Bit Address Word Address bits Notes
Coil 000001 - 065536 000001 - 065521 x|
Discrete Input 100001 - 165536 100001 - 165521 L H| x| 2
Input Register | - 300001 - 365536 or 15 2
HiL
. . 400001,00 - Lk
Holding Register 465536.15"3 400001 - 465536 B e 1)

*1  High and low relationship of the stored data is specified by the [Double Word word order] setting of [Device
Setting].
574 1 Setup Items in GP-Pro EX" (page 60)
*2  Write disabled

*3  An access method at the time of Bit Set varies depending on the [Rest of the bits in this word] setting of [Device

Setting].
-Clear................ 9]
- Do not clear.....400001,00 - 465536,15
6.2 FCN/FCJ Series
[E====) This address can be specified as system data area.
. . 32
Device Bit Address Word Address bits Notes
Coil 000001 - 009984 000001 - 009969 =il
Discrete Input 100001 - 109984 100001 - 109969 [LIH prrwel ETRCAE
. 300001.00 - or -
Input Register 309999 15 300001 - 309999 o |
HIL
. . 400001.00 -
Holding Register 409999 15 400001 - 409999 *1 o |

*1  High and low relationship of the stored data is specified by the [Double Word word order] setting of [Device
Setting].
&4 1 Setup Items in GP-Pro EX" (page 60)
*2  The device access range of the External Device is specified as 1 to 9999, that of the Display, however, as up to
9984, since the Display device is accessible in 16-bit units.

*3  Write disabled
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Function Code

Below is the list of Supported Function Code.

Function Code (Hex)

Description

FCO1 (0x01)

Reads the ON/OFF status of coils (0X references) in the slave.

FCO02 (0x02)

Reads the ON/OFF status of discrete inputs (1X references) in the slave.

FCO03 (0x03)

Reads the binary content of holding registers (4X references) in the slave.

FCO04 (0x04)

Reads the binary content of input registers (3X references) in the slave.

FCO5 (0x05)

Forces a single coil (0X references) to either ON or OFF

FCO06 (0x06)

Presets a value into a single holding register (4X references).

FC15 (0XOF)

Forces each coil (0X references) in a sequence of coils to either ON or OFF.

FC16 (0x10)

Presets values into a sequence of holding registers (4X references).

FC90(0x5A)

Used when SoMachine Basic syntax is selected.

NOTE | * FC15/

FC16 will be used for writing. In case if the connected controller do not support these

function codes, then FC05 / FC06 will be used.

6.4 IEC61131 address syntax
The following table gives the equivalences between the Modbus syntax and the IEC61131 syntax.
Modbus address syntax IEC61131syntax
: 0-based 1-based
Device . .
First orma First First
Format Range Range Range
element element element

. . | 1=0to o/ N A i=0 to N i=1to 0
Call 000001+ 65535 000001 %Mi 65535 %MO00000 65536 %MO00001
Discrete . |i=0to
Input 100001+ 65535 100001 - - - - -
Input register . | i=0to
(word) 300001+ 65535 300001 - - - - -
Input register i=0to
(W‘;r | bft’) 300001+ | 65535 | 300001,00 | - - - - -

j=0tol5

Holding =0 to =0 to i=1to

i 1 0, M 0, 0,
register 400001+ 65535 400001 %MWi 65535 %MW00000 65536 %MWO00001
(word)
Holding i=0 to o . |i=0to o |i=1to 0
register 400001+i,j | 65535 400001,00 )/;M Wi 65535 )?(I)\gWOOOOO. 65535 g"(l(\)/[ow 00001
(word bit) =0 tol5 J i=0to 15 =0 tol5 |’

NOTE | * The two areas 100000 and 300000 are not accessible with the IEC syntax.
* Once you change the project which you have setup Discrete Input Register to IEC 61131 Syntax,

the address will be undefined.
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6.5 SoMachine Basic syntax

SoMachine Basic syntax is available for M221 series only.

« TM221M16Re/TM221ME16Re/TM221M16Te/TM221ME16Te

MODBUS SIO Master Driver

32
Device Bit Address Word Address bits Notes
Memory bits %MO00000 - %M01023 | -
Mermory words %MW00000.00 - %MWO00000 - TRERE
ry %MW07999.15 %MW07999 iy
Constant words %KWO00000 - %KW00000 - 4+
%KWO00511.15 %KWO00511
%1000.000 - %1000.007 | - *5 %6
Digital inputs *
%I001.000 - %I014.031 | - 7
%Q000.000- | o
%Q000.007
Digital outputs
%Q001.000- | .
%Q014.031
%IW000.000.00 - %IW000.000 - [LIH) o5 16
%IW000.001.15 %IW000.001
Analog inputs or
%IW001.000.00 - %IW001.000 - HiL |67
%IW014.007.15 %IW014.007 (H7L
%QW001.000.00 - %QW001.000 - " *6 +7
Analog outputs %QW014.003.15 %QW014.003
System bits %S00000 - %S00159 | -
Svstemn words %SW00000.00 - %SW00000 - 15 "3
y %SW00233.15 %SW00233 i)
%IWS000.000.00 - %IWS000.000 - .5 g
%IWS000.001.15 %IWS000.001
Input channel status
%IWS001.000.00 - %IWS001.000 - v6 ¥7
%IWS014.007.15 %IWS014.007
%QWS001.000.00 - %QWS001.000 - 26 +7
Output channel status %QWS014.003.15 %QWS014.003

*1  High and low relationship of the stored data is specified by the [Double Word word order] setting of [Device
Setting].

R Setup ltems in GP-Pro EX" (page 60)
*2  To use addresses %MD00000 - %MD07998 and %MF00000 - %MF07998 on the External Device, select

addresses %MWO00000 - %MW07998. Then, set the [Data type] to either [32bit Dec]/[32bit Hex](%MD) or
[32bit Float](%MF).
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*3  The access method for Bit Set varies depending on the [Rest of the bits in this word] setting in the [Individual
Device Setting] dialog box.

-Clear......coooeureenne. 1]
- Do not clear........... When bits are written, the Display reads the corresponding word address from the External

Device, sets particular bits of that word address ON, and then returns the resulting word
address to the External Device. Note that the resulting data may not be correct if you write
to the word address from the External Device while the Display is reading from and writing
to the External Device.

*4  To use addresses %KDO00000 - %KDO00510 and %KF00000 - %KF00510 on the External Device, select
addresses %KWO00000 - % KWO00510. Then, set the [Data type] to either [32bit Dec]/[32bit Hex](%MD) or
[32bit Float](%MF).

*5  Write disabled

*6  The device address structure is as follows.
The module number is mapped to the attached unit.

Bit device Word device

%Q XXX . lﬁ Y%IW xxX . .2z
Address (000 - 255) —LBit address (00 - 15)

Module No. (000 - 014) -Address (000 - 255)
Device Module No. (000 - 014)
Device

*7  Available for use only when an I/O module is connected.
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+  TM221IM32TK/TM221ME32TK

MODBUS SIO Master Driver

32
Device Bit Address Word Address bits Notes
Memory bits %MO00000 - %M01023 | -
Mermory words %MW00000.00 - %MW00000 - 15,2 %
ry %MW07999.15 %MW07999 0]
Constant words %K W00000 - %KW00000 - oy s
%KWO00511.15 %KWO00511
%1000.000 - %1000.015 | - *5 %6
Digital inputs -
%1001.000 - %1014.031 | - 7
%Q000.000- | “6
%Q000.015
Digital outputs
%Q001.000- | *7
%Q014.031
%IW000.000.00 - %IW000.000 - [LIH) .5 g
%IW000.001.15 %IW000.001
i or
Analog inputs
%IW001.000.00 - %IW001.000 - HiL |67
%IW014.007.15 %IW014.007 (AL
%QW001.000.00 - %QWO001.000 - " *6 *7
Analog outputs %QW014.003.15 %QW014.003
System bits %S00000 - %S00159 | -
Svstem words %SW00000.00 - %SW00000 - 15 "3
y %SW00233.15 %SW00233 kv
%IWS000.000.00 - %IWS000.000 - o5 16
%IWS000.001.15 %IWS000.001
Input channel status
%IWS001.000.00 - %IWS001.000 - *6 %7
%IWS014.007.15 %IWS014.007
%QWS001.000.00 - %QWS001.000 - v6 7
Output channel status %QWS014.003.15 %QWS014.003

*1

*2

*3

*4

High and low relationship of the stored data is specified by the [Double Word word order] setting of [Device
Setting].
Fvyg 1 Setup Items in GP-Pro EX" (page 60)

To use addresses %6MDO00000 - %MD07998 and %MF00000 - %MF07998 on the External Device, select
addresses %MWO00000 - %MWO07998. Then, set the [Data type] to either [32bit Dec]/[32bit Hex](%MD) or
[32bit Float](%MF).

The access method for Bit Set varies depending on the [Rest of the bits in this word] setting in the [Individual
Device Setting] dialog box.

- Do not clear........... When bits are written, the Display reads the corresponding word address from the External
Device, sets particular bits of that word address ON, and then returns the resulting word
address to the External Device. Note that the resulting data may not be correct if you write
to the word address from the External Device while the Display is reading from and writing
to the External Device.

To use addresses %KDO00000 - %KDO00510 and %KF00000 - %KF00510 on the External Device, select
addresses %KWO00000 - %KWO00510. Then, set the [Data type] to either [32bit Dec]/[32bit Hex](%MD) or
[32bit Float](%MF).

GP-Pro EX Device/PLC Connection Manual

187




MODBUS SIO Master Driver

*5  Write disabled

*6  The device address structure is as follows.

The module number is mapped to the attached unit.

Bit device

*7  Available for use only when an I/O module is connected.

%Q xxX .
%Address (000 - 255)

Module No. (000 - 014)
Device

Word device

YolW xxx . -ZZ
—LLI\&——LBit address (00 - 15)

-Address (000 - 255)
Module No. (000 - 014)
Device
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+ TM221C16¢/TM221CE16e

MODBUS SIO Master Driver

32
Device Bit Address Word Address bits Notes
Memory bits %MO00000 - %M01023 | -
Mermory words %MW00000.00 - %MWO00000 - 15,2 %
ry %MW07999.15 %MW07999 0]
Constant words %KW00000 - %KW00000 - oy s
%KWO00511.15 %KWO00511
%1000.000 - %1000.008 | - *5 %6
Digital inputs s
%I001.000 - %I014.031 | - 5%6 %7
%Q000.000- | “6
%Q000.006
Digital outputs
%Q001.000- | 26 +7
%Q014.031
%IW000.000.00 - %IW000.000 - .5 g
%IW000.001.15 %IW000.001
Analod inputs %IW001.000.00 - %IW001.000 - 05 %6 #7
9 1nhp %IW014.007.15 %IW014.007
%IW000.100.00 - %IW000.100 - [LIH) o5 6 *g
%IW000.101.15 %IW000.101 or
%QW001.000.00 - %QW001.000 - 3 %6+
%QW014.003.15 %QWO014.003 HiL | 19
Analog outputs .
%QW000.100.00 - %QW000.100 - 1 15,3 %6 %9
%QW000.101.15 %QW000.101 EXRLL]
System bits %S00000 - %S00159 | -
Svstem words %SW00000.00 - %SW00000 - 15, %3
y %SW00233.15 %SW00233 iy
%IWS000.000.00 - %IWS000.000 - .5 g
%IWS000.001.15 %IWS000.001
Input channel stafus %IWS001.000.00 - %IWS001.000 - o5 %6 #7
P %IWS014.007.15 %IWS014.007
%IWS000.100.00 - %IWS000.100 - *5 46 48
%IWS000.101.15 %IWS000.101
%QWS001.000.00 - %QWS001.000 - v5 %6+
%QWS014.003.15 %QWS014.003
Output channel status
%QWS000.100.00 - %QWS000.100 - o5 %6 %0

%QWS000.101.15

%QWS000.101

*1  High and low relationship of the stored data is specified by the [Double Word word order] setting of [Device

Setting].

F7ng 1 Setup Items in GP-Pro EX" (page 60)

*2  To use addresses %MD00000 - %MD07998 and %MF00000 - %MF07998 on the External Device, select
addresses %MWO00000 - %MWO07998. Then, set the [Data type] to either [32bit Dec]/[32bit Hex](%MD) or

[32bit Float](%MF).
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*3  The access method for Bit Set varies depending on the [Rest of the bits in this word] setting in the [Individual
Device Setting] dialog box.

-Clear......coooeureenne. 1]
- Do not clear........... When bits are written, the Display reads the corresponding word address from the External

Device, sets particular bits of that word address ON, and then returns the resulting word
address to the External Device. Note that the resulting data may not be correct if you write
to the word address from the External Device while the Display is reading from and writing
to the External Device.

*4  To use addresses %KDO00000 - %KDO00510 and %KF00000 - %KF00510 on the External Device, select
addresses %KWO00000 - % KWO00510. Then, set the [Data type] to either [32bit Dec]/[32bit Hex](%MD) or
[32bit Float](%MF).

*5  Write disabled

*6  The device address structure is as follows.
The module number is mapped to the attached unit.

Bit device Word device

%Q XXX . lﬁ Y%IW xxX . .2z
Address (000 - 255) —LBit address (00 - 15)

Module No. (000 - 014) -Address (000 - 255)
Device Module No. (000 - 014)
Device

*7  Available for use only when an I/O module is connected.
*8  Available for use only when TMC2AI2, TMC2HOIS01, TMC2PACKO1 or TMC2TI2 is connected.
*9  Available for use only when TMC2AQ2V or TMC2AQ2C is connected.
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*  TM221C24¢/TM221CE24e

MODBUS SIO Master Driver

32
Device Bit Address Word Address bits Notes
Memory bits %MO00000 - %M01023 | -
Mermory words %MW00000.00 - %MWO00000 - 15,2 %
ry %MW07999.15 %MW07999 0]
Constant words %KW00000 - %KW00000 - oy s
%KWO00511.15 %KWO00511
%1000.000 - %1000.013 | - *5 %6
Digital inputs s
%I001.000 - %I014.031 | - 5%6 %7
%Q000.000- | “6
%Q000.009
Digital outputs
%Q001.000- | 26 +7
%Q014.031
%IW000.000.00 - %IW000.000 - .5 g
%IW000.001.15 %IW000.001
Analod inputs %IW001.000.00 - %IW001.000 - 05 %6 #7
9 1nhp %IW014.007.15 %IW014.007
%IW000.100.00 - %IW000.100 - [LIH) o5 6 *g
%IW000.101.15 %IW000.101 or
%QW001.000.00 - %QW001.000 - 3 %6+
%QW014.003.15 %QWO014.003 HiL | 19
Analog outputs .
%QW000.100.00 - %QW000.100 - 1 15,3 %6 %9
%QW000.101.15 %QW000.101 EXRLL]
System bits %S00000 - %S00159 | -
Svstem words %SW00000.00 - %SW00000 - 15, %3
y %SW00233.15 %SW00233 iy
%IWS000.000.00 - %IWS000.000 - s5ig
%IWS000.001.15 %IWS000.001
Input channel stafus %IWS001.000.00 - %IWS001.000 - o5 %6 #7
P %IWS014.007.15 %IWS014.007
%IWS000.100.00 - %IWS000.100 - *5 46 48
%IWS000.101.15 %IWS000.101
%QWS001.000.00 - %QWS001.000 - v5 %6+
%QWS014.003.15 %QWS014.003
Output channel status
%QWS000.100.00 - %QWS000.100 - o5 %6 %0

%QWS000.101.15

%QWS000.101

*1  High and low relationship of the stored data is specified by the [Double Word word order] setting of [Device

Setting].

F7ng 1 Setup Items in GP-Pro EX" (page 60)

*2  To use addresses %MD00000 - %MD07998 and %MF00000 - %MF07998 on the External Device, select
addresses %MWO00000 - %MWO07998. Then, set the [Data type] to either [32bit Dec]/[32bit Hex](%MD) or

[32bit Float](%MF).
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*3  The access method for Bit Set varies depending on the [Rest of the bits in this word] setting in the [Individual
Device Setting] dialog box.

-Clear......coooeureenne. 1]
- Do not clear........... When bits are written, the Display reads the corresponding word address from the External

Device, sets particular bits of that word address ON, and then returns the resulting word
address to the External Device. Note that the resulting data may not be correct if you write
to the word address from the External Device while the Display is reading from and writing
to the External Device.

*4  To use addresses %KDO00000 - %KDO00510 and %KF00000 - %KF00510 on the External Device, select
addresses %KWO00000 - % KWO00510. Then, set the [Data type] to either [32bit Dec]/[32bit Hex](%MD) or
[32bit Float](%MF).

*5  Write disabled

*6  The device address structure is as follows.
The module number is mapped to the attached unit.

Bit device Word device

%Q XXX . lﬁ Y%IW xxX . .2z
Address (000 - 255) —LBit address (00 - 15)

Module No. (000 - 014) -Address (000 - 255)
Device Module No. (000 - 014)
Device

*7  Available for use only when an I/O module is connected.
*8  Available for use only when TMC2AI2, TMC2HOIS01, TMC2PACKO1 or TMC2TI2 is connected.
*9  Available for use only when TMC2AQ2V or TMC2AQ2C is connected.
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*  TM221C40¢/TM221CE40e

MODBUS SIO Master Driver

. . 32
Device Bit Address Word Address bits Notes
Memory bits %MO00000 - %M01023 | -
Mermory words %MW00000.00 - %MW00000 - 15,2 %
ry %MW07999.15 %MW07999 0]
%KWO00000 - %KW00000 - oy s
Constant words %KWO00511.15 %K WO00511
%1000.000 - %1000.023 | - *5 %6
Digital inputs s
%I001.000 - %I014.031 | - 3%6*7
%Q000.000- | “6
%Q000.015
Digital outputs
%Q001.000- | 26 +7
%Q014.031
%IW000.000.00 - %IW000.000 - .5 g
%IW000.001.15 %IW000.001
%IW001.000.00 - %IW001.000 - 05 %6 #7
. %IW014.007.15 %IW014.007
Analog inputs
%IW000.100.00 - %IW000.100 -
%IW000.101.15 %IW000.101 *5 46 48
%IW000.200.00 - %IW000.200 -
%IW000.201.15 %IW000.201
[LIH
%QW001.000.00 - %QW001.000 - 15,3 %6 *7
%QW014.003.15 %QW014.003 or 9]
Analog outputs %QW000.100.00 - %QW000.100 - [H/L
%QW000.101.15 %QW000.101 151 %3 %69
9%QW000.200.00 - %QW000.200 - 1 iy
%QW000.201.15 %QW000.201
System bits %S00000 - %S00159 | -
Svstemn words %SW00000.00 - %SW00000 - 15 "3
y %SW00233.15 %SW00233 0]
%IWS000.000.00 - %IWS000.000 - *5 %
%IWS000.001.15 %IWS000.001
%IWS001.000.00 - %IWS001.000 - v5 %6+
%IWS014.007.15 %IWS014.007
Input channel status
%IWS000.100.00 - %IWS000.100 -
%IWS000.101.15 %IWS000.101 o5 6 *g
%IWS000.200.00 - %IWS000.200 -
%IWS000.201.15 %IWS000.201
%QWS001.000.00 - %QWS001.000 - v5 %6+
%QWS014.003.15 %QWS014.003
Output channel status %QWS000.100.00 - %QWS000.100 -
%QWS000.101.15 %QWS000.101 o5 %6 %9

%QWS000.200.00 - %QWS000.200 -
%QWS000.201.15 %QWS000.201
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*1  High and low relationship of the stored data is specified by the [Double Word word order] setting of [Device
Setting].

F7ng 1 Setup Items in GP-Pro EX" (page 60)
*2  To use addresses %MD00000 - %MD07998 and %MF00000 - %MF07998 on the External Device, select

addresses %MWO00000 - %MWO07998. Then, set the [Data type] to either [32bit Dec]/[32bit Hex](%MD) or
[32bit Float](%MF).

*3  The access method for Bit Set varies depending on the [Rest of the bits in this word] setting in the [Individual
Device Setting] dialog box.

= Clear..oneeeeeeeeann. = l15|
- Do not clear........... When bits are written, the Display reads the corresponding word address from the External

Device, sets particular bits of that word address ON, and then returns the resulting word
address to the External Device. Note that the resulting data may not be correct if you write
to the word address from the External Device while the Display is reading from and writing
to the External Device.

*4  To use addresses %KDO00000 - %KDO00510 and %KF00000 - %KF00510 on the External Device, select
addresses %KWO00000 - %KWO00510. Then, set the [Data type] to either [32bit Dec]/[32bit Hex](%MD) or
[32bit Float](%MF).

*5  Write disabled

*6  The device address structure is as follows.
The module number is mapped to the attached unit.

Bit device Word device

YoQ XXX . )LH %IW XXX . yyy . zZ
-Address (000 - 255) 1Bit address (00 - 15)

Module No. (000 - 014) Address (000 - 255)
Device Module No. (000 - 014)
Device

*7  Available for use only when an I/O module is connected.
*8  Available for use only when TMC2AI2, TMC2HOIS01, TMC2PACKO1 or TMC2TI2 is connected.
*9  Available for use only when TMC2AQ2V or TMC2AQ2C is connected.

NOTE | ¢ Please refer to the GP-Pro EX Reference Manual for system data area.
Cf. GP-Pro EX Reference Manual "LS Area (Direct Access Method Area)"
* Please refer to the precautions on manual notation for icons in the table.

& "Manual Symbols and Terminology"
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7 Device Code and Address Code

MODBUS SIO Master Driver

Use device code and address code when you select "Device Type & Address" for the address type in data displays.

7.1 Micro/Premium/Twido/Quantum/Momentum/M221 Series
Device Code
Device Device Name Address Code
(HEX)
Coil 0 0080 Value of (word address - 1) divided by 16
Discrete Input 1 0081 Value of (word address - 1) divided by 16
. Value of word address from which 1 is
Input Register 3 0001 deducted
Holding Register 4 0000 Value of word address from which 1 is
deducted
7.2 FCN/FCJ Series
Device Code
Device Device Name Address Code
(HEX)
Coil 0 0080 Value of (word address - 1) divided by 16
Discrete Input 1 0081 Value of (word address - 1) divided by 16
. Value of word address from which 1 is
Input Register 3 0001 deducted
. . Value of word address from which 1 is
Holding Register 4 0000 deducted
7.3 SoMachine Basic Syntax
Device Code
Device Device Name Address Code
(HEX)
Memory words %MW 0000 Value of word address
Constant words %KW 0002 Value of word address
Analog inputs %IW 0008 Value of word address
Analog outputs %QW 0009 Value of word address
System words %SW 0004 Value of word address
Input channel status %IWS 000A Value of word address
Output channel status %QWS 000B Value of word address
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8 Error Messages

Error messages are displayed on the screen of Display as follows: "No. : Device Name: Error Message (Error

Occurrence Area)". Each description is shown below.

ltem Description

No. Error No.

Name of External Device where error occurs. Device name is a title of External Device set

Device Name with GP-Pro EX. (Initial value [PLC1])

Error Message Displays messages related to the error which occurs.

Displays IP address or device address of External Device where error occurs, or error codes
received from External Device.

Error Occurrence Area NOTE

» IP address is displayed such as "IP address(Decimal): MAC address( Hex)".
* Device address is displayed such as "Address: Device address".
» Received error codes are displayed such as "Decimal[Hex]".

Display Examples of Error Messages
"RHAAOQ35: PLC1: Error has been responded for device write command (Error Code: 2 [02H])"

NOTE | * Refer to your External Device manual for details on received error codes.
« Refer to "Display-related errors" in "Maintenance/Troubleshooting Guide" for details on the error

messages common to the driver.
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